Oracle® Enterprise Manager

Getting Started with the Oracle Management Pack for Oracle Applications

Release 9.0.1

June 2001
Part No. A88720-01
## Contents

### Send Us Your Comments

Preface

### 1 Overview

- **What's New in Version 9i**
- **Oracle Enterprise Manager Console**
- **Central Administration of Oracle Applications System**
- **Automatic Problem Resolution**
- **Oracle Applications Advanced Event Tests**
- **Oracle Performance Manager**
- **Oracle Capacity Planner**
- **Concurrent Processing Tuning Assistant**
- **Oracle Applications Manager**

### 2 Post-Installation Configuration

- **Intelligent Agent on the Managed Node**
- **Applying Oracle Applications Patch for Bug #1302931 or Bug #1371501**
- **Configuring Windows NT Security for the Enterprise Manager Job System**
- **Enabling Disk Statistics Collection for Capacity Planner and Performance Manager on Windows NT**
- **Configuring Oracle Applications Sign-On Auditing**
- **Starting the Intelligent Agent on the Managed Node**
  - **Managing the Intelligent Agent on UNIX**
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing the Intelligent Agent on Windows NT</td>
<td>2-5</td>
</tr>
<tr>
<td>Managing the Intelligent Agent from the Windows NT Command Prompt</td>
<td>2-6</td>
</tr>
<tr>
<td>Oracle Management Server (OMS)</td>
<td>2-7</td>
</tr>
<tr>
<td>Creating the Oracle Management Server Repository</td>
<td>2-7</td>
</tr>
<tr>
<td>Starting the Oracle Management Server</td>
<td>2-8</td>
</tr>
<tr>
<td>Managing the Oracle Management Server on UNIX</td>
<td>2-8</td>
</tr>
<tr>
<td>Managing the Oracle Management Server on Windows NT</td>
<td>2-9</td>
</tr>
<tr>
<td>Using CPTA Through the Oracle Management Server</td>
<td>2-10</td>
</tr>
<tr>
<td>Running the Management Pack for Oracle Applications through a Web Browser</td>
<td>2-10</td>
</tr>
<tr>
<td>Oracle Enterprise Manager Console</td>
<td>2-11</td>
</tr>
<tr>
<td>Starting the Oracle Enterprise Manager Console</td>
<td>2-11</td>
</tr>
<tr>
<td>Discovering Nodes and Services</td>
<td>2-12</td>
</tr>
<tr>
<td>Configuring the oapps.ora File on the Concurrent Manager Node</td>
<td>2-12</td>
</tr>
<tr>
<td>Discovering Concurrent Managers in the Console</td>
<td>2-14</td>
</tr>
<tr>
<td>Setting Preferred Credentials</td>
<td>2-15</td>
</tr>
<tr>
<td>Starting Applications in the Management Pack for Oracle Applications</td>
<td>2-15</td>
</tr>
<tr>
<td>Configuration Checklist</td>
<td>2-16</td>
</tr>
<tr>
<td>3 Introduction to Oracle Performance Manager</td>
<td></td>
</tr>
<tr>
<td>Accessing Performance Data Through an Intermediate Host</td>
<td>3-3</td>
</tr>
<tr>
<td>Usage Scenarios for Oracle Performance Manager</td>
<td>3-4</td>
</tr>
<tr>
<td>Starting Oracle Performance Manager</td>
<td>3-5</td>
</tr>
<tr>
<td>Starting Oracle Performance Manager from the Console</td>
<td>3-5</td>
</tr>
<tr>
<td>Starting Oracle Performance Manager from the UNIX Command Line</td>
<td>3-5</td>
</tr>
<tr>
<td>Starting Oracle Performance Manager from the Start Menu in Windows NT</td>
<td>3-6</td>
</tr>
<tr>
<td>Running Performance Manager in Enterprise Mode</td>
<td>3-6</td>
</tr>
<tr>
<td>Running Performance Manager in Standalone Mode</td>
<td>3-7</td>
</tr>
<tr>
<td>Using the Oracle Performance Manager Main Window</td>
<td>3-7</td>
</tr>
<tr>
<td>Connecting to a Discovered Target in Enterprise Mode</td>
<td>3-8</td>
</tr>
<tr>
<td>Manually Connecting to a Target</td>
<td>3-9</td>
</tr>
<tr>
<td>Viewing Performance Manager Charts</td>
<td>3-9</td>
</tr>
<tr>
<td>Monitoring Multiple Targets Concurrently</td>
<td>3-10</td>
</tr>
<tr>
<td>Viewing Chart Groups</td>
<td>3-10</td>
</tr>
<tr>
<td>Selecting Collected Data and Data Sources</td>
<td>3-11</td>
</tr>
<tr>
<td>Using the Chart Display Window</td>
<td>3-12</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Selecting a Chart Format</td>
<td>3-12</td>
</tr>
<tr>
<td>Setting the Chart Refresh Rate</td>
<td>3-13</td>
</tr>
<tr>
<td>Pausing and Restarting a Chart</td>
<td>3-13</td>
</tr>
<tr>
<td>Selecting Chart Options</td>
<td>3-13</td>
</tr>
<tr>
<td>Chart-Specific Commands</td>
<td>3-15</td>
</tr>
<tr>
<td>Drilling Down from One Chart to Another</td>
<td>3-15</td>
</tr>
<tr>
<td>Using the Chart Status Button</td>
<td>3-16</td>
</tr>
<tr>
<td>Drilling Down to an Historical Chart</td>
<td>3-18</td>
</tr>
<tr>
<td>Displaying Alternate Chart Orientations</td>
<td>3-20</td>
</tr>
<tr>
<td>Sorting Data in a Table Chart</td>
<td>3-20</td>
</tr>
<tr>
<td>Saving Your Changes to a Chart</td>
<td>3-21</td>
</tr>
<tr>
<td>Obtaining Help for a Class, Chart, or Data Item</td>
<td>3-21</td>
</tr>
<tr>
<td>Printing a Chart</td>
<td>3-22</td>
</tr>
<tr>
<td>Generating a Report for a Chart</td>
<td>3-22</td>
</tr>
<tr>
<td>Recording Chart Data</td>
<td>3-22</td>
</tr>
<tr>
<td>Starting a Recording</td>
<td>3-23</td>
</tr>
<tr>
<td>Stopping a Recording</td>
<td>3-23</td>
</tr>
<tr>
<td>Playing a Recording</td>
<td>3-24</td>
</tr>
<tr>
<td>Removing a Recording</td>
<td>3-24</td>
</tr>
<tr>
<td>Chart Display Window Menu Shortcut Keys</td>
<td>3-24</td>
</tr>
<tr>
<td>Working With Events and Thresholds in Performance Manager</td>
<td>3-25</td>
</tr>
<tr>
<td>Triggered Events and Thresholds</td>
<td>3-29</td>
</tr>
<tr>
<td>Events Registered for Multiple Targets</td>
<td>3-29</td>
</tr>
<tr>
<td>Metrics with Multiple Events and Different Thresholds</td>
<td>3-29</td>
</tr>
<tr>
<td>Event Permissions</td>
<td>3-30</td>
</tr>
<tr>
<td>Registering Events in Performance Manager</td>
<td>3-30</td>
</tr>
<tr>
<td>About Oracle 9i and Pre-9i Agents</td>
<td>3-31</td>
</tr>
<tr>
<td>Viewing Thresholds</td>
<td>3-31</td>
</tr>
<tr>
<td>Resetting Thresholds</td>
<td>3-33</td>
</tr>
<tr>
<td>Refreshing Thresholds</td>
<td>3-33</td>
</tr>
<tr>
<td>Editing Threshold Associations</td>
<td>3-34</td>
</tr>
<tr>
<td>Running Performance Manager in a Browser</td>
<td>3-35</td>
</tr>
<tr>
<td>Viewing Metric and Event Documentation Through a Browser</td>
<td>3-36</td>
</tr>
</tbody>
</table>
4 Introduction to Oracle Capacity Planner

How Capacity Planner Collects and Stores Performance Data ........................................... 4-2
Accessing Historical Data Through an Intermediate Host ................................................ 4-3
Usage Scenarios for Oracle Capacity Planner .................................................................... 4-4
Starting Oracle Capacity Planner ....................................................................................... 4-4
Using Help .......................................................................................................................... 4-5
Using Oracle Capacity Planner ............................................................................................ 4-6
Setting Up a Collection ........................................................................................................ 4-6
  Selecting Targets ............................................................................................................... 4-7
    Selecting Targets on Discovered Nodes ........................................................................ 4-7
    Selecting Targets on Undiscovered Nodes .................................................................... 4-8
  About the Target Property Sheet ....................................................................................... 4-9
  Defining the Frequency of Collection Samples ................................................................ 4-10
  Defining the Location of the Historical Database ............................................................ 4-10
  Defining the Frequency of Loading Collection Data ....................................................... 4-11
    Understanding When the Loader Runs ........................................................................ 4-12
    Understanding How Data Aggregation Works .............................................................. 4-12
  Defining the Amount of Data to Keep .............................................................................. 4-14
  Applying and Reverting the Collection Settings for a Target ........................................ 4-14
  Selecting the Classes of Data to Collect .......................................................................... 4-15
    Starting Data Collection ............................................................................................... 4-17
    Stopping Data Collection ............................................................................................. 4-18
  Generating a Collection Report ......................................................................................... 4-19
  Copying Collection Settings ............................................................................................ 4-19
  Troubleshooting Collection and Load Problems .............................................................. 4-20
Analyzing Collected Data .................................................................................................... 4-20
  Connecting to an Oracle Capacity Planner Historical Database .................................. 4-21
  Organization of Data in the Navigator ............................................................................. 4-22
  Browsing the Collected Data ............................................................................................ 4-22
  Viewing an Analysis for a Class of Data ........................................................................... 4-23
  Saving a Class Analysis as a User-Defined Analysis ...................................................... 4-23
  Specifying Selection Criteria for a Class of Data ........................................................... 4-24
  Viewing and Modifying User-Defined and Predefined Analyses .................................. 4-25
  Creating a Copy of an Analysis ......................................................................................... 4-26
  Renaming a User-Defined Analysis .................................................................................. 4-27
Starting the Tuning Assistant from the Start Menu on Windows NT .................................. 5-6

**Using the Tuning Assistant** ........................................................................................................ 5-6
- Tuning Assistant Main Window ...................................................................................... 5-7
- General Tab ...................................................................................................................... 5-7
- Options Tab ...................................................................................................................... 5-7
- Displaying Reports ........................................................................................................... 5-8
- Saving Reports ................................................................................................................... 5-9
- Report Properties .............................................................................................................. 5-9
- Drill Down from Tuning Assistant Reports ..................................................................... 5-9
- Printing Tuning Assistant Reports .................................................................................. 5-9

**Report Descriptions** .............................................................................................................. 5-10
- Concurrent Managers by Hour (24x7) ........................................................................... 5-10
- Concurrent Manager Usage by Program ......................................................................... 5-11
- Program Run Summary by Status .................................................................................... 5-12
- Program Wait Summary .................................................................................................. 5-12
- Waiting Requests by Hour (24x7) ................................................................................... 5-13
- Long Running Requests ................................................................................................. 5-13
- Short Running Requests that Waited ................................................................................ 5-14
- Request Run Summary by Month .................................................................................... 5-15
- Drill-Down Reports .......................................................................................................... 5-16
  - Requests that Ran ......................................................................................................... 5-16
  - Requests that Waited ..................................................................................................... 5-16
  - Request Details ............................................................................................................. 5-17

**Tuning Advisor** ...................................................................................................................... 5-18
- Tuning Advisor Reports .................................................................................................... 5-18
- Tuning Advisor Report ..................................................................................................... 5-19
- Tuning Suggestion Report for High Utilization with Many Waiting Requests ........... 5-19
- Tuning Suggestion Report for Low Utilization with Many Waiting Requests .......... 5-20
- Tuning Suggestion Report for No Capacity with Many Waiting Requests ............. 5-20

### 6 Oracle Applications Advanced Event Tests

**Fault Event Tests** .................................................................................................................. 6-3
- Concurrent Manager UpDown ......................................................................................... 6-3
- CRM Waiting on a Lock .................................................................................................. 6-4
- ICM Waiting on a Lock .................................................................................................... 6-5
Performance Event Tests ................................................................. 6-8
  Inactive Request Pending ............................................................. 6-8
  Pending Concurrent Request Backlog ........................................... 6-8
  Request Pending Time ................................................................. 6-9
  Run Alone Request Submitted ................................................... 6-10

Space Event Tests ........................................................................ 6-11
  Concurrent Manager Disk Free ................................................... 6-11

Fault Event Tests (For V8.1.6 and Earlier Agents) ........................... 6-12
  Concurrent Manager UpDown (for V8.1.6 and Earlier Agents) .......... 6-12
  CRM Waiting on a Lock (for V8.1.6 and Earlier Agents) .................. 6-12
  ICM Waiting on a Lock (for V8.1.6 and Earlier Agents) ................ 6-13
  Request Error Rate (for V8.1.6 and Earlier Agents) ...................... 6-14
  Request Warning Rate (for V8.1.6 and Earlier Agents) .................. 6-15

Performance Event Tests (For V8.1.6 and Earlier Agents) ................. 6-15
  Inactive Request Pending (for V8.1.6 and Earlier Agents) .......... 6-15
  Pending Concurrent Request Backlog (for V8.1.6 and Earlier Agents) 6-16
  Request Pending Time (for V8.1.6 and Earlier Agents) .............. 6-16
  Run Alone Request Submitted (for V8.1.6 and Earlier Agents) .... 6-17

7 Oracle Applications Jobs

Setting Concurrent Manager Node Credentials ................................ 7-2
Job Descriptions ............................................................................ 7-3
  Concurrent Manager Shutdown .................................................. 7-3
  Concurrent Manager Shutdown (for V8.1.6 and Earlier Agents) ...... 7-4
  Concurrent Manager Startup ...................................................... 7-4
  Concurrent Manager Startup (for V8.1.6 and Earlier Agents) ....... 7-5
  Kill Locking Session .................................................................. 7-6
  Kill Locking Session (for V8.1.6 and Earlier Agents) ................. 7-7
  Load Data into Concurrent Processing Tuning Assistant ............... 7-7

A Troubleshooting

Managed Node (Concurrent Manager Node) .................................... A-2
Cannot Start the Intelligent Agent - Oracle Performance Utility Conflict .................. A-2

Oracle Management Server Node (OMS) ........................................................................ A-3

Problems Connecting to Oracle Management Server ................................................. A-3

Client Node .................................................................................................................. A-4

Unable to Connect to Repository When Using Performance Manager or Capacity Planner A-4

Unable to Start Performance Manager in Context of the Console......................... A-4

Error Connecting to Repository When Using Performance Manager ......................... A-5

Cannot Save Current Performance Manager Work..................................................... A-6

Errors Occur When Attempting to Connect to Oracle Applications Instances .......... A-6

Losing Connection to a Service .................................................................................... A-7

Version of Agent Is Not Compatible with Event or Job................................................. A-7

Advanced Events Do Not Display in the Browser ......................................................... A-7

‘Failed to Authenticate User Error’ When Running a Job ........................................... A-8

Multiple Instances of the Same Concurrent Managers in the Console...................... A-9

Chart Recording Stops When Enterprise Manager Console Is Closed ......... A-9

Index
Send Us Your Comments

Oracle Enterprise Manager Getting Started with the Oracle Management Pack for Oracle Applications, Release 9.0.1
Part No. A88720-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this document. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document title and part number, and the chapter, section, and page number (if available). You can send comments to us in the following ways:

- Electronic mail: nedc-doc_us@oracle.com
- FAX: 603-897-3317 Attn: Oracle Management Pack for Oracle Applications
- Postal service:
  Oracle Corporation
  Oracle Management Pack for Oracle Applications Documentation
  1 Oracle Drive
  Nashua, NH 03062
  U.S.A.

If you would like a reply, please give your name, address, telephone number, and (optionally) electronic mail address.

If you have problems with the software, please contact your local Oracle Support Services.
This section describes the purpose and organization of this guide: Getting Started with the Oracle Management Pack for Oracle Applications. Specifically, it covers the following topics:

- Purpose of This Guide
- Audience
- How This Guide Is Organized
- Oracle Enterprise Manager Pack Information
- Oracle Enterprise Manager Documentation
- How to Find Oracle Documentation Online
- Oracle Support

**Purpose of This Guide**

This guide provides an overview of the Oracle Performance Manager and Oracle Capacity Planner applications and their features. It also describes the Concurrent Processing Tuning Assistant, the Oracle Applications Advanced Event Tests, and the Oracle Applications Jobs. As the guide describes how to use these applications and events, it also introduces you to key concepts and terminology.

**Audience**

This guide is written for those who wish to use Oracle Performance Manager, Oracle Capacity Planner, Concurrent Processing Tuning Assistant, the Oracle

This guide assumes that you are familiar with the Oracle Enterprise Manager console and base applications. If you are not, please read Oracle Enterprise Manager Concepts Guide and Oracle Enterprise Manager Administrator’s Guide.

This guide also assumes you have some administrative knowledge of Oracle Applications. If not, please refer to the Oracle Applications documentation.

How This Guide Is Organized

This guide is organized as follows:

Chapter 1, "Overview"
Provides an overview of the Oracle Management Pack for Oracle Applications and its features.

Chapter 2, "Post-Installation Configuration"
Provides lists of steps to consider after the installation of the Oracle Management Pack for Oracle Applications has taken place.

Chapter 3, "Introduction to Oracle Performance Manager"
Provides an overview of the Oracle Performance Manager application and its features.

Chapter 4, "Introduction to Oracle Capacity Planner"
Provides an overview of the Oracle Capacity Planner application and its features.

Chapter 5, "Concurrent Processing Tuning Assistant"
Provides an overview of the Concurrent Processing Tuning Assistant feature.

Chapter 6, "Oracle Applications Advanced Event Tests"
Provides a description of the Oracle Applications Advanced Event Tests.

Chapter 7, "Oracle Applications Jobs"
Provides a description of the Oracle Applications Jobs.

Appendix A, "Troubleshooting"
Provides solutions to problems you may encounter while working with the Oracle Management Pack for Oracle Applications.
Oracle Enterprise Manager Pack Information


Oracle Change Management Pack

- Includes Create Baseline, Baseline Viewer, Comparison Viewer, Compare Database Objects, DB Alter, DB Propagate, DB Quick Change, Plan Editor, and Change Manager.
- Tracks metadata changes in databases.
- Eliminates errors and loss of data when upgrading databases to support new applications.
- Analyzes the impact and complex dependencies associated with application change and automatically performs database upgrades.
- Initiates change with easy-to-use wizards that teach systematic steps necessary to upgrade databases.

Oracle Diagnostics Pack

- Includes Oracle Performance Manager, Oracle Capacity Planner, Oracle Data Viewer, Oracle TopSessions, and Oracle Advanced Event Tests.
- Monitors, diagnoses, and maintains the stability of databases, operating systems, and applications. Both historical and real-time analysis are used to automatically avoid problems before they occur.
- Provides powerful capacity planning features that enable users to easily plan and track future system resource requirements.

Oracle Tuning Pack

- Includes Oracle SQL Analyze, Oracle Expert, SQL Explain Plan, Oracle Index Tuning Wizard, Tablespace Map, Reorg Wizard, Outline Management, and the Outline Editor.
- Optimizes system performance by identifying and tuning major database and application bottlenecks such as inefficient SQL coding, poor data structures, and improper use of system resources.
Discovers tuning opportunities and automatically generates the analysis and required changes to tune the system. Inherent in the product are powerful teaching tools that help DBAs learn to tune the system as they work.

Helps increase the productivity of developers and DBAs.

**Oracle Management Pack for SAP R/3**

- Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle Event Tests that are specific to monitoring your SAP R/3 environment.
- Monitors, diagnoses, and maintains the health of a SAP R/3 system. Both historical and real-time analysis are used to automatically avoid problems before they occur.
- Provides powerful capacity planning features that enable users to easily plan and track future system resource requirements.

**Oracle Management Pack for Oracle Applications**

- Includes Oracle Performance Manager, Oracle Capacity Planner, Concurrent Processing Tuning Assistant, and Oracle Applications Event Tests that are specific to monitoring your Oracle Applications environment.
- Enables you to monitor all aspects of your system, including databases and concurrent managers.
- Enables the monitoring, diagnosing, and capacity planning of the Oracle Applications environment.

**Oracle Enterprise Manager Documentation**

*Getting Started with the Oracle Management Pack for Oracle Applications* is one of several Oracle Enterprise Manager documents.

**Oracle Enterprise Manager Base Documentation**

- *Oracle Enterprise Manager Readme* provides important notes regarding the online documentation, updates to the software, and other late-breaking information for Oracle Enterprise Manager and the Oracle Management Packs.
- *Oracle Enterprise Manager Administrator’s Guide* explains how to use Oracle Enterprise Manager, the Oracle systems management console, common services, and integrated platform tools.
■ Oracle Enterprise Manager Configuration Guide explains how to configure Oracle Enterprise Manager.

■ Oracle Enterprise Manager Messages Manual describes Oracle Enterprise Manager error messages and methods for diagnosing those errors.

■ Oracle Intelligent Agent User’s Guide provides configuration information and answers to crucial troubleshooting questions pertaining to the Oracle Intelligent Agent.

■ Oracle Enterprise Manager Event Test Reference Manual describes Oracle Event Tests which allow you to implement automatic problem detection and correction on concurrent managers, databases, listeners, nodes, and SAP R/3 systems.

Oracle Management Pack Installation documentation

■ The Oracle9i Installation Guide Release 9.0.1 for your particular platform provides important information for installing the Oracle Enterprise Manager console and the management packs. This manual also contains information such as hardware and software requirements, installable components, and deinstallation procedures. The Oracle9i Installation Guide Release 9.0.1 is available as a free download from the Oracle Documentation Center at http://docs.oracle.com

Oracle Change Management Pack Documentation


Oracle Diagnostics Pack Documentation

■ Getting Started with the Oracle Diagnostics Pack provides an overview of the concepts and features of Oracle Performance Manager, Oracle Capacity Planner, and Oracle TopSessions applications.

Oracle Tuning Pack Documentation

■ Database Tuning with the Oracle Tuning Pack provides an overview of the concepts and features of each of the applications included in the Oracle Tuning Pack. The applications include Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning Wizard, Reorg Wizard, Tablespace Map, Outline Management, and the Outline Editor. A description of how these applications can work together to tune an Oracle database is also provided.
Oracle Management Pack for Oracle Applications Documentation

- Getting Started with the Oracle Management Pack for Oracle Applications provides an overview of the concepts and features of Oracle Performance Manager, Oracle Capacity Planner, and Concurrent Processing Tuning Assistant. It also describes Oracle Applications Event Tests and Jobs that are specific to monitoring your Oracle Applications environment.

Oracle Management Pack for SAP/R3 Documentation

- Oracle Management Pack for SAP R/3 Readme provides important notes regarding Oracle Management Pack for SAP R/3 online documentation, updates to the software, and other late-breaking information.

- Getting Started with Oracle Management Pack for SAP R/3 provides an overview of the concepts and features of Oracle Performance Manager and Oracle Capacity Planner. It also describes Oracle Event Tests that are provided with the Oracle Management Pack for SAP/R3.

- The Oracle Management Pack for SAP R/3 Installation provides important information for installing the Oracle Enterprise Manager console and the Oracle Management Pack for SAP R/3. This manual also contains information such as hardware and software requirements, installable components, and deinstallation procedures.

How to Find Oracle Documentation Online

To download free release notes or installation documentation, please visit the Oracle Documentation Center at http://docs.oracle.com/

Printed documentation is available for sale in the Oracle Store at http://oraclestore.oracle.com/

Oracle Support

The Oracle MetaLink (www.oracle.com/support/metalink/index.html) site provides access to information that will aid you in using Oracle products such as: hot topics, product reference, installation assistance materials, white papers, problem/solution articles, and more. To use this site you must be a licensed Oracle user with an active support service contract.

Contact your Oracle sales representative for more information.
Documentation Accessibility

Oracle’s goal is to make our products, services, and supporting documentation accessible to the disabled community with good usability. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For additional information, visit the Oracle Accessibility Program web site at http://www.oracle.com/accessibility/.

JAWS, a Windows screen reader, may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, JAWS may not always read a line of text that consists solely of a bracket or brace.
The sheer complexity of enterprise application systems presents you, the Oracle Applications system administrator, with much greater challenges than managing the database by itself. The Oracle Management Pack for Oracle Applications (hereafter referred to as the Management Pack for Oracle Applications) helps you better manage your systems through a single console, from which you can monitor and administer all major aspects of the system, including databases and concurrent managers.

The Management Pack for Oracle Applications extends Oracle Enterprise Manager to enable the monitoring, diagnosing, and capacity planning of the multitiered Oracle Applications environment. The Management Pack for Oracle Applications takes advantage of the following Oracle Enterprise Manager system management features:

- Discovery and graphical representation of services to be monitored
- Starting tools from the console in the context of a specific service
- Automated data collection and management services
- Central monitoring and administration of remote systems using intelligent agents

The Management Pack for Oracle Applications extends the following tools to work with Oracle Applications:

- Oracle Enterprise Manager Console
  
  The console is extended to discover concurrent managers and to notify you should any of the servers go down. You can also define event tests and jobs for any of the Oracle Applications subsystems, allowing central administration of a distributed Oracle Applications system.

- Oracle Applications Advanced Event Tests and Jobs
A library of event tests specific to Oracle Applications are provided for lights-out event monitoring and problem detection of the Oracle Applications system.

Additional lights-out problem resolution is provided with fix-it jobs that are configured to run automatically when an event triggers. These fix-it jobs are either custom-built or chosen from a small predefined set provided with the Management Pack for Oracle Applications.

- **Oracle Performance Manager**
  
  An Oracle Applications cartridge feeds data to Oracle Performance Manager, providing you with an extensive array of real-time monitoring charts on all concurrent managers and Oracle Forms sessions that are used by your Oracle Applications instance. Information about these charts and chart groups is provided in the Performance Manager help.

- **Oracle Capacity Planner**

  Concurrent manager performance data is gathered over time and fed to Oracle Capacity Planner for analysis of resource consumption and detection of performance anomalies.

- **Concurrent Processing Tuning Assistant**

  This utility allows you to examine historical processing information about Oracle Concurrent Processing requests and concurrent managers.

This chapter investigates the interaction of each of these tools with Oracle Applications.

**What’s New in Version 9i**

The Oracle Management Pack for Oracle Applications release 9i offers the following new features:

- A new repository schema has been introduced in this release. The Concurrent Processing Tuning Assistant repository stores FND table information that normally would be purged. This data is aggregated into new tables allowing for additional analysis.

- New ‘Load Data into Concurrent Processing Tuning Assistant Repository’ job used to schedule a daily transfer between the FND tables and the Concurrent Processing Tuning Assistant repository.

- Descriptions of concurrent manager charts are available in help.
Tuning Advisor reports in the Concurrent Processing Tuning Assistant. These reports provide information about possible solutions for problems that may be impeding the best-possible performance of your concurrent manager.

- New Unresponsive Concurrent Manager event checks the responsiveness of the concurrent managers
- Performance Manager and Concurrent Processing Tuning Assistant are now web-enabled

Oracle Enterprise Manager Console

Concurrent Manager servers can be discovered in the Oracle Enterprise Manager navigator. By discovering all databases and Concurrent Manager servers available on the system, Oracle Enterprise Manager provides a single point of administration for an Oracle Applications system. The integration with Oracle Enterprise Manager provides the benefits of the existing 3-tiered management infrastructure and provides you with a familiar interface thus reducing the learning curve.

Central Administration of Oracle Applications System

You can group together discovered services into a single logical entity, such as the Production Financials System or the Human Resource Test System. Once grouped, you can quickly identify which system is affected when a particular Oracle Forms server goes down, or easily link the slow performance of a particular application with an overloaded concurrent manager in that system.

The base Enterprise Manager console ships with simple events for Oracle Applications, allowing you to check whether the relevant subsystems are up or down, and have notifications delivered by a pager or e-mail to the appropriate administrators identified by their job responsibilities and work shifts. This capability allows you not only to detect problems before an end user does, but also to do so when you are not even in the office!

Automatic Problem Resolution

The base console also is shipped with a library of predefined jobs specific to Oracle Applications, such as shutting down or starting up a remote server. These jobs can be configured to trigger automatically as fix-it jobs for particular events, or scheduled to run at predefined times or intervals. As a result, you can automatically correct problems before end users are aware of them.
Oracle Applications Advanced Event Tests

In addition to the basic UpDown event tests provided for all services administered in the Oracle Enterprise Manager console, the Management Pack for Oracle Applications provides a library of advanced event tests specific to Oracle Applications subsystems. Examples of the problems that the event tests notify you of include:

- Internal Concurrent Manager is waiting on a lock.
- Percentage of requests with errors has exceeded a threshold.
- Run-alone request was submitted, locking out all other requests.

See Chapter 6, "Oracle Applications Advanced Event Tests" for a complete list of these problems.

The key to smooth system administration is to resolve problems before they turn into crises. These advanced event tests allow you to focus on the causes of problems before the symptoms become serious. In addition, with pager and e-mail notification mechanisms provided by Oracle Enterprise Manager, you can be notified of any problems with the system wherever you are located.

Oracle Performance Manager

The Management Pack for Oracle Applications uses Oracle Performance Manager, a tool also available as part of the Oracle Diagnostics Pack. Oracle Performance Manager has been extended to monitor the performance statistics of concurrent managers.

Oracle Performance Manager displays performance data in real-time graphical views that can be automatically refreshed at user-defined intervals. Multiple charts and tables can be presented in a single monitoring window, affording you a multifaceted view of applications’ system performance. For example, an Oracle Applications administrator can monitor the number of Oracle Forms sessions, pending concurrent requests, and the number of running concurrent requests all in a single screen. The following are two of the predefined chart groups shipped with the Management Pack for Oracle Applications:

- System Activity Overview Chart Group
  - Forms Sessions and Concurrent Requests Chart
  - Completed Requests by Status Chart
  - Pending Requests per Manager Chart
Oracle Capacity Planner

- Running Requests per Manager Chart
- Longest Running Requests Chart
- Top Resource Consumers Chart Group
  - Top Form Sessions Chart
  - Top Running Requests Chart

Users can further drill down on these charts to see greater detail, and in some cases, drill down to problematic requests and terminate them. Many other subsystem specific charts are available, giving you a rich set of data to analyze your system from multiple angles. See Performance Manager help for a description of individual charts.

Oracle Capacity Planner

The same data collection mechanism used by Oracle Performance Manager is also used to collect historical performance and resource consumption data for capacity planning. The Management Pack for Oracle Applications uses Oracle Capacity Planner to analyze concurrent manager performance data to help you configure your systems appropriately and project your future capacity needs.

Historical data can be gathered for many charts exposed in the Oracle Performance Manager. This collection can be customized, allowing you to select the interval at which these statistics should be sampled. The data collection mechanism allows you to customize roll up capabilities, where data can be aggregated at the end of each hour, day, week, or month. This data collection mechanism, along with data expiration policies you customize, gives you full control over the amount of storage needed for the historical data.

Once the data is gathered, you can use Oracle Capacity Planner to chart the historical data for the purposes of identifying trends and predicting future hardware requirements for the system. You can also extrapolate to a particular point in time or work back from a particular target value and find when that event is expected to occur. These charts can be customized, allowing you to get the data you need and to view data from multiple sources (for example, CPU, disk, and concurrent manager processes) on a single, unified chart.
Concurrent Processing Tuning Assistant

The Concurrent Processing Tuning Assistant reports historical information about concurrent managers, concurrent programs, and concurrent processing requests. You can use these reports to achieve better throughput and performance.

With the Tuning Assistant you can connect to the Concurrent Processing Tuning Assistant repository, the Oracle Management Server, or the database schema containing the Oracle Application Object Library tables for the subsystems you want to tune.

The Tuning Advisor feature of the Tuning Assistant provides information about possible solutions for problem areas that are preventing optimum performance of your concurrent manager.

The Tuning Assistant reports help you balance concurrent manager workloads by determining:

- Time periods with greatest wait times
- Requests that waited during those time periods
- Time periods with excess concurrent manager capacity

You can then reschedule requests that waited, add more concurrent managers, or, if necessary, add more hardware to address the problem. In addition, you can follow the suggestions offered in the Tuning Advisor reports.

Many reports allow you to drill down to other reports associated with the selected items. For example, when you run the Waiting Requests by Hour report, you can quickly determine the time period with the greatest wait times. You can then select the period, drill down to the Requests that Waited report, and identify the requests that were blocked.

Oracle Applications Manager

Oracle Applications has integrated its concurrent manager administrative interface with Oracle Enterprise Manager, enabling administrators to better manage their systems.

The Oracle Applications Manager console provides an Applications DBA-oriented subset of the current Oracle Applications System Administration functions. These functions include administration of concurrent managers, processes, and requests.

The Oracle Applications Manager is available for Releases 11.0 and 11i.
This functionality is in addition to the multi-window Oracle Applications forms, and administrators can choose which tools to use. Requests submitted within the standard Oracle Applications windows can be viewed from the Oracle Applications Manager console. Likewise, concurrent managers defined in the console can be accessed from within the Oracle Applications windows.

While Oracle Applications Manager thoroughly complements the monitoring capabilities of the Management Pack for Oracle Applications tools, it is released separately from the Management Pack for Oracle Applications as a free download from Oracle MetaLink.

Access the Oracle MetaLink (www.oracle.com/support/metalink/index.html) site to download Oracle Applications Manager and the associated Oracle Applications Manager Server Extensions.
After you have installed the Management Pack for Oracle Applications, you need to configure the following software:

- Intelligent Agent on the managed nodes (for example, Internal Concurrent Manager node and Applications Database node)
- Oracle Management Server
- Oracle Enterprise Manager console

**Note:** All the configuration tasks listed in this chapter are required to bring the Management Pack for Oracle Applications online. A checklist is provided at the end of this chapter to help you ensure that each step has been performed correctly.

The following sections provide detailed information about each of these configuration tasks.
Intelligent Agent on the Managed Node

On the managed node you must:

- Apply Oracle Applications patch for bug #1302931 or bug #1371501, depending on the version of your Oracle Applications instance
- Configure Windows NT security for the Enterprise Manager job system (for Windows NT targets only)
- Enable disk statistics collection for Capacity Planner and Performance Manager on Windows NT (for Windows NT only)
- Configure Oracle Applications Sign-On Auditing profile
- Start the Intelligent Agent on the managed node

**Note:** If you are running the Concurrent Processing Server in Parallel Concurrent Processing mode (that is, distributed across several host computers), configure as a managed node only the host which runs the Internal Concurrent Manager. In this configuration, the Applications Disk Free event will only report on the disk space on this node.

Applying Oracle Applications Patch for Bug #1302931 or Bug #1371501

The patch for bug #1302931 or bug #1371501 must be applied to the Oracle Applications instance for it to be managed by the Management Pack for Oracle Applications. The patch for bug #1302931 applies to release 10.7 of Oracle Applications and the patch for bug #1371501 applies to releases 11.0 and higher of Oracle Applications. These patches must be applied to the $APPL_TOP directory of each of the Concurrent Processing Servers.

**Note:** The fix for bug #1302931 is a server-side patch, which applies identically to 10.7 SC (Smart Client), 10.7 NCA (Network Computing Architecture), and 10.7 character mode deployments.

Please use your normal channels for pulling patches for Oracle Applications. The patch for bug #1302931 or bug #1371501 is a prerequisite for using the Management Pack for Oracle Applications.
Configuring Windows NT Security for the Enterprise Manager Job System

You can use the Oracle Intelligent Agent to perform a variety of jobs on the managed node, such as starting or stopping the Concurrent Manager, or running fix-it jobs to correct problems detected by Advanced Event Tests.

To use this feature against a Concurrent Processing Server on Windows NT, you must grant the Log on as a batch job privilege to the Windows NT user whose account will be used to run these jobs. If you know what user accounts you will be using for this purpose, configure them now. If not, perform this step later when you enter preferred node credentials to be used on this node by Oracle Enterprise Manager.

To grant a Windows NT user the Log on as a batch job privilege, do the following:

1. Select Start=>Programs=>Administrative Tools=>User Manager.
2. Highlight the user to be granted the privilege.
4. Check the Show Advanced User Rights box.
5. In the Right field, select the Log on as a batch job right.
6. Click Add.

Jobs submitted using user names without the Log on as a batch job privilege fail with the status of VNI Authentication Error. Refer to the Oracle Intelligent Agent User’s Guide for information regarding the Logon as a batch job privilege.

Enabling Disk Statistics Collection for Capacity Planner and Performance Manager on Windows NT

To collect disk statistics on Windows NT, type the following at the DOS prompt:

diskperf -Y

Disk statistics will be enabled the next time the system is restarted.
To monitor Applications form sessions with the Management Pack for Oracle Applications, you must set the Oracle Applications "Sign-On: Audit Level" profile to FORM, using your normal Applications administration tools. Oracle suggests that you periodically run the Purge Sign-on Audit Data concurrent program to purge unwanted historical data from your FND tables.

**Note:** If you want to view CPU usage of your concurrent programs using Performance Manager, the Applications database must have the timed_statistics parameter, located in the init.ora file, turned on. See your database documentation for details. Activating this parameter may have a performance impact on your database.

**Starting the Intelligent Agent on the Managed Node**

To start the Intelligent Agent on the managed node, see the appropriate sections that follow:

- "Managing the Intelligent Agent on UNIX" on page 2-4
- "Managing the Intelligent Agent on Windows NT" on page 2-5
- "Managing the Intelligent Agent from the Windows NT Command Prompt" on page 2-6

**Managing the Intelligent Agent on UNIX**

On UNIX, Oracle Enterprise Manager uses the `agentctl` command to start and stop the Intelligent Agent. The relevant `agentctl` commands to control the UNIX Intelligent Agent are listed in the following table.
Managing the Intelligent Agent on Windows NT

On Windows NT, the Intelligent Agent runs as a Windows NT service. The steps to control the Intelligent Agent are listed in the following table.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Intelligent Agent</td>
<td>Start=&gt;Settings=&gt;Control Panel=&gt;Services=&gt;Oracle&lt;name of Oracle home=&gt;Agent=&gt;Start</td>
</tr>
<tr>
<td>Stop Intelligent Agent</td>
<td>Start=&gt;Settings=&gt;Control Panel=&gt;Services=&gt;Oracle&lt;name of Oracle home=&gt;Agent=&gt;Stop</td>
</tr>
</tbody>
</table>
Managing the Intelligent Agent from the Windows NT Command Prompt

To start or stop the Intelligent Agent from the command prompt, enter the appropriate command. From the command prompt, you can also verify that the service is running.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Enter the following command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start the Intelligent Agent from the prompt</td>
<td><code>net start &lt;agent service&gt;</code></td>
</tr>
<tr>
<td>Stop the Intelligent Agent from the prompt</td>
<td><code>net stop &lt;agent service&gt;</code></td>
</tr>
<tr>
<td>Verify status of the Intelligent Agent from the prompt</td>
<td><code>net start</code></td>
</tr>
</tbody>
</table>

The `<agent service>` is composed of the word Oracle, followed by the name of the Oracle home (for example, ORCLHome), and concluded with the word Agent. `OracleORCLHomeAgent`, is an example of an agent service.

**Note:** Do not use the `agentctl` command to start the Intelligent Agent for Windows NT.
Oracle Management Server (OMS)

After you install the Oracle Management Server for the Management Pack for Oracle Applications, you must:

- Create the Oracle Management Server repository, if not already created
- Start the Oracle Management Server
- (Optional) Run the Management Pack for Oracle Applications through a web browser

Creating the Oracle Management Server Repository

When you create your Oracle Management Server, you must provide the repository address in the `<host:port:SID>` format, rather than using an Oracle Net service name or leaving the name field blank to indicate a local default database. The host portion should be a fully qualified DNS name, for example, `myhost.us.acme.com`. Otherwise, Capacity Planner and Performance Manager clients from other DNS domains (for example, `uk.acme.com`) will not be able to connect to the server. This step ensures that all Enterprise Manager applications can connect to the Oracle Management Server repository when needed.

If you are using a previously created repository, use the Enterprise Manager Configuration Assistant to verify that the Oracle Management Server is using the `<host:port:SID>` syntax for its repository address, and modify it to use this syntax if needed. To do this task, start the Configuration Assistant, as follows:

- To start the Configuration Assistant on Windows NT, select `Start=>Programs=><Enterprise Manager Home=>Enterprise Manager=>Configuration Assistant`
- To start the Configuration Assistant on UNIX, run `<Enterprise Manager Oracle Home>/bin/emca`

Select the `Edit Configuration Parameters` option and click `Next`. The existing Oracle Management Server connection parameters are now displayed. The bottom parameter ("Service") indicates the repository service. If this is already in the `<host:port:SID>` syntax, nothing further needs to be done, and you can exit the tool.

If this line instead contains a name (for example, `omsdb` or `omsdb.acme.com`) or is blank, you need to do the following:
1. Change the line to contain the fully-qualified host name on which the Oracle Management Server repository database is run. Insert a colon after the host name.

2. Type the port number that the TNS listener for this database is using. Insert a colon after the port number.

3. Type the SID of this database. The resulting line looks like:

   omhost.acme.com:1521:ORCL

4. Click Next.

5. Click Finish to save the changes.

Starting the Oracle Management Server

To start the Oracle Management Server, see the appropriate section that follows:

- "Managing the Oracle Management Server on UNIX" on page 2-8
- "Managing the Oracle Management Server on Windows NT" on page 2-9

---

Note: If you have problems starting the Oracle Management Server, see the Oracle Enterprise Manager Configuration Guide for information.

---

Managing the Oracle Management Server on UNIX

On UNIX, Oracle Enterprise Manager uses the oemctl command to start and stop the Oracle Management Server. The relevant oemctl commands to control the UNIX Oracle Management Server are listed in the following table. In all cases, the command string is case-sensitive and must be entered with lowercase characters.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Enter the command...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Oracle Management Server</td>
<td>oemctl start oms</td>
</tr>
</tbody>
</table>
Managing the Oracle Management Server on Windows NT

On Windows NT, the Oracle Management Server runs as a Windows NT service. The steps to control the Oracle Management Server are listed in the following table.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Oracle Management Server</td>
<td>Start=&gt;Settings=&gt;Control Panel=&gt;Services=&gt;Oracle&lt;name of Oracle home&gt;ManagementServer=&gt;Start</td>
</tr>
<tr>
<td>Stop Oracle Management Server</td>
<td>Start=&gt;Settings=&gt;Control Panel=&gt;Services=&gt;Oracle&lt;name of Oracle home&gt;ManagementServer=&gt;Stop</td>
</tr>
</tbody>
</table>

**NOTE:** You must have the Windows NT operating system administrator privilege to stop the Oracle Management Server.

**Note:** If the need arises, you can reset the superuser password by running the vduResetSysman.sql script from the Enterprise Manager master account. The script is located in the ORACLE_HOME/sysman/admin directory.
The status information of the Oracle Management Server includes the following:

- Overall status of the Oracle Management Server
- Time period the Oracle Management Server has been up and available
- Statistics regarding the performance of the Oracle Management Server

Using CPTA Through the Oracle Management Server

When launching CPTA in standalone mode, you have the option of using CPTA through the Oracle Management Server. To use the Concurrent Processing Tuning Assistant through the Oracle Management Server, you must have an entry defined in the `tnsnames.ora` file where the Oracle Management Server resides.

If you do not have such an entry in the `tnsnames.ora` file, you must add a connection to the Oracle Management Server using the Add Connection option available from the toolbar.

Running the Management Pack for Oracle Applications through a Web Browser

Windows NT clients can run the Oracle Enterprise Manager console, along with all Management Pack for Oracle Applications tools, through a web browser without installing any software on the client node. The only exception is Capacity Planner, which can only run as a client install.

To run in this mode of operation, some special setup steps must be taken to make the Enterprise Manager software available from a Web server. Refer to the Web browser information in the Oracle Enterprise Manager Configuration Guide for a complete description of how to set up and run Oracle Enterprise Manager in this configuration.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify status of Oracle Management Server</td>
<td>Start=&gt;Settings=&gt;Control Panel=&gt;Services=&gt;Oracle&lt;name of Oracle home&gt;Management Server=&gt;look at Status column or oemctl status oms</td>
</tr>
</tbody>
</table>
Oracle Enterprise Manager Console

After you install the client software for the Management Pack for Oracle Applications, you must:

1. Start the Oracle Enterprise Manager console.
2. Discover nodes and services to manage in the console.
3. Configure the oapps.ora file on the concurrent manager node.
4. Discover concurrent managers in the console.
5. Set preferred credentials.
6. Start the applications delivered with the Management Pack for Oracle Applications.

The following sections describe these tasks in detail.

Starting the Oracle Enterprise Manager Console

1. Start the Oracle Enterprise Manager console.
   - On Windows NT, start the console from the Windows Start menu under the appropriate Oracle home.
   - On UNIX, start the console from the command line by typing:
     oemapp console

     The command string is case-sensitive and must be entered with lowercase characters.

2. If you are connecting to the Oracle Management Server for the first time, at the first login dialog, type in the default credentials for the super administrator account.

   Administrator = sysman
   Password = oem_temp

   **Note:** Should you forget the Enterprise Manager password after you set it, run the vduResetSysman.sql script to reset the password.

3. From the Oracle Management Server pull-down list, select an Oracle Management Server which is configured for Oracle Applications management.
If the name of the Oracle Management Server you want to use does not appear, do the following:

a. Click the Management Servers button. The Management Servers dialog is displayed.

b. Click the Add button. The Add Management Server dialog is displayed.

c. Type in the host name of the computer on which the Oracle Management Server you want to add is running, and click OK.

d. Select the Oracle Management Server from the pull-down list.

4. After the initial login, a security login dialog is displayed where you can change your password. Change your password immediately.

---

**Note:** Passwords cannot have more than 8 characters.

---

**Discovering Nodes and Services**

During the start up of the Oracle Management Server, the manageable services on the machine where the Oracle Management Server is running are automatically discovered. The Console Navigator shows all these discovered services.

To discover additional nodes:

1. Select **Discover Nodes** from the Console’s Navigator menu.

2. Enter the host name of the node in the text window of the Discover Nodes dialog. You can discover multiple services at one time by entering each node you want to discover on a new line within the text window.

3. Click **OK** to continue.

If a node cannot be discovered, it may be because the node is down or the node is not running an Intelligent Agent. Also note that you must be using the TCP/IP network protocol.

---

**Configuring the oapps.ora File on the Concurrent Manager Node**

There are several manual steps you must perform before discovering an Oracle Applications instance. These steps are:

1. In the Enterprise Manager Console, discover the node where the Oracle Applications database resides, as described in "Discovering Nodes and Services" on page 2-12.
2. Make a note of the fully qualified database name as it appears in the Enterprise Manager console, for example, Production_DB.acme.com. You will need this information later.

3. Go to the Concurrent Processing Server node and locate the Oracle home of the Intelligent Agent. For the Intelligent Agent to discover the Concurrent Processing Server, you must edit the oapps.ora file. The oapps.ora file is installed into the following directory in the Intelligent Agent’s Oracle home:

$ORACLE_HOME/network/agent/config

The oapps.ora file is an input file used to associate Oracle Applications instances with information about the instances.

The file format is:

<type> <WS> <dbname> <WS> <envfile> <WS> <startup information> <NL>

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;type&gt;</td>
<td>Entry type. Currently only cmanager is recognized; cmanager denotes Concurrent Manager Server.</td>
</tr>
<tr>
<td>&lt;WS&gt;</td>
<td>White space (one or more blanks or tabs).</td>
</tr>
<tr>
<td>&lt;dbname&gt;</td>
<td>Applications database name. This name is also used as the Applications instance name. This must be exactly the same (fully qualified) name as the database name that appears in the Enterprise Manager console.</td>
</tr>
<tr>
<td>&lt;envfile&gt;</td>
<td>Fully qualified path and file name of the Applications environment file. This file must set up the entire Applications environment, including all required database environment variables, and all variables from the Applications environment file located in the APPL Top directory. Note: For the Windows NT 10.7 instance, which does not have the Applications environment file, type a dummy file name. This file name can reference an empty file or a non-existing file.</td>
</tr>
<tr>
<td>&lt;startup information&gt;</td>
<td>For Windows NT. Name of the ICM service in the NT Services panel. For UNIX. Fully qualified path to the ICM startup script. Typically this is the oemstart.sh script in the $FND Top/bin directory, installed when you apply the patch for bug #1302931 or bug #1371501.</td>
</tr>
<tr>
<td>&lt;NL&gt;</td>
<td>New line, that is, one line per entry. Note: You can have multiple entries in a single oapps.ora file.</td>
</tr>
</tbody>
</table>
Lines starting with a pound sign (#) as the first non-WS character are comments and are ignored.

An example of an entry for Windows NT is:

```plaintext
# entry for discovering the headquarters production applications instance
cmanager hqprod.world C:\home\admin\appenvfile ICMProd
```

An example of an entry for UNIX is:

```plaintext
# entry for discovering the headquarters production applications instance
cmanager hqprod.world /appltop/APPSORA.env /appltop/fnd/11.0/bin/oemstart.sh
```

4. Stop and start the Intelligent Agent as described earlier in this chapter. This will force the Intelligent Agent to read the oapps.ora file and recognize the existence of the Concurrent Manager on this node.

5. After starting the Intelligent Agent, verify that the Intelligent Agent successfully discovered the concurrent manager by inspecting the Intelligent Agent’s $ORACLE_HOME/network/agent/services.ora file. This file should contain an entry of the form:

```plaintext
<applications instance name> = (oracle_sysman_cmanager, <hostname>,
<environment file name>, <startup information>)
```

If such a line does not appear in the services.ora file, refer to Appendix A, "Troubleshooting", or the Oracle Intelligent Agent User’s Guide for additional information.

---

**Note:** It is possible to name the concurrent manager instance using a name that is different from the name of its corresponding database. To do this, you must define a tnsnames.ora entry for the Oracle Applications database with the name you want to use for the concurrent manager in the Console. Use this name in the oapps.ora file and verify that every oracle home (for example, Enterprise Manager Console, OMS, and Agent) has this tns alias defined in its tnsnames.ora file.

---

### Discovering Concurrent Managers in the Console

After configuring the oapps.ora file, return to the Enterprise Manager console. Right mouse click on the node where the Concurrent Processing Server resides and select **Refresh Node**. Upon completion, you will see a new Concurrent Manager appear in the console.
Setting Preferred Credentials

You must enter preferred credentials for both the concurrent manager and the managed node. The Intelligent Agent uses these credentials when running jobs on the managed node.

To enter preferred credentials, select System=>Preferences=>Preferred Credentials on the Oracle Enterprise Manager console main window. To manage Concurrent Manager Servers, you must add preferred credentials for each concurrent manager discovered, and you must add node credentials for the host computer on which they run. All the fields are mandatory. Refer to the Oracle Enterprise Manager console help and the Oracle Enterprise Manager Configuration Guide for information about setting preferred credentials.

**Note:** Node credentials for Windows NT nodes must be for users who are granted the Windows NT Log on as a batch job privilege. See "Configuring Windows NT Security for the Enterprise Manager Job System" on page 2-3 for details on configuring this privilege.

Starting Applications in the Management Pack for Oracle Applications

After starting the Oracle Enterprise Manager console, you can now start the applications in the Management Pack for Oracle Applications. The following table lists these applications and where to find the appropriate information.

<table>
<thead>
<tr>
<th>Step</th>
<th>Where to Find the Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Oracle Performance Manager</td>
<td>See “Starting Oracle Performance Manager” on page 3-5.</td>
</tr>
<tr>
<td>Starting Oracle Capacity Planner</td>
<td>See &quot;Introduction to Oracle Capacity Planner&quot; on page 4-1.</td>
</tr>
<tr>
<td>Starting Concurrent Processing Tuning Assistant</td>
<td>See “Concurrent Processing Tuning Assistant” on page 5-1.</td>
</tr>
<tr>
<td>Using Advanced Events</td>
<td>See &quot;Oracle Applications Advanced Event Tests&quot; on page 6-1.</td>
</tr>
</tbody>
</table>
## Configuration Checklist

The following table provides a checklist of steps to perform when configuring the Management Pack for Oracle Applications.

### Table 2–1 Configuration Checklist

<table>
<thead>
<tr>
<th>Intelligent Agent on the Managed Node (Concurrent Manager Node)</th>
</tr>
</thead>
<tbody>
<tr>
<td>❑ Install software on the managed node</td>
</tr>
<tr>
<td>See the Oracle9i Installation Guide Release 9.0.1 for your particular platform for instructions on installing the Oracle Intelligent Agent.</td>
</tr>
<tr>
<td>❑ Apply Oracle Applications patch for bug #1302931 or bug #1371501</td>
</tr>
<tr>
<td>See “Applying Oracle Applications Patch for Bug #1302931 or Bug #1371501” on page 2-2.</td>
</tr>
<tr>
<td>❑ Configure Windows NT security</td>
</tr>
<tr>
<td>❑ Enable disk statistics collection (Windows NT only)</td>
</tr>
<tr>
<td>❑ Start the Intelligent Agent in the newly installed Oracle Home</td>
</tr>
<tr>
<td>See “Starting the Intelligent Agent on the Managed Node” on page 2-4 and information in the file itself.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Oracle Management Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>❑ Install software</td>
</tr>
<tr>
<td>Skip this step if Oracle Management Server Release 9.0.1 is already running.</td>
</tr>
<tr>
<td>❑ Create an Oracle Management Server repository</td>
</tr>
<tr>
<td>Skip this step if Oracle Management Server Release 9.0.1 is already running. The installation will guide you through these steps. See “Creating the Oracle Management Server Repository” on page 2-7 or refer to the Oracle Enterprise Manager documentation for additional details.</td>
</tr>
<tr>
<td>❑ Start the Oracle Management Server</td>
</tr>
<tr>
<td>See “Starting the Oracle Management Server” on page 2-8.</td>
</tr>
<tr>
<td>❑ (Optional) Run the Management Pack for Oracle Applications through a web browser</td>
</tr>
<tr>
<td>See “Running the Management Pack for Oracle Applications through a Web Browser” on page 2-10.</td>
</tr>
</tbody>
</table>

### Oracle Enterprise Manager Console

---

2-16 Oracle Enterprise Manager Getting Started with the Oracle Management Pack for Oracle Applications
<table>
<thead>
<tr>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install software</td>
<td></td>
</tr>
<tr>
<td>Start the Oracle Enterprise Manager Console</td>
<td>See &quot;Starting the Oracle Enterprise Manager Console&quot; on page 2-11.</td>
</tr>
<tr>
<td>Discover managed nodes (Oracle Applications Database Node)</td>
<td>See &quot;Discovering Nodes and Services&quot; on page 2-12.</td>
</tr>
<tr>
<td>Configure the oapps.ora file on the Concurrent Manager node</td>
<td>See &quot;Configuring the oapps.ora File on the Concurrent Manager Node&quot; on page 2-12.</td>
</tr>
<tr>
<td>Discover concurrent managers in the console</td>
<td>See &quot;Discovering Concurrent Managers in the Console&quot; on page 2-14.</td>
</tr>
<tr>
<td>Set preferred credentials</td>
<td>See &quot;Setting Preferred Credentials&quot; on page 2-15.</td>
</tr>
</tbody>
</table>
Oracle Performance Manager is an Oracle Enterprise Manager application that allows you to monitor the performance of the database and its related applications and operating systems in real time. It allows system and database administrators to monitor performance statistics for Oracle database servers, web servers, Oracle concurrent managers, operating systems, and other managed targets. Performance Manager also allows you to record statistics and play them back at a later time.

You can display these statistics in a number of formats including horizontal and vertical tables, strip charts, horizontal and vertical bar charts, and pie charts. You can also drill down for more detail on some predefined charts.

Since Performance Manager is integrated with Oracle Capacity Planner, you can also drill down to an historical view of the displayed data. The drilldown to historical data allows you to quickly compare the current real time value with the historical average to provide you with a better understanding of the meaning of the current value. For more information about Capacity Planner, see Chapter 4, "Introduction to Oracle Capacity Planner".

For most targets, Performance Manager integrates Event system thresholds with charts so that events and charts share common performance thresholds you can set from either monitoring point. This provides consistent monitoring of thresholds across Enterprise Manager and allows access to graphical and historical diagnostics information from the Event system. You can investigate event notifications by launching charts, historical data and diagnostic advice directly from the Event Viewer. Performance Manager charts incorporate event notification through chart threshold state indicators. Performance Manager threshold and event features are available for node and database data.
Oracle Performance Manager uses the Intelligent Agent (Agent) to collect performance data. To monitor some types of data, you must install the Agent on the system (or systems) where you want to monitor data. See the Oracle Intelligent Agent User’s Guide for information on managing the Agent on a system.

If you are using Oracle Performance Manager to monitor concurrent manager performance, the Agent can be installed on another system. See "Accessing Performance Data Through an Intermediate Host" on page 3-3 for more information on accessing data through an Agent on another system.

The types of performance data that Oracle Performance Manager can monitor on a system depends on the products that are installed. Table 3–1 shows the types of data (or targets) that Oracle Performance Manager can monitor when various Oracle products are installed. The number of targets that appear in the Performance Manager navigator tree will also vary, depending on the number of applications you have installed.

Table 3–1  Data that Performance Manager Can Monitor when Various Oracle Products Are Installed

<table>
<thead>
<tr>
<th>Oracle Product</th>
<th>Oracle Concurrent Manager Data</th>
<th>Oracle Server Data</th>
<th>Operating System Data</th>
<th>SAP R/3 System Data</th>
<th>Microsoft SQL Server Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics Pack</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Management Pack for Oracle Applications</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Accessing Performance Data Through an Intermediate Host

Oracle Performance Manager relies on the Agent to monitor a target (such as a node, a database, or a concurrent manager). Usually, the collection of the data is done on the system where the target is located. However, for some types of targets Oracle Performance Manager can also monitor data on a system by using the Agent on another system (an intermediate host).

This intermediate host could be the client system where the Oracle Performance Manager is running, or any other system on the network on which the Agent is available.

There are three ways to set the location of the Agent. The method you use depends on how you connect to the target. Consider the following three scenarios:

- You connect to a target that has been discovered using the Enterprise Manager console and you are running Oracle Performance Manager while connected to the Oracle Management Server.

  Performance Manager attempts to connect to the Agent on the host where the target is located. If this connection fails or cannot be attempted because no preferred credentials have been set for the target, you can use the Connection Details dialog box to specify logon credentials for the target. This dialog box

---

**Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products Are Installed (Cont.)**

<table>
<thead>
<tr>
<th>Oracle Product</th>
<th>Oracle Concurrent Manager Data</th>
<th>Oracle Server Data</th>
<th>Operating System Data</th>
<th>SAP R/3 System Data</th>
<th>Microsoft SQL Server Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management Pack for SAP R/3</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Standard Management Pack (Oracle Standard Edition only)</td>
<td>No</td>
<td></td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

If additional products from Oracle or other vendors are installed, Oracle Performance Manager may be able to monitor additional types of data not shown in **Table 3–1**.
also contains a field to specify the location of the Agent that will be used to collect performance data.

- You click the **Add Service** button in the toolbar panel and manually add the target to the navigator.
  
  Performance Manager displays a Logon dialog box. You can use the Connection Details dialog box to specify the location of the Agent that will be used to collect performance data.

- You select a target in the Performance Manager navigator tree and choose **Set Connection Details** from the **File** menu.
  
  Performance Manager displays the Logon dialog box for the selected target. Use the Connection Details dialog box to specify the location of the Agent that will be used to collect performance data.

### Usage Scenarios for Oracle Performance Manager

Using Oracle Performance Manager, you can:

- Monitor one or more targets concurrently.
- View the monitored data in various chart formats, including strip (line), pie, bar, table, and hierarchical.
- Set the refresh rate for a chart’s data.
- View multiple charts concurrently for each monitored target.
- View multiple charts in a single window.
- Drill down from one chart to another related chart.
- Drill down from real-time chart data to historical chart data.
- Choose the collected data and data sources to display in a chart.
- View threshold state indicators that provide immediate visual notification of performance status for specific targets. This feature is available for nodes and databases.
- Print a chart.
- Generate and publish an HTML report for a chart.
- Display context-sensitive help for a chart, if help is available for the chart.
- Play a recording of a chart, with fast-forward and pause features.
Starting Oracle Performance Manager

You can start Oracle Performance Manager from the Oracle Enterprise Manager console, from the UNIX command line, or from the Windows Start menu.

Starting Oracle Performance Manager from the Console

You can start Oracle Performance Manager from the Oracle Enterprise Manager console in any of the following ways:

- On the Oracle Enterprise Manager console, point to the Application Management drawer, then click Performance Manager.
- On the Tools menu of the Oracle Enterprise Manager console, point to Application Management, then click Performance Manager.
- Click the right mouse button on the target for which you want to start Performance Manager and then choose Performance Manager from the Related Tools menu item on the context menu.

**Note:** When you start Oracle Performance Manager from the Oracle Enterprise Manager console, Oracle Performance Manager connects to the Oracle Management Server using the same credentials used to start the Oracle Enterprise Manager console.

Starting Oracle Performance Manager from the UNIX Command Line

To start Performance Manager from the UNIX command line, set default to the ORACLE_HOME/bin directory, then type the following command:

```bash
./oemapp pm
```

**Note:** ORACLE_HOME represents the home directory in which the Management Pack for Oracle Applications is installed.

When you start Performance Manager from the UNIX command line, you are given a choice of logging in to the Oracle Management Server and running Performance Manager in Enterprise mode or Standalone mode.

See "Running Performance Manager in Enterprise Mode" on page 3-6 and "Running Performance Manager in Standalone Mode" on page 3-7 for more information about running Performance Manager in Enterprise mode and Standalone mode.
Starting Oracle Performance Manager from the Start Menu in Windows NT

On the **Start** menu of Windows NT, follow the path: **Start**=&gt;**Programs**=&gt;**ORACLE_HOME**=&gt;**Oracle Applications**=&gt;**Performance Manager**.

**Note:** **ORACLE_HOME** represents the home directory in which the Management Pack for Oracle Applications is installed.

When you start Performance Manager from the **Start** menu, you are given a choice of logging in to the Oracle Management Server and running Performance Manager in Enterprise mode or Standalone mode.

**Running Performance Manager in Enterprise Mode**

To run Oracle Performance Manager in Enterprise mode:

1. Click **Login to the Oracle Management Server**.
2. Enter the appropriate connection information for your Oracle Management Server.

   To select an alternate Management Server, click the **Management Server** button next to the **Management Server** drop-down list. In the resulting dialog box, you can add another node that is running Oracle Management Server software. The Oracle Management Server and its associated repository must already exist.

   For information on the fields in the Management Servers dialog box, click **Help**.
3. Click **OK**.

   **Note:** If the repository was created using Enterprise Manager Release 2.1 or earlier, you must upgrade the repository or create a new repository. For more information, see the *Oracle Enterprise Manager Configuration Guide*.

When Performance Manager is running in Enterprise mode and the navigator is first displayed with a target type folder expanded, the targets of that type that were discovered in the Enterprise Manager console are displayed. When you expand a target, Performance Manager attempts to connect to the target. When the target is a Concurrent Manager and preferred credentials for the Concurrent Manager have been saved in the Oracle Enterprise repository, Performance Manager attempts to
connect to the Concurrent Manager using those credentials. Otherwise, the APPS Logon dialog box prompts you for the logon information.

**Running Performance Manager in Standalone Mode**

To run Oracle Performance Manager in standalone mode (not connected to the Oracle Enterprise Manager repository), click **Standalone, no repository connection**, then click **OK**.

When Performance Manager is running in Standalone mode Performance Manager displays any targets that were added to the console in Standalone mode. You can add nodes or Concurrent Managers to the collection view for the current standalone mode session only. Click on the Add Target toolbar button after selecting the folder for the desired target type.

---

**Note:** Your recordings and user-defined charts will not be saved in Standalone mode. If you exit Performance Manager, you will not be able to play back any recordings or access these user-defined charts in future sessions. You will also not be able to save any chart settings or custom charts.

---

**Using the Oracle Performance Manager Main Window**

The primary component of the Oracle Performance Manager user interface is the main window (see **Figure 3–1**), which contains two panels. The navigator or tree panel appears on the left side of the main window and the property sheet panel appears on the right side. When you select an item in the navigator panel, the property sheet panel displays the properties of the selected item.

When you first start Oracle Performance Manager, the navigator panel displays the target type folders and the property sheet panel displays the Performance Manager welcome screen.

A vertical toolbar appears on the left side of the window and a menu bar appears across the top of the window. For more information about the buttons in the toolbar and the commands available from the Performance Manager menus, choose **Window** from the Performance Manager **Help** menu.

In the navigator panel, the **Network** folder contains a folder for each target type. For example, when you have the Management Pack for Oracle Applications installed, the target types are Nodes and Concurrent Managers. To monitor the
performance of database targets, you must have the Oracle Diagnostics Pack installed. Not all target types may be available on all systems.

In addition to the **Network** folders, the **Recordings** folder contains any recordings of chart data that exist. For more information about the **Recordings** folder, see "Recording Chart Data" on page 3-22.

**Figure 3–1 Oracle Performance Manager Main Window**

Connecting to a Discovered Target in Enterprise Mode

Expand a target type folder to view the corresponding targets previously discovered through the Oracle Enterprise Manager console.

To connect to a discovered target, select the target in the navigator tree and click **Connect to service** in the Performance Manager toolbar, or click the plus sign (+) next to the target in the navigator. You can also connect to the target by double clicking on it in the navigator tree. You may be prompted with a Logon dialog box.
if credentials are required to connect to the target. For information on the fields in the Logon dialog box, click **Help**.

**Manually Connecting to a Target**

You can manually add additional targets that have not been discovered using the Enterprise Manager console.

| Note: | When you add a target manually to the navigator tree using the **Add Service** button, you are adding that target for the current session of Performance Manager only. You can begin collecting data for the target, but if you exit and restart Performance Manager, you will have to add the target again. |

To add and connect to a target manually:

1. Select the folder for the target type you are adding.
2. Click **Add Service** in the Performance Manager toolbar panel.
   
   Performance Manager displays a Logon dialog box.
3. Fill in the fields in the Logon dialog box and click **OK**.
   
   For information on the fields in the Logon dialog box, click **Help**.

After you connect to a target, Performance Manager displays the classes of performance information you can monitor for the selected target. Expand a class to see the individual performance data charts available for the selected class.

**Viewing Performance Manager Charts**

You can display a chart using one of the following methods:

- Select the chart in the navigator, and click the **Show Chart** button on the toolbar.
- Select the chart in the navigator, and choose **Show Chart** from the **Chart** menu.
- Select the chart in the navigator, which displays the chart’s property sheet. To start the chart with the selected property sheet options, click **Show Chart** on the property sheet.
- Select a chart class, then select the chart in the **Predefined Displays** list and click **Show Chart**.
Select the chart in the navigator and click the right mouse button. From the context menu, click **Show Chart**.

Performance Manager displays each chart or chart group in its own window, which is separate from the main window. This window is called the Chart Display window. For more information, see "Using the Chart Display Window" on page 3-12.

**Monitoring Multiple Targets Concurrently**

You can view charts from multiple targets concurrently by connecting to the targets from the navigator tree and displaying charts.

**Viewing Chart Groups**

Some types of data include a chart group, which is two or more charts that are displayed within a single Chart Display window. You display a chart group the same way as you view any other chart (see "Viewing Performance Manager Charts" on page 3-9).

You can display a special chart group that contains the Overview Charts for a selected target:

1. Select a target in the Performance Manager navigator.
2. Click the **Show Overview Charts** button in the toolbar panel.

Performance Manager displays a chart group containing some key statistics most likely of interest to database administrators monitoring the selected target.

Charts in a chart group are displayed within a single window. You perform actions, such as setting options and displaying drilldown charts, on one chart at a time within a chart group. The currently selected chart within a chart group window is identified by a highlighted title or a black box. For example, the **Memory Faults** chart is the currently selected chart in Figure 3–2.
Besides viewing the Overview Charts for a selected target, you can also view a chart group provided with a data class. For example, you can select the Memory data class for a Windows NT node and display the Memory at a Glance chart group. Not all data classes provide chart groups, however.

**Selecting Collected Data and Data Sources**

For some charts, the chart’s property sheet allows you to select the collected data to display and the data sources for which the collected data should be displayed.

The collected data are the statistics that can be monitored and displayed in the chart. The data sources are the items from which Oracle Performance Manager is able to collect the data. For example, the data source of disk statistics may be disk1 or disk2, and the data source of file statistics may be file1 or file2.

By clicking in the column next to the name of the collected data or the name of the data source in the chart property sheet, you can specify whether or not to monitor that collected data or data source and display it in the chart.

When a green check mark appears in the column, Oracle Performance Manager will display that collected data or data source in the chart. If you click in the column again, the check mark goes away, which indicates that Oracle Performance Manager will not display that collected data or data source. You can toggle back and forth between monitoring and not monitoring all the collected data or data sources by...
clicking in the column head. If the check mark is gray, it means Oracle Performance Manager will display the collected data or data source, and you are unable to change the selection of this data.

If the chart definition contains default data source or collected data attributes, then those items are preselected in the chart’s property sheet.

**Using the Chart Display Window**

When you display a chart, Oracle Performance Manager opens the Chart Display window. The window contains its own toolbar and menu bar. For information about the Chart Display window, choose **Window** from the Chart Display window **Help** menu.

**Selecting a Chart Format**

To change the format of the chart, click on the **Chart Format button** in the Chart Display window toolbar and select the format in which you want to display the chart from the list that displays.

For example, suppose a chart initially displays as a bar chart. To see the data as a pie chart, choose **Pie Chart** from the list that displays when you click on the Chart Format button in the toolbar. You can also display a chart in one of the additional formats:

- Bar (vertical or horizontal orientation)
- Strip (or line chart)
- Table (vertical or horizontal orientation)
- Hierarchical

You can also choose a chart format from the View menu in the Chart display window or right mouse click on a chart and select a chart type from the context menu. For more information about the buttons on the Chart Display window toolbar, see the Oracle Performance Manager online help.

**Note:** Depending upon the type of chart you are displaying, one or more of the chart formats may not be available.
Setting the Chart Refresh Rate

By default, most charts are set to refresh every fifteen seconds but vary based on the chart. That means that Performance Manager collects the data every fifteen seconds and then immediately refreshes (or redisplay) the chart using the new data.

To change the refresh rate for the current chart:

1. Click the **Refresh Rate** button in the Chart Display window toolbar.
   Performance Manager displays the Refresh Rate dialog box.

2. Use the fields on the dialog box to set a new refresh rate for the current chart.

3. Click **OK** to close the dialog box and display the chart using the new refresh rate.

You can also choose Refresh Rate from the **Collection menu** to change the refresh rate.

Pausing and Restarting a Chart

By default, Performance Manager continues to collect performance data and update the current chart using the current refresh rate.

To pause a chart so it stops redisplaying based on the refresh rate, click the **Pause Chart** button in the Chart Display toolbar.

To restart the chart, click the **Resume Chart** button in the Chart Display toolbar.

Selecting Chart Options

After you display a chart in the Chart Display window, you can still modify the collected data and data sources for the chart. For more information about selecting the collected data and data sources before you display a chart, see "Selecting Collected Data and Data Sources" on page 3-11.

To set the chart options:

1. Click the **Options** button in the Chart Display toolbar.
   Performance Manager displays the Options dialog box.

2. Use the Options dialog box to add or remove data items from the chart.
   For more information on selecting data sources and selecting collected data, click **Help**.
You can also access the Options dialog box by choosing Options from the Collection menu.

Oracle Performance Manager also allows you to select filters to limit the data collected for a chart. However, not all charts provide filters. For charts that allow you to filter the chart data, you can select a limit to the number of data sources that are displayed. For example, if the data sources are the processes on an operating system, you can modify the chart to display only 10 processes, rather than all the processes.

For example, to select a limit to the number of data sources that are displayed for the Pagefaults Per Session chart, do the following:

1. Highlight the Pagefaults Per Session chart in the navigator tree of the Performance Manager main window. You can locate the chart by traversing the tree as follows: Network=>Nodes=><Name of Node=>Process=>Pagefaults Per Process.

2. Click the Options tab in the Property Sheet panel.

3. Enter 10 in the Maximum Number of Data Sources to Display field. The 10 data sources will be sorted by Page Faults per second, as shown in the Sort the data by drop-down list.

4. Click Show Chart.

Performance Manager displays the chart, but includes a maximum of 10 data sources.

---

Note: The Pagefaults Per Session chart in the Process class is available only when you are monitoring a Windows NT node. For a UNIX node, select the Process Info chart in the Process Data class as an example of a chart you can filter.

---

Note: The number of options available on the Options tab will vary, depending upon the chart you are modifying. Some charts offer more or fewer options than the Pagefaults Per Process chart discussed here.
You can later change this setting after the chart is displayed:

1. In the Chart Display window for the Pagefaults Per Process chart, click the **Options** button in the toolbar.

2. In the **Options** tab, set the **Maximum Number of Data Sources to Display** back to 7.

3. Click **OK**.

These options can be useful for finding the top resource users. In the case where processes are the data sources and the data collected is memory usage and CPU usage, you can ask the Agent to limit the number of data sources to 10, and to sort by memory usage. Your chart would then show the 10 processes using the most memory. If you were to sort by CPU usage, you would get the 10 processes using the most CPU instead.

Some charts can also give different views of the data. If that feature is available, you will also be able to select a view of the data. An example of a data view may be the current rate per second or current rate per transaction for each piece of data collected in the chart.

### Chart-Specific Commands

Some types of charts have their own unique commands. For example, you can select the **Kill Session** command when you are viewing the Lock Manager charts for Oracle database targets, or **Turn SQL Trace On** if you are viewing a Top Sessions chart.

To see if a chart-specific command is available for a chart:

- Click the right mouse button on an item name in the chart legend or a data item in the chart and click **Drilldown** on the context menu.
- Click the **Drilldown** menu on the Chart Display window menu bar.

### Drilling Down from One Chart to Another

Some charts have drill-down charts associated with them. To see if any drill-down charts are available for the current chart, do one of the following:

- Click the right mouse button on an item name in the chart legend or a data item in the chart and click **Drilldown** on the context menu.
- Click the **Drilldown** menu on the Chart Display window menu bar.
- Click on the **Chart Status** button.
In all cases, Performance Manager displays any drill-down charts associated with that chart item as menu options on the **Drilldown** menu. If a list of drill-down chart names is not displayed, no drill-down charts are associated with that item.

---

**Note:** If you have trouble selecting a particular data item when you try to drill down for related data, pause the chart or reduce the refresh rate. For more information, see “Pausing and Restarting a Chart” on page 3-13.

---

**Using the Chart Status Button**

You can use the Chart Status button located in the upper right corner of a chart to perform one of several tasks. When you click on the button, menu items appear based on the context of the chart as seen in Figure 3–3.

**Figure 3–3 Chart Status Button**

- View the threshold status of chart metric(s)

The Chart Status button displays the current status of thresholds for metrics in the chart. If an indicator flag is present, at least one of the metrics on the chart has thresholds defined. The most severe threshold displays on the button. A green flag indicates that no metrics have crossed a threshold, a yellow flag indicates that at least one metric has crossed a warning threshold, and a red flag indicates that at least one metric has crossed a critical threshold. When you press the Chart Status button, you can view the status of individual metrics within the chart. If several metrics have crossed warning or critical thresholds,
the menu items are sorted according to the severity, with the indicators for the most severe items on top and the less severe on the bottom.

Thresholds are available only for node and database data.

- Display advice on a data item

When you choose Advice from the Chart Status button, Performance Manager displays an information window that provides information about the currently selected data item along with guidelines for solving existing problems, or suggestions about other charts to view for further diagnosis, as seen in Figure 3–4.

**Figure 3–4  Viewing Advice from the Chart Status Button**

---

**Buffer Cache Hit %**

**Description**

This data item represents the data block buffer cache efficiency, as measured by the percentage of times the data block requested by the query is in memory.

Effective use of the buffer cache can greatly reduce the I/O load on the database. If the buffer cache is too small, frequently accessed data will be flushed from the buffer cache too quickly, which forces the information to be re-fetched from disk. Since disk access is much slower than memory access, application performance will suffer. In addition, the extra burden imposed on the I/O subsystem could introduce a bottleneck at one or more devices which would further degrade performance.

**Data Source**

\[
\frac{(\Delta \text{Logical Reads} - (\Delta \text{Physical Reads} - \Delta \text{Physical Reads Directly})/\Delta \text{Logical Reads}) \times 100}{\text{where:}}
\]
Drill down to a chart

After you select a data item, you can choose to drill down to one of the charts displayed in the list or invoke tools like SQL Analyze.

Set or reset thresholds for a chart or an event

You can set chart-only thresholds for a data item or you can reset the chart-only threshold to its default value. You can choose to set or edit the threshold for the value in the chart only, or you can edit or register an event threshold for the data item. For more information, see "Registering Events in Performance Manager" on page 3-30.

Thresholds are available only for node and database data.

Edit a threshold association

You can edit a threshold association for a metric by selecting Edit Threshold Association from the Chart Status button and choosing an event from the dialog box that appears. For more information, see "Editing Threshold Associations" on page 3-34.

Thresholds are available only for node and database data.

Refresh thresholds

To view Event System changes made while a Performance Manager chart is visible, choose Refresh Thresholds from the Chart Status button menu on the Performance Manager chart. For more information, see "Refreshing Thresholds" on page 3-33.

Thresholds are available only for node and database data.

Drilling Down to an Historical Chart

From a Performance Manager real-time chart, you can drill down to see an historical view of the same data collected over a longer period of time, for example,
days, months, and years. This view of historical data, provided by the Oracle Capacity Planner software, allows you to analyze long-term trends in the data.

Historical data collection must be enabled to view the historical data for a chart. If you drill down to a historical chart for which historical data collection has not been enabled, Performance Manager allows you to start historical data collection. You can also start historical data collection by starting Oracle Capacity Planner. From the Capacity Planner window, you can also control other aspects of your historical data collection, such as how often data is collected and loaded into the historical database.

---

**Note:** User-Defined charts do not support drill-down to historical data.

---

To drill down to historical data:

1. Display a chart in the Chart Display window.
2. Click the right mouse button on a data item in the chart.
3. From the context menu, click **Drilldown**.
4. From the **Drilldown** submenu, click **Historical Data**.

What happens next depends on whether or not you have begun collecting historical data. Consider three possible scenarios:

- If Performance Manager finds historical data related to the chart, Performance Manager displays the Analysis Chart window.

  Note that if you previously set up your historical database using an alternate database location, Performance Manager displays a database logon box before it displays the Analysis Chart window.

  The Analysis Chart window shows you the historical information about the collected data. From here, you can modify the format of the chart or perform a trend analysis on the historical data. For more information, select an option from the **Help** menu in the Analysis Chart window or see the chapter about Capacity Planner in this manual.

- If Performance Manager cannot find historical data related to the chart, the following message appears:

  The historical chart cannot be displayed because there is no history available for the data sources or data items.
Would you like to begin collecting the history of these data sources and data items now so that you can view the chart in the future?

Click Yes to begin collecting historical data automatically or click Help to learn how to collect historical data using the Oracle Capacity Planner software.

When you click Yes, Performance Manager displays another message explaining that historical data is now being gathered, but is not yet available. Click Continue to return to the Display Chart window.

■ If no historical data has ever been saved to the historical database, Performance Manager displays a message box that includes the following errors:

Error connecting to the historical database.
The specified schema is not a Capacity Planner database.

Click Continue. Performance Manager displays the message described in the previous bullet item.

Click Yes to begin collecting historical data or click Help for more information about how historical data is collected. When you click Yes, Performance Manager displays another message explaining that historical data is now being gathered, but is not yet available.

Click Continue to return to the Display Chart window.

Displaying Alternate Chart Orientations

You can display bar charts and tables with either a horizontal or vertical orientation.

To change the orientation of the bar chart or table, click the button associated with the orientation that you want.

Sorting Data in a Table Chart

When a chart is displaying data in table format, the sort order of the column data can be changed by clicking the column headers in the table. The first click on a column header sorts the data in ascending order, and a second click sorts the data in descending order.

Changing the sort order in the chart table does not affect the data’s sort order on the server. To change the sort order of the data on the server, use the Options page. For more information, see "Selecting Chart Options" on page 3-13.
Saving Your Changes to a Chart

If you are working in repository mode and you make modifications to a chart (for example, if you change the format, orientation, or sorting order of a chart), you can save your changes in one of two ways:

- Click **Save** on the Chart Display **File** menu.

  Performance Manager saves your changes using the same name as the original chart. When you display the chart again, your changes will appear in the Chart Display window.

  To later remove your changes and display the predefined chart using its original settings, click **Remove Chart** on the **Chart** menu.

- **Note:** You can remove the changes you saved to a predefined chart, but you cannot delete the original predefined chart.

- Click **Save As** on the Chart Display **File** menu.

  Performance Manager displays the Save Custom Chart dialog box. Use this dialog box to enter a name for the custom chart and to indicate whether you want to create a similar chart for other targets of the same type. For information about the fields on the Save Custom Chart dialog box, click **Help**.

  Click **OK** in the Save Custom Chart dialog box to save the custom chart using the name you provided. Performance Manager saves the chart in the Custom Charts folder for the selected target.

  To delete a custom chart from the Custom Charts folder, select the chart and click **Remove Chart** on the **Chart** menu.

- **Note:** You can delete custom charts, but you cannot delete predefined charts.

Obtaining Help for a Class, Chart, or Data Item

To get help on a class or chart:

1. Select the class or chart in the main window navigator.
2. From the **Help** menu, choose **Selected Item**.
If help is available for the selected chart, Performance Manager displays a message box or a help topic window describing the chart data.

To get help on a data item:
1. Select a chart.
2. In the Property Sheet panel, select a data item and choose Selected Item from the Help menu.

Note: Help is not available for all objects.

Printing a Chart
To print a chart, click the Print Screen button on the Display Chart window toolbar.

The size of the chart on the screen determines the size of the chart in the chart printout. For example, when you print a chart that is 5 inches high and 7 inches wide on your screen, the chart will be 5 inches high and 7 inches wide in the printout.

Generating a Report for a Chart
To generate an HTML report for a chart:
1. Click the Report Chart button while the chart is displayed.
   Performance Manager displays a dialog box that tells you the name of the HTML file used to display the report and where the file will be saved.
2. Make a note of the file name and location.
3. Click Yes to preview the chart in your Web browser, or click No if you do not want to preview the report.

You can view the report later using a Web browser, or—if you have experience with Web publishing tools and techniques—you can share the report with your co-workers by publishing the HTML file and its associated graphic files on a Web server.

Recording Chart Data
Oracle Performance Manager allows you to record the data being monitored in a chart. After a recording is complete, you can play it back. During playback, you can pause and fast forward the recording, if you wish.
Chart recordings are saved under the **Recordings** folder and on the Recordings tab of the right pane of the Performance Manager main window when a recorded chart is selected. The Recordings tab is added to a chart’s property sheet after you record the chart.

You can manage chart recordings in the **Recordings** folder without connecting to the target from which a chart was recorded. If you are already connected to a target, you can see a chart’s recordings by selecting the **Recordings** tab in that chart’s Detail property sheet.

**Starting a Recording**

You start a recording by performing one of the following steps:

- With a chart highlighted in the navigator tree of the Performance Manager main window, click **Record Chart** on the chart’s property sheet.

- With a chart displayed in the Chart Display window, click **Start Recording** in the Chart Display window toolbar.

- With a chart displayed in the Chart Display window, click **File=>Recording=>Start Recording**.

Oracle Performance Manager displays the Recording Parameters dialog box. For more information on the fields in the Recording Parameters dialog box, click **Help**.

**Stopping a Recording**

To stop recording a chart, do one of the following:

- To stop recording the current chart, click the **Stop Recording** button in the Chart Display window toolbar.

- To stop all recordings at one time, choose **Stop All Recordings** from the Performance Manager main window **Recordings** menu.

- To stop a recording from the **Recordings** folder, expand the **Recordings** folder in the Performance Manager main window and navigate to the chart. Select the chart and click **Stop Recording** on the chart’s property sheet.

- With a chart displayed in the Chart Display window, click **File=>Recording=>Stop Recording**.
Playing a Recording

**Note:** Before you can play a recording, you must stop the recording. For more information, see "Stopping a Recording" on page 3-23.

To play a recording, do the following in the Performance Manager main window:

1. Navigate to the **Recordings** folder.
2. Select the chart you want to play in the navigator tree.
3. In the corresponding property sheet, select the recording from the list of recordings for the selected chart, and click **Play Recording** (or on the **Recordings** menu click **Play Recording**).
4. In the Chart Display window toolbar, click **Start Playback**.

   The **Stop Playback**, **Pause Playback**, and **Fast Forward** buttons become available in the playback window (**Figure 3–5**). When the playback is complete, the **Reset Playback** button becomes available.

**Figure 3–5  Chart Playback Buttons in the Chart Display Window**

Removing a Recording

To remove a recording:

1. Navigate to the **Recordings** folder or the Recordings tab on the chart’s Detail page.
2. Select the recording you want to remove.
3. From the **Recordings** menu, click **Remove Recording**.

Chart Display Window Menu Shortcut Keys

Table 3–2 lists the Chart Display Window menu and submenu items along with their corresponding shortcut keys.
Table 3–2  Chart Display Window Shortcut Keys

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Screen</td>
<td>Control+P</td>
</tr>
<tr>
<td>Report Chart</td>
<td>Control+R</td>
</tr>
<tr>
<td>Start Recording</td>
<td>Control+K</td>
</tr>
<tr>
<td>Stop Recording</td>
<td>Control+J</td>
</tr>
<tr>
<td>Start Playback</td>
<td>Control+Q</td>
</tr>
<tr>
<td>Stop Playback</td>
<td>Control+Y</td>
</tr>
<tr>
<td>Pause Playback</td>
<td>Control+W</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>Control+F</td>
</tr>
<tr>
<td>Reset Playback</td>
<td>Control+B</td>
</tr>
<tr>
<td>Save</td>
<td>Control+S</td>
</tr>
<tr>
<td>Save As</td>
<td>Control+A</td>
</tr>
<tr>
<td>Close</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Pause/Resume Chart</td>
<td>Control+Q</td>
</tr>
<tr>
<td>Refresh Rate</td>
<td>Control+E</td>
</tr>
<tr>
<td>Options</td>
<td>Control+O</td>
</tr>
<tr>
<td>Historical Data</td>
<td>Control+D</td>
</tr>
<tr>
<td>Using Help</td>
<td>Control+Shift+U</td>
</tr>
<tr>
<td>Help on Item</td>
<td>Control+Shift+H</td>
</tr>
<tr>
<td>Contents</td>
<td>Control+H</td>
</tr>
<tr>
<td>Search</td>
<td>Control+Shift+S</td>
</tr>
<tr>
<td>Window</td>
<td>F1</td>
</tr>
</tbody>
</table>

Working With Events and Thresholds in Performance Manager

You can create and edit threshold values from both the Oracle Enterprise Manager console and Performance Manager.
From Performance Manager, you can create and edit a Chart-only threshold, create and register an event, reset a Chart-only threshold, or edit a registered event. From the Enterprise Manager console, you can create, edit or deregister an Enterprise Manager event but you cannot edit or view Chart-only thresholds.

You can set thresholds on data items by using event tests or by setting a threshold for a data item in a chart (Chart-only threshold) using the Set Chart-only Threshold dialog box seen in Figure 3–6. When you monitor a chart that contains a data item that supports a threshold established for an event, you can edit the parameters for that event by choosing Set Threshold from the Chart Status button.

When you create events from Performance Manager, the event is initialized with the context defined by the Performance Manager chart. You can only modify the event tests in an event if the event was registered using the Oracle 9i Agent.

If a data item supports the concept of an event, the chart displays a visible indicator (a flag) based on thresholds stored in the repository for that data item. If the data item does not support the concept of an event, you cannot establish a chart-only threshold for the data item. Every metric-based event test can have a warning and a critical threshold value. The flag indicators on a chart specify whether a threshold value has crossed a warning or critical threshold. The flag that appears on the Chart Status button in a chart displays the most serious state of any contained metric thresholds, and the metrics that appear when you click on the Chart Status button are sorted with the most serious indicators displayed first in the list.

---

**Note:** The Performance Manager threshold and event features described in this section are available only for node and database data.
Threshold values may be derived from one of three sources:

- A default value for some metrics that is added to the repository at the time of product installation.
- Chart-only thresholds, which are warning and critical threshold values for a specific metric, target, target type and instance.
- An event test derived threshold, which can be shared among administrators depending on the access rights of the user and the event containing the event test. When you set a threshold on a data item associated with an existing event, the thresholds displayed in that chart correspond to the thresholds set for the event test.

The threshold types listed above apply to metrics in a specific order of precedence:

- If you have Event System access and access to an event containing a metric, the threshold values for the metric are defined by the Event Test and override any Chart-only or default threshold values.
- If you have established a Chart-only threshold for a metric, the threshold values you establish are valid and supersede any default values that may exist.
If neither of the previous two scenarios exist and a default threshold is defined in the repository for the metric, the default value defines the warning and critical thresholds for this metric, regardless of target or data source.

Threshold values are stored in the Oracle Management Server repository and are updated whenever the user sets or edits a Chart-only threshold or when Event registration changes occur. Chart-only thresholds are removed from the repository when you invoke Reset Threshold or when the Administrator is removed from the system. If you create a Chart-only threshold that is later overridden by the registration of an event, the Chart-only threshold remains in the repository. If the association between the metric and the event is later broken, the Chart-only threshold is restored.

To set or edit thresholds in Performance Manager:

1. Click the **Chart Status** button in the upper right corner of the chart below the menu bar.

2. Select the data item for which you want to set a threshold and then choose **Set Thresholds** from the context menu.

   If there is more than one data source displayed in a chart when you select **Set Thresholds**, Performance Manager displays the Select Data Source dialog box where you must choose a single data source for which to set a threshold. When you create or edit a chart-only threshold or create a new event, you must choose a single data source before setting thresholds.

3. To set or modify a Chart-Only threshold, select **Set Chart-Only Threshold** at the bottom of the window. To register an event, select **Register Event**.

   **Note:** If you do not have permission to access the Enterprise Manager Event System, the option of registering an event from the dialog box is not present.

4. To set or modify a Chart-Only threshold, add or modify the values in the **Warning Threshold** and **Critical Threshold** fields. If default warning or critical threshold values are defined for the metric, the input fields will contain these values.

   To register or modify an event, select **Register Event** and then complete the fields in the General, Test, Parameters, Schedule, Access and Fixit Jobs pages of the event property sheet. If you are using a pre-9i Agent and you modify an event that has been registered, those changes are not used by the registered event.
Triggers Events and Thresholds

Events and thresholds often poll at different intervals. For example, events may be polled at intervals of minutes or even hours, while thresholds may be sampled in seconds. The result is that you could see a metric cross a threshold in a chart but not be notified of an event simultaneously. If the problem were caused by a spike, the threshold may be crossed in the chart with a sampling occurrence measured in seconds, but not trigger an event because the metric is sampled in minutes or hours, meaning the event is never triggered at all.

Additionally, events can include the concept of occurrences. Occurrences prevent notification for erratic or one-time instances of a threshold being crossed. If an event has a number of occurrences associated with a test, you may see the threshold crossed in a chart but never see the corresponding event triggered.

Events Registered for Multiple Targets

If you attempt to modify a threshold that has an associated event test registered for multiple targets, a warning displays indicating that the change you make will affect the event test for multiple targets and that if you want to use different thresholds for each target, you must create separate events. If you continue with the change, the existing event is deregistered for all targets and re-registered for all targets with the new threshold.

Metrics with Multiple Events and Different Thresholds

When you display a chart for a data item for which there are multiple event tests, a message is displayed indicating that there are multiple tests for the same metric. To show a threshold for the chart, you must select which event test to associate with the metric. If you then modify the associated event test or the metric in the chart, the thresholds are synchronized. Other tests of the metric are not affected by changes to the threshold in a chart.

If another user de-registers the associated event test and then you display a chart with that metric, a warning displays indicating that the previously associated event test no longer exists. If only a single event test remains for the metric, the message indicates that the remaining event is now associated with the metric. If more than one event remains, the message indicates that you must select a new event to associate with the metric.

If you add a new event test for a metric where a single chart-only threshold already exists, the thresholds associated with the previous test will not be used during monitoring.
Event Permissions

If you display a chart for which you have read-only permission for the corresponding event, you cannot modify the thresholds for that chart. You receive a read-only view of the event indicating that if you wish to change the thresholds associated with the data item, you must be granted appropriate access to the event system.

---

**Note:** Super-users who set up permissions on an event should consider the effect on non-privileged administrators who will be unable to modify the thresholds.

---

Registering Events in Performance Manager

You can register events from within Performance Manager through the Chart Status button on a chart containing the data item for which you want to register an event.

Registering events through Performance Manager is procedurally identical to registering events through the Enterprise Manager console.

To create or edit events in Performance Manager:

1. Click on the **Chart Status button** in the upper right corner of the chart.
2. Select the data item and then choose **Set Threshold** from the context menu.
   
   If there is more than one data source displayed in a chart when you select Set Threshold, Performance Manager displays the Select Data Source dialog box where you must choose a single data source for which to set a threshold. When you create or edit a Chart-only threshold or create a new event, you must choose a single data source before setting thresholds.

3. Select **Register Event** at the bottom of the dialog box.
4. Complete or modify the fields in the General, Test, Parameters, and Permissions pages of the property sheet to create a new event. If you are using a pre-9i Agent and you modify an event that has been registered, those changes are not used by the registered event.

When you use a pre-9i Agent, the property sheet for creating a new event is similar to the property sheet for modifying an event. Some fields are editable while others are not. If you are using a 9i Agent, you can modify many more fields.
You can use several predefined event tests that have been installed with Oracle Enterprise Manager. See Chapter 6, "Oracle Applications Advanced Event Tests" for more information on these event tests.

**About Oracle 9i and Pre-9i Agents**

If you attempt to register a 9i event with a pre-9i Agent, you will receive an error message indicating that you cannot register the event. You can use only a 9i Agent to register 9i events.

If there exists both a 9i and pre-9i version of the same event, then the Oracle Management Server will determine which to use depending on the Agent version. For example, if there is a 9i Agent, the Agent will request registration using the 9i version of the event. If the Agent is pre-9i, then it will use the pre-9i version.

If you have migrated from a pre-9i Agent, then an existing event will not automatically use the 9i counterpart. To use the 9i test and access thresholds in the repository, you must deregister the pre-9i event and register the 9i event using the 9i Agent.

**Viewing Thresholds**

If a Performance Manager chart is displaying metrics that have multiple data sources, you can display the View Thresholds dialog box to view all threshold indicators. The View Thresholds dialog box is accessible from the Chart Status button.

The View Thresholds dialog box displays the current threshold status of each data item and its corresponding data source. You can view the status for each metric/data source pair using flags to indicate whether the value of the data item has passed its warning or critical threshold. If a data item has no threshold set, the column containing that data item is left blank.

When you display the View Thresholds dialog box, the current data item and threshold values are captured in a dataset and the status of each threshold is displayed in the table. A timestamp of the dataset appears in the bottom left corner of the View Thresholds dialog box.

If you change a threshold value for a data item while the View Thresholds dialog box remains open, the new threshold value is compared against the dataset created at the time you displayed the dialog box, not against the current value of the data item in real time. To refresh the statuses in the View Threshold dialog box, close and redisplay it.
You can add or change threshold values by clicking the **Chart Status** button on the View Thresholds dialog box and choosing **Set Threshold** from the context menu.

To view thresholds:

1. Click the **Chart Status** button for the chart containing the data item for which you want information and select **View thresholds** from the context menu.

   The View Thresholds dialog box appears, displaying the status of any thresholds set for each of the data items and data sources in the chart. The status for a threshold is indicated by the flag that appears in the column for the data item and data source.

   - A **green flag** indicates the value for the data item has not crossed a threshold.
   - A **yellow flag** indicates the value for the data item is at or has passed the warning threshold.
   - A **red flag** indicates the value for the data item is at or has passed the critical threshold.

   If no threshold is set for a data item, the status for that metric is left blank.

   The threshold statuses that appear in the View Thresholds dialog box are derived from dataset values gathered at the time you display the View Thresholds dialog box. The date and time of the dataset appears at the bottom of the dialog box. The View Thresholds dialog box is not updated when the Performance Manager chart is refreshed.

   From the View Thresholds dialog box, you can set thresholds or reset and edit associations for a specific cell if thresholds are set.

You can set or edit a threshold for a metric from the View Thresholds dialog box by clicking the **Chart Status** button and selecting **Set Thresholds** from the context menu. For more information about setting thresholds, see "Working With Events and Thresholds in Performance Manager" on page 3-25.
Resetting Thresholds

You can reset Chart-only thresholds through the Chart Status button on a chart. If you reset a Chart-only threshold for a data item, the current threshold is deleted and is reset to its default value. If the data item has no default value, the threshold is simply deleted and no value is assigned as a threshold.

If you select Reset Threshold for a data item with an assigned event, a message box displays stating that you must deregister or edit the event from within the Enterprise Manager console.

To reset a threshold:

1. From the chart, click on the Chart Status button and select the metric and data source for which you want to reset a threshold.

2. From the context menu, choose Reset Threshold. When you select Reset Threshold, the current data item is reset to its default value. If the data item has no default threshold value, the threshold is eliminated.

   A confirmation dialog box appears, verifying that you are about to reset the threshold for the current metric. Click the OK button to confirm.

   If no threshold exists for the metric, an error dialog box displays informing you that the threshold cannot be reset because no threshold exists for the metric.

   If you attempt to reset a threshold associated with a registered event, an error message dialog box displays. You cannot deregister an event from within Performance Manager because the event associated with a metric may have several other targets and tests. You can instead edit the event from within Performance Manager by choosing Set Threshold (for 9i targets) to remove or modify the event.

Refreshing Thresholds

A chart may not reflect an event that is registered while the related chart is open because the information for the metric in the chart related to the event has not been
read from the repository. A chart does not automatically reflect the effect of event system changes. When you select Refresh Thresholds from the Chart Status button, Performance Manager updates the chart with the new data from the threshold repository and updates the chart threshold indicators.

When Event Registration or Permission changes effect the threshold repository, Performance Manager users are notified of these changes in a dialog box when the threshold data for the metric is next read from the repository. The following actions are conveyed to the Performance Manager user when a chart is opened, thresholds are refreshed for a chart, or thresholds are edited:

- An event test associated with a metric has been deregistered.
- A Chart-only threshold is overridden by the registration of an event test by another user.
- An event test associated with a metric has failed registration.
- Access to an event containing an event test associated with a metric has been removed.
- An event test associated with an event has been removed from the event or the instance has been modified.
- An event test associated with a metric has failed event modification.

To refresh thresholds, choose Refresh Thresholds from the Chart Status button on the Performance Manager chart.

**Editing Threshold Associations**

There may be circumstances when a user has permission to view several events that contain the same event test. When viewing a chart, you must decide which event will be associated with the metric in the chart. You can invoke Edit Threshold Association to change this association.

The Edit Threshold Association menu item has no application for data items with less than two events assigned to it. If you select Edit Threshold Association in such a case, a message box appears informing you that the threshold association cannot be changed because a threshold association for the metric does not exist or there is only one registered event test.

You cannot change the association for Chart-only thresholds because each user has his own pool of Chart-only thresholds and duplicates are not supported.

To edit threshold associations:
1. Click the Chart Status button in the current chart and select the metric for which you want to edit the threshold association, and then choose Edit Threshold Association from the context menu.

2. When applicable, select the data source from the Select Data Source dialog box and click OK.

3. Select the event threshold you want to assign to the data item in the list that appears in the Associate Metric with Event Test dialog box.

4. Click the OK button at the bottom of the Associate Metric with Event Test dialog box.

**Note:** If you attempt to set a threshold association when the metric is not associated with an event test or you only have permission to view one registered event test for the specified target and data source, an error dialog box appears informing you that the association cannot be changed.

To edit threshold associations:

1. Click the Chart Status button in the current chart and select the metric for which you want to edit the threshold association and then choose Edit Threshold Association from the context menu.

2. When applicable, select the data source from the Select Data Source dialog box and click OK.

3. Select the event threshold you want to assign to the data item in the list that appears in the Associate Metric with Event Test dialog box.

4. Click on the OK button at the bottom of the Associate Metric with Event Test dialog box.

**Running Performance Manager in a Browser**

You can run Oracle Performance Manager in a browser and use a significant subset of the features of the full product, including basic monitoring features and event integration. Browser support includes basic monitoring features and event integration if you are using a version 9i Agent (or later).

The following features are available when running Performance Manager in a browser:
Viewing Metric and Event Documentation Through a Browser

You can view specific information about metrics, events, charts and classes in Performance Manager through the Advice function on the Chart Status button and...

- Show database chart
- Show node chart
- Show Oracle Applications chart
- Drilldowns
- Help
- Quick Tour
- Print Screen from charts
- Report Chart from charts
- Pause/Resume charts
- Set Refresh Rate
- Set Options
- Setting Chart-only thresholds (this feature is available for node and database data only)
- Event Registration (this feature is available for node and database data only)

The following features are not available while running Performance Manager in a browser:

- Recordings
- Historical collection drilldowns
- Custom Charts
- Saved chart attributes
- User-defined charts
- Direct Connect
- Standalone mode
- SQL Analyze
- Threshold status

Viewing Metric and Event Documentation Through a Browser

You can view specific information about metrics, events, charts and classes in Performance Manager through the Advice function on the Chart Status button and...
through other contextual functions within the Oracle Enterprise Manager application. However, you can view the full set of documentation for all the following types of metrics and events independently through your web browser without having to access the Oracle Enterprise Manager application. The documentation available through your browser provides a comprehensive Table of Contents, an index keyword search, and a full text search function.

- Oracle Database
- Windows NT
- IBM AIX
- Sun Solaris
- HP-UX
- Compaq Tru64
- SAP R/3 System
- Oracle Applications system

For each of these types of metrics and events, the following information is provided.

For Metrics:
- Classes
- Charts
- Data Items
  - Description
  - Source
  - User Action
- Event Tests
  - Description
  - Source
  - Parameters
  - Output
  - Frequency
  - User Action
To access each documentation set, open the appropriate file below in a web browser:

- Oracle Database -- `ORACLE_HOME/doc/EM/Webhelp/dba/dba.htm`
- Windows NT -- `ORACLE_HOME/doc/EM/Webhelp/nt_os/NT_OS.htm`
- IBM AIX -- `ORACLE_HOME/doc/EM/Webhelp/aix/AIX.htm`
- Sun Solaris -- `ORACLE_HOME/doc/EM/Webhelp/sol/SOL.htm`
- HP-UX -- `ORACLE_HOME/doc/EM/Webhelp/hpux/HPUX.htm`
- Compaq Tru64 -- `ORACLE_HOME/doc/EM/Webhelp/dec/DEC.htm`
- SAP R/3 -- `ORACLE_HOME/doc/EM/Webhelp/sap/sap.htm`
- Oracle Applications System -- `ORACLE_HOME/doc/EM/Webhelp/oafnd/OAFND.htm`
Introduction to Oracle Capacity Planner

Oracle Capacity Planner is an Oracle Enterprise Manager application that allows you to collect different types of performance statistics and record that data in an historical database. You can then use Oracle Capacity Planner to analyze the historical data to plan future capacity.

**Note:** In releases prior to 9i, the Agent data gathering service (also known as the Oracle Data Gatherer) was used to collect data for presentation in real-time performance monitoring utilities and historical data. The Intelligent Agent and the data gathering service were separate services that were started and stopped independently of each other.

With 9i, the data collection capabilities are integrated into the 9i Intelligent Agent. Therefore, there is no separate service that needs to be started. Furthermore, when you stop the 9i Intelligent Agent, the data gathering capabilities are disabled and not available.

Oracle Capacity Planner uses the Intelligent Agent (Agent) to collect its historical data. To collect most types of data, you must install the Agent on the system (or systems) where you want to collect data. See the *Oracle Intelligent Agent User’s Guide* for information on managing the Agent.

If you are using Oracle Capacity Planner to collect concurrent manager data, the Agent can be installed on another system.

The types of performance data that Oracle Capacity Planner can collect on a system depend on the products that are installed. Table 4–1 shows the types of data that Oracle Capacity Planner can collect when various Oracle products are installed. The
number of targets that appear in the Capacity Planner navigator tree will also vary, depending on the number of applications you have installed.

**Table 4–1 Data That Capacity Planner Can Collect When Various Oracle Products are Installed**

<table>
<thead>
<tr>
<th>Oracle Product</th>
<th>Oracle Concurrent Manager Data</th>
<th>Oracle Database Data</th>
<th>Node (Operating System) Data</th>
<th>SAP R/3 System Data</th>
<th>Microsoft SQL Server Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics Pack</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Management Pack for Oracle Applications</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Management Pack for SAP R/3</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

If additional products from Oracle are installed, Oracle Capacity Planner may be able to collect additional types of data not shown in **Table 4–1**.

**How Capacity Planner Collects and Stores Performance Data**

The following list identifies how Capacity Planner uses the Agent to collect performance data:

- The Agent collects the data at an interval you specify from within Capacity Planner.
  
  The Agent stores the data in an efficient binary form.

- At a specified loader interval, the data is read from this binary file and stored in a readable form in the Oracle Capacity Planner historical database.
  
  The Agent also aggregates the data by time, creating summary statistics for the data that is collected at different time intervals (hour, day, week, and so on).

- Over time, the Agent purges the data in the historical database, keeping only as much data as you specify.
Purging the historical data allows you to have access to a current view of recent performance data for your environment and to manage the amount of stored data to avoid wasting disk space.

Accessing Historical Data Through an Intermediate Host

Oracle Performance Manager relies on the Agent to monitor a target (such as a node, a database, or a concurrent manager). Usually, the collection of the data is done on the system where the target is located. However, for some types of targets Oracle Performance Manager can also monitor data on a system by using the Agent on another system (an intermediate host).

This intermediate host could be the client system where the Oracle Performance Manager is running, or any other system on the network on which the Agent is available.

There are three ways to set the location of the Agent. The method you use depends on how you connect to the target. Consider the following scenarios:

- You connect to a database that has been discovered using the Enterprise Manager console and you are running Oracle Capacity Planner while connected to the Oracle Management Server.
  
  Capacity Planner attempts to connect to the Agent on the host where the target is located. If this connection fails or cannot be attempted because no preferred credentials have been set for the database, you will be prompted with a dialog box containing logon credentials for the database. You can use the Connection Details dialog box to specify the location of the Agent that will be used to collect performance data.

- You click the Add Service button in the toolbar panel and manually add the target to the navigator.
  
  Capacity Planner displays a Logon dialog box. This dialog box also contains a field to specify the location of the Agent that will be used to collect performance data.

- You select a target in the Capacity Planner navigator tree and choose Set Connection Details from the File menu.
  
  Capacity Planner displays the Database Logon dialog box for the selected target. This dialog box also contains a field to specify the location of the Agent that will be used to collect performance data.
Usage Scenarios for Oracle Capacity Planner

Oracle Capacity Planner can perform tasks such as the following:

- Track the increase in the amount of used space on a disk over time and estimate when 95 percent of the space on the disk will be consumed
- Track the increase in the total I/O rate for a host over time, then estimate what the total I/O rate for the host will be at some future point in time
- Determine thresholds to set in Performance Manager by evaluating historical data gathered in Capacity Planner
- Provide a predefined set of data that measures performance (Oracle Recommended Collection)
- Publish historical data to a website where administrators and system administrators can view data that is periodically updated
- Display a chart that shows the number of forms sessions per user and per application; estimate how the numbers will change over a designated period of time.

Starting Oracle Capacity Planner

You can start Oracle Capacity Planner in any of the following ways:

- On the Oracle Enterprise Manager console, click the Application Management drawer, then click the Capacity Planner icon.
- On the Oracle Enterprise Manager console, select a Concurrent Manager target, click the right mouse button, point at Related Tools in the context menu, then click Capacity Planner.
- On the Tools menu of the Oracle Enterprise Manager console, point to Application Management, then click Oracle Capacity Planner.
- From the UNIX command line, change directory to the ORACLE_HOME/bin directory (where ORACLE_HOME represents the home directory in which the Management Pack for Oracle Applications is installed), then type the following command:
  
  ./oemapp cp

- From the Start menu, point to Programs, then to the Oracle Home where Oracle Enterprise Manager is installed, then to Oracle Applications, then click Capacity Planner, which displays the Capacity Planner Login dialog box.
Enter the appropriate connect information for your Oracle Enterprise Manager repository, then click OK.

**Using Help**

When you are using Oracle Capacity Planner, you can display context-sensitive help topics. You can also display conceptual topics and task topics.

To obtain context-sensitive help for an Oracle Capacity Planner panel, window, dialog box, or property page, select an item in the panel, window, dialog box, or property page, then on the Help menu, choose **Window**.

To obtain context-sensitive help for a class, chart, or data item on a property page, select the class, chart, or data item on the property page, then take one of the following actions:

- Press F1.
- Click the Help icon on the toolbar.
- On the Help menu, choose **Selected Item**.

If a help topic is not available for a class, chart, or data item, a No Help Available message is displayed when you request help.

---

**Note:** Not all the charts described in the appendix are available from within Oracle Capacity Planner.

---

To view the Contents page for the Oracle Capacity Planner help, on the Help menu, choose **Contents**. On the Contents page, you can:

- View a list of the conceptual help topics by double-clicking the **Conceptual Topics** book on the help system’s Contents page.

  Conceptual topics provide conceptual or overview information of which you should be aware before performing a particular Oracle Capacity Planner task. Conceptual topics do not contain step-by-step information for performing a task.

- View a list of the task help topics by double-clicking the **Task Topics** book on the help system’s Contents page.
Task topics provide step-by-step instructions for accomplishing an Oracle Capacity Planner task. They do not provide conceptual information that you should be aware of before performing the task.

You can access a glossary of Oracle Capacity Planner terms by double-clicking the Oracle Capacity Planner Glossary book on the Contents page.

**Using Oracle Capacity Planner**

You may find it helpful to think of using Oracle Capacity Planner as a two-step process:

1. Setting up the collection of historical data
   
   See "Setting Up a Collection" on page 4-6 for a detailed description of how to collect historical data.

2. Analyzing the collected data
   
   See "Analyzing Collected Data" on page 4-20 for a detailed description of how to analyze collected data.

**Setting Up a Collection**

To set up a historical data collection with Oracle Capacity Planner, you:

1. Select (and connect to) the targets for which you want to collect historical data.
2. Define the frequency of collection samples.
3. Define the location of the historical database and the frequency at which collected data should be loaded in the historical database.
4. Define the amount of data to be kept in the Oracle Capacity Planner database at each time interval.
5. Select the classes of data to collect, based on what is available in the Oracle Capacity Planner navigator.

Figure 4–1 shows the steps to follow when setting up a collection. For more information on each step, see the following sections.
Selecting Targets

You can select one or more targets from which you want to collect historical performance statistics. For example, when you have the Management Pack for Oracle Applications installed, the target types are typically Nodes and Concurrent Managers.

The procedure for selecting a target depends upon whether or not the server resides on a node that is known to the Enterprise Manager main console. A node is known to the console when it has been discovered with the Enterprise Manager console Discover Nodes command.

Selecting Targets on Discovered Nodes

To select a target on a node that has been discovered by the Enterprise Manager console:

1. Click the Collection tab of the Oracle Capacity Planner navigator panel, which displays the Oracle Capacity Planner collection view.
2. Double-click one of the target type folders.

The Oracle Capacity Planner navigator tree displays the targets of the selected type that are known to the Oracle Enterprise Manager main console.
3. Select the target from which you want to collect performance data and click the **Connect** button in the Capacity Planner toolbar, or click the plus sign (+) next to the target in the navigator.

When you connect to a target in the Oracle Capacity Planner navigator panel, you may be prompted for credentials if they are required to connect to that target. If a logon dialog box appears, click **Help** for information on the individual fields on the dialog box.

After you connect to a target, the available collection classes for that target appear in the navigator and Oracle Capacity Planner displays the Target property sheet for the selected target. For example, **Figure 4–2** shows the classes that appear when you connect to a Windows NT node target.

**Figure 4–2  Selecting a Target in the Oracle Capacity Planner Window**

Selecting Targets on Undiscovered Nodes

If you double-click a target type and the target you are looking for does not appear in the target type folder, you can do one of the following:

- Use the Enterprise Manager console to discover the node where the target resides.

This is the preferred method for adding a target to the Capacity Planner navigator panel. When you discover a node with the Enterprise Manager
console, Capacity Planner saves key information about the target, such as the preferred credentials, location of the Agent, and historical database information.

- Add the target manually to the Capacity Planner navigator panel.

When you add a target manually, the target is added for the current session of Capacity Planner only. You can start gathering data for the target, but the next time you start Capacity Planner, the target will not appear in the navigator panel. To modify collection settings or analyze data collected for the target, you will have to add the target again the next time you start Capacity Planner.

To add a target manually:

1. Select the target type for the target you want to add.
2. Click the **Add Service** button in the Capacity Planner toolbar.

   Capacity Planner displays a message to remind you that targets you add manually will be available for the current session of Capacity Planner only.

3. Click **Yes**.

   Capacity Planner displays a logon dialog box for the target. Click **Help** if you need information about any of the specific fields on the dialog box.

4. After you fill in the logon credentials, click **OK** to connect to the target.

   After you connect to a target, the available collection classes for that target appear in the navigator and Oracle Capacity Planner displays the Target property sheet for the selected target (**Figure 4–2**).

### About the Target Property Sheet

When you connect to a target, Oracle Capacity Planner displays the Target property sheet, which contains the following property pages:

- **Collection Options page**
- **Storage Options page**
- **Purge Options page**

The collection, load, and purge settings you select on these pages apply to all the classes in the selected target. You cannot change these settings for a selected class; you can change them only for a selected target.
Defining the Frequency of Collection Samples

When you first connect to a target, Capacity Planner displays the Collection Options property page. The values you select on this page determine how often the Agent will collect information about the selected target and save it to disk. On the Collection Options property page, you can set the frequency of collection samples using either of these two methods:

- By selecting the number of data samples to collect for a specified time interval
  For example, to collect information 3 times every hour, select **Samples per Time Interval**, enter 3 in the text field, and choose **Hours** from the drop-down list.

- By specifying the length of time between collection samples
  For example, to collect information every 20 minutes, select **Time Between Samples**, enter 20 in the text field, and choose **Minutes** from the drop-down list.

**Note:** To configure the settings for collecting data, the Agent that will collect data for a target must be running. Normally, the Agent is located on the host where the target is located.

Defining the Location of the Historical Database

After you set the frequency of collection samples, use the **Storage Options** tab to specify the location of the Oracle Capacity Planner historical database. This setting defines where Capacity Planner will save information collected for the selected target. When data is saved in the historical database, you can later analyze the data or use it to generate trend analyses.
By default, collected data is saved in your Oracle Enterprise Manager repository. However, you can specify an alternate database for the historical data if you do not want to store historical data for the selected target in the repository.

To save the data collected for a target in a location other than the Oracle Enterprise Manager repository:

1. From the Storage Options tab, select **Store historical data in alternate location**.
2. Enter the credentials for the database that will store the collection data for the target.

   Enter the appropriate user name, password, and target for the Oracle Capacity Planner historical database. This connection information is used by the Agent when it loads the collected data at the specified loader interval. Therefore, the target specified for the Oracle Capacity Planner historical database must be known and accessible from the host where the Agent is running.

   For example, if you specify MY_DB.WORLD as the historical database and your Agent is running on host MYNODE, then database MY_DB.WORLD must be reachable via Net8 or SQL*Net from host MYNODE (MY_DB.WORLD must exist in the TNSNAMES.ORA file for host MYNODE, for example).

**Defining the Frequency of Loading Collection Data**

After you define how often data will be collected and where the data will be stored, you can define how often the data will be loaded into the historical database.

You can determine how frequently the Oracle Capacity Planner loader program loads collection data for the target using either of these two methods:

- Using the **Per Time Interval** field to specify the number of loader passes for a specified time interval
- Using the **Time Between** field to specify the length of time between loader passes

---

**Note:** Although data can be collected at short time intervals (such as 5, 10, or 15 minutes), collected data is not available to you for analysis until it has been loaded into the Oracle Capacity Planner historical database. Therefore, the load interval you specify controls when the most recently collected data will be visible to you.
The collection frequency you set determines the lowest time interval for which Oracle Capacity Planner can analyze data. For example, if you want to be able to analyze data from hourly intervals, you need to set a collection frequency of at least once an hour.

After you define the frequency of loading collection data, you can set a time for the next loader pass by using the Next Transfer Occurs at field:

1. Click the value that you want to change in the date and time box.
2. Click the up or down arrow to select a higher or lower value.

If the current time is later than the time displayed for the Next Transfer Occurs at setting, click Refresh View to update the display to show the actual time of the next loader pass.

Note that the values that you select on the Storage Options property page apply to all classes of data collected on the selected target.

Understanding When the Loader Runs
The loader runs at the regular time interval specified on the Storage Options property page. The time specified in the Next Transfer Occurs at field controls when the loader runs. For example, if you want the loader to run once a day at 2:00 a.m., then set the transfer interval to once per day, and set the next transfer time to the next day at 2:00 a.m. The loader will run for the first time at 2:00 a.m. the next day, and then will run once a day, each day at 2:00 a.m.

You can use the Next Transfer Occurs at field to force the loader to run immediately—or as soon as possible. Simply set the next transfer time to a time earlier than the current time.

Understanding How Data Aggregation Works
As it loads data into the database, Oracle Capacity Planner automatically aggregates the data. During aggregation, Oracle Capacity Planner examines the collection samples for a given time interval, calculates an average value for that interval, then uses that average value for calculations at the next larger time interval.
On each loader pass, Oracle Capacity Planner examines the time stamps of all collected data to determine whether or not the threshold for a set interval (hour, day, week, month, or year) has been crossed since the previous loader pass. If so, Oracle Capacity Planner performs an aggregation of collected data from the next smaller interval to the interval threshold just passed. Table 4–2 shows the larger time interval to which data at each time interval is aggregated.

<table>
<thead>
<tr>
<th>Data at This Interval</th>
<th>Aggregates to This Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minutes</td>
<td>Hours</td>
</tr>
<tr>
<td>Hours</td>
<td>Days</td>
</tr>
<tr>
<td>Days</td>
<td>Weeks</td>
</tr>
<tr>
<td>Weeks</td>
<td>Months</td>
</tr>
<tr>
<td>Months</td>
<td>Years</td>
</tr>
</tbody>
</table>

An example may help clarify how Oracle Capacity Planner aggregates collection data. Suppose Oracle Capacity Planner is collecting a data sample every 10 minutes to capture the percentage of used space on a particular disk, and the loader runs once an hour. When the Oracle Capacity Planner loader runs and transfers data into the Oracle Capacity Planner database every hour, it examines the values for the percentage of used disk space in the samples collected during the previous hour, then it computes an average percentage for the samples. That average percentage is then used as the average value for the hour.

At the first loader pass after midnight, Oracle Capacity Planner uses the hourly averages since midnight the previous day to compute the day’s percentage of used disk space.

At the first loader pass after midnight on Saturday, Oracle Capacity Planner examines the daily averages of used disk space since midnight the previous Saturday and computes an average percentage for the week.

At the first loader pass after midnight on the last calendar day of the month, Oracle Capacity Planner examines the weekly averages since midnight on the last calendar day of the previous month and computes an average percentage for the month.

Finally, at the first loader pass after midnight on December 31, Oracle Capacity Planner examines the last 12 monthly averages to compute a yearly average.
Defining the Amount of Data to Keep

The final step in setting up a target for historical data collection is defining the amount of data to keep.

When you select a target, you can click the Purge Options tab to display the Purge Options property page. On this page, you specify the amount of data you want to store in the Oracle Capacity Planner historical database for each type of data (for example, hour data, day data, and week data). You can accept the default Purge Options property page values or choose different values.

The values set on the Purge Options property page apply to all classes of data collected on the selected target.

The values you specify in the data retention table (the Enter the amount of data you want to keep table on the Purge Options page) determine how far back in time you can go to analyze data for the different types of data.

Suppose, for example, you always want to be able to view hour data for the previous six weeks. In this case, for the Hours Data Type row in the data retention table, you would enter 6 in the Timespan column and Weeks in the To Keep column. This tells Oracle Capacity Planner that you want to keep hour data for a 6-week period. Oracle Capacity Planner calculates 6 weeks from the current time, and the Purge Data Older Than column shows the time span for which hour data is available. Table 4–3 shows the Hours row in the data retention table with this data entered.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Timespan</th>
<th>To Keep</th>
<th>Purge Data Older Than</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>6</td>
<td>Weeks</td>
<td>(current date minus 6 weeks)</td>
</tr>
</tbody>
</table>

For each row in the data retention table, you can choose the time span to keep data samples for that type of data by entering the desired value in the Timespan to Keep column.

Applying and Reverting the Collection Settings for a Target

When you finish setting all the options on the Target property sheet, do the following to apply your collection settings:

1. Click Apply.
If you changed the location of the historical database on the Storage Options page, Capacity Planner displays a message box reminding you that any information stored in the previous location will not be available for analysis.

If you don’t want to be reminded about this implication the next time you change the database location, select Don’t show this message again.

2. Click OK.

Capacity Planner displays a message stating that the options were set successfully.

3. Click Continue to close the message box and return to the Capacity Planner main window.

When you apply your collection settings, Capacity Planner sends the settings to the Agent for the selected target. Note that you cannot select data to be collected until these settings have been applied.

At any time during the process of modifying the settings on the Target property sheet, you may revert the settings to their last saved (applied) state by clicking Revert. However, after you apply the settings, they cannot be reverted to their previous settings using the Revert button; they must be modified manually.

Selecting the Classes of Data to Collect

After you set the collection and loading options for a target, you can then select the classes of performance data that you want to collect for that target:

1. In collection view, select and connect to the target.

   For more information, see “Selecting Targets” on page 4-7.

2. Click the plus sign (+) next to the target to show the classes of data you can collect.

3. Select one of the classes for the target.

   Figure 4–3 shows a typical collection class for a node target on Windows NT and the data sources and data items available for the class.
The following list explains classes, data items, and data sources in more detail:

- **Classes**

  A class is a container for a particular category of data. For example, a node (or operating system) target might include the following classes:

  - System
  - Processor
  - Memory

  When you select a target in the navigator, Capacity Planner displays the names of the classes below the target in the tree view.

  You can collect data from none, some, or all displayed classes for a target. A class may also be a container for other classes, to provide logical groupings of the performance data at higher levels. For example, an I/O class may be a container for other more specific I/O classes.
Data items

In a class, each of the related statistics is referred to as a data item. For example, a LogicalDisk class might include the following data items:

- Percent Free Space
- Free Megabytes
- Current Disk Queue Length
- Disk Writes per Second

A class can contain one or more data items. When you select a class in the navigator, the names of the data items and data sources associated with the data items are displayed on the Collection Details property page. Select the data items that you are interested in collecting.

A green check mark appears next to the name of each data item that is selected for collection. You can toggle the state of all data items between collected and not collected by clicking the Data Items column header that contains the check mark.

Data sources

A data source is a description of where Oracle Capacity Planner can collect the data items for a class. A class can contain one or more data sources. When you select a class in the navigator, the names of the data items and data sources associated with the class are displayed on the Collection Details property page.

The type of data in the class determines the data sources for the class. For example, in a LogicalDisk class, the data sources might be the individual disks for the operating system (for example, disk1, disk2, and so on). In a CPU Utilization class, the sources are the individual CPUs for the host (for example, cpu1, cpu2, and so on). You can collect data items from one or more data sources.

When you select a data source, a green check mark appears next to the name of the data source on the Collection Details property page. You can toggle the state of all data sources between collected and not collected by clicking the Data Sources column header that contains the check mark.

Starting Data Collection

After you select the data items that you want to collect from the available data sources on the Collection Details property page, click Apply to confirm your selections, or click Revert to cancel the selections.
When you click **Apply** for a class of data, Capacity Planner marks the icon for the selected class and the selected target with a green dot in the Collection view of the navigator panel. A green dot on a collection class icon indicates that one or more data sources are selected for the class. A green dot on a target icon indicates that Capacity Planner is collecting data for one or more classes in the target.

For example, in **Figure 4–4**, Capacity Planner is actively collecting data for the Processor, Memory, and Cache classes for node ANG-PC. Capacity Planner is not collecting data for the System collection class.

**Figure 4–4  Green Dots on a Target or Class Indicate Capacity Planner is Collecting Data**

![Diagram showing green dots on target and classes](image)

**Stopping Data Collection**

To stop collecting data for one or more data items or data sources for a collection class, follow these steps:

1. Select the collection class in the navigator.
2. On the Collection Details page, click on the green check marks for those data items or data sources from which you no longer want data collected, which causes the check marks to disappear.
3. Click **Apply**.

To stop collecting data for all data items and data sources for a collection class, follow these steps:

1. Select the collection class in the navigator.
2. On the Collection Details page, click **Stop Collection**.
   
   Capacity Planner displays a message box stating that collections for the class have stopped.
3. Click **OK** to close the message box and return to the Capacity Planner main window.

When no data sources are selected for collection for a class of data, the icon for that class in the navigator does not display a green dot.

To stop collecting data for all classes in a target:

1. In collection view, select and connect to the target.

   For more information, see “Selecting Targets” on page 4-7.

2. Click **Stop Collection** on the Target property sheet.

   Capacity Planner displays a confirmation box.

3. Click **Yes** to stop collecting data for all classes in the target; click **No** to cancel the operation.

### Generating a Collection Report

A collection report provides a summary of the collection settings for one or more targets. Capacity Planner displays the collection settings in your Web browser. In the browser, you can easily review the settings currently applied to the target or targets you selected.

To display a collection report for one or more targets:

1. In collection view, on the **File** menu, choose **Collection Report**.

   Capacity Planner displays the first screen of the Collection Report Wizard.

2. Use the Collection Report Wizard to specify the target or targets whose collection settings you want to include in the report and to generate and view the report.

   At any time while using the wizard, click **Help** for more information.

When you click **Finish** on the last screen of the Collection Report Wizard, Capacity Planner saves the report to an HTML file and displays the report in your Web browser.

### Copying Collection Settings

After you set up collection settings for one service, you can quickly copy those settings to another similar target.
To copy the collections settings from one target to another:

1. In collection view, select a target whose collection settings you want to copy.
2. On the File menu, choose Copy Collection Settings or right mouse click on the Collection Settings from the context menu.

Capacity Planner displays the first screen of the Copy Collections Wizard.
3. Use the Copy Collection Settings Wizard to specify the destination targets to which you would like to copy the collection settings for the selected target.

From the wizard, you can also view the progress of the copy operation. At any time while you are using the Copy Collection Settings Wizard, click Help for more information.

Note: Any destination target you select must be running an Agent of the same type and version as the target from which you are copying your settings.

Troubleshooting Collection and Load Problems

During the collection and load processes, errors may be encountered by the Agent. You can determine if data is not being collected or loaded by using either of these methods:

- Browsing the analysis data in the Oracle Capacity Planner navigator. See "Browsing the Collected Data" on page 4-22 for more information.
- Accessing the historical database using SQL. See "Understanding the Oracle Capacity Planner Historical Database" on page 4-37 for more information.

If data is not being collected or loaded, you should check the status of the Agent on the host from which data is being collected. If the Agent is running, check the log file ($ORACLE_HOME/network/log/dbsnmp.log) for errors related to the collection or loading of data. See the Oracle Intelligent Agent User’s Guide for additional details on the configuration of the Agent.

Analyzing Collected Data

After collected data is loaded into the Oracle Capacity Planner historical database, you can perform a variety of analyses on it. To access the analysis features of Oracle Capacity Planner, click the Analysis tab (Figure 4–5) at the bottom of the Oracle
Capacity Planner navigator tree view. This displays the Oracle Capacity Planner analysis view.

Figure 4–5  Clicking the Analysis Tab

Connecting to an Oracle Capacity Planner Historical Database

When you expand the Historical Database folder at the root of the navigator tree in analysis view, you are prompted for the logon credentials for an Oracle Capacity Planner historical database.

After you connect to a historical database, the folder expands to show the targets for which data is available in that historical database.

If you store data in multiple historical databases, you must disconnect from one historical database before you can connect to a different historical database.

To disconnect from the current historical database,

1. Click the Historical Database folder at the root of the navigator tree.
2. Click the Disconnect button in the Capacity Planner toolbar panel.

To connect to a different historical database, expand the Historical Database folder again and enter the credentials for the new historical database in the resulting logon dialog box.
Organization of Data in the Navigator

When you expand a target in the navigator under the Historical Database folder, two forms of data are displayed below the target:

- **Classes of data**
  The classes displayed for the target are the collection classes for which data is available in the Oracle Capacity Planner historical database. You can select and view data from these classes by selecting a class in the navigator, specifying the selection criteria, and then clicking **Show New Chart**. These operations are the first step in creating an analysis.

- **Analyses**
  Below each target in the navigator is an Analyses folder, which contains predefined and user-defined analyses. Predefined analyses are provided for some targets. You can create user-defined analyses by selecting a class of data, displaying an analysis of the data, and then saving the analysis. You can also create a user-defined analysis by using an existing analysis as a template, making modifications to the analysis, and then saving the analysis under a new name.

Browsing the Collected Data

To browse the collected data for a particular target:

1. In analysis view, expand the Historical Database folder.
   You are prompted for the credentials for the historical database that contains the collected data that you want to analyze.

2. Enter your logon credentials and connect to the historical database.

3. On the navigator panel, expand the folder for the target whose collected data you want to analyze.
   The navigator displays the:
   - Names of the classes for which collected data exists in the historical database for the target
   - An **Analyses** folder, which contains predefined and user-defined analyses you created for the target
Viewing an Analysis for a Class of Data

To view an analysis chart for a selected class of data:

1. On the navigator panel, click the name of a class whose collected data you want to analyze.

   Capacity Planner displays the property page for the class (Figure 4–6).

2. To specify the selection criteria for the class of data you want to analyze, see "Specifying Selection Criteria for a Class of Data" on page 4-24 for instructions.

3. Click Show New Chart.

   Capacity Planner displays the Analysis window, which contains two or more pages. The Chart page displays the chart. The remaining pages are Details pages. A separate Details page exists for each class from which one or more data items are included in the analysis.

   For information about the Analysis window, choose Window from the Analysis window Help menu. For information about modifying the analysis or changing the way the data is displayed, see “Working with Analyses” on page 4-28.

Saving a Class Analysis as a User-Defined Analysis

After you view an analysis for a class of data, you can save it as a user-defined analysis to view later.

To save the analysis:

1. While viewing the analysis chart, click Save Chart on the analysis window toolbar.

2. Click Yes in the message box.

   Performance Manager places the new user-defined analysis in the Analyses folder of the navigator panel.
Specifying Selection Criteria for a Class of Data

When you select a class in the navigator panel in analysis view, Capacity Planner displays a property sheet that contains options available for selecting data from the Oracle Capacity Planner historical database for that class.

Before you display a chart of the collected data you must:

1. Select the time aggregation level from the Time Aggregation drop-down list.
   For example, select Hours if you want to analyze hourly data, Days if you want to analyze daily data, and so on.

2. In the Data Sources section, select one or more data sources whose data items you want to analyze.

3. In the Data Items section, select one or more data items you want to analyze.
   A check mark appears next to each data item that is selected for analysis.

After you specify the selection criteria, there are two ways to display the data in an analysis chart:
To add the selected data to a new analysis chart, click **Show New Chart**, which displays the new chart.

To add the selected data to an analysis chart that is already displayed in the Analysis window, click **Add to Chart**, then in the Add Data to Analysis dialog box, select the name of the previously-displayed analysis chart. Note that only charts that are currently opened are displayed in the Add Data to Analysis dialog box.

### Viewing and Modifying User-Defined and Predefined Analyses

You can view and modify both user-defined and predefined analyses. However, once modifications are made to a predefined analysis, the only way to save those changes is to save the analysis to a new name. This creates a new user-defined analysis and preserves the original predefined analysis.

| Note: | Not all targets provide predefined analyses. |

To view an existing analysis, which makes it available for modification, follow these steps:

1. Expand the Analysis folder for the target, which displays the existing predefined and user-defined analyses for the target.
   
   A bar chart icon identifies a predefined analysis. Not all targets provide predefined analyses.
   
   A bar chart and person icon identifies a user-defined analysis. You create a user-defined analysis by displaying an analysis for a class of data or displaying a predefined analysis, and then saving the analysis.

   | Note: | You can limit the list of displayed analyses to only user-defined analyses by removing the check mark from the **View Predefined Analyses** option on the **Analysis** menu. When you choose the **View Predefined Analyses** option on the **Analysis** menu again, the check mark preceding the menu option is replaced, and predefined analyses are displayed again. |

2. Select a predefined analysis or user-defined analysis in the navigator panel.
The Analysis Summary property page for the selected analysis is displayed in the detail panel. This property page displays the names of the targets and classes whose data is used in the analysis.

3. To view the data sources and data items in the analysis, click the plus sign (+) next to the target icons in the Service/Source column.

4. To view the chart for the analysis, click Show.

   Note that if you are opening a predefined analysis, Capacity Planner displays the Select Data Sources for Analysis dialog box. Predefined analyses are provided for some targets. Predefined analyses require you to specify the available data sources for your installation. Select the data sources you want to include in the predefined analysis and click OK.

   After you have opened an analysis, you can modify the contents and how they are presented. See "Working with Analyses" on page 4-28 for more information.

   You can also create a copy of an analysis, rename an analysis, or delete an analysis, as explained in the next three sections.

Creating a Copy of an Analysis

   You can create an analysis that is an exact copy of an existing analysis, but the copy has a different name. To do this:

   1. In analysis view, locate and expand the target that contains the analysis you want to copy.

   2. Expand the Analyses folder.

   3. Select the analysis you want to copy.

   4. On the Analysis menu, choose Create Like.

   5. In the Create Analysis Like dialog box, enter a unique name for the new analysis that you are creating and click OK.

   Capacity Planner creates the new copy of the analysis in the Analyses folder for the target.
Renaming a User-Defined Analysis

**Note:** You cannot rename a predefined analysis. This restriction ensures that the original predefined analysis charts are not overwritten.

However, after you make changes to a predefined analysis, you can save the modified version of the predefined analysis as a user-defined chart with a new name. For more information, see "Saving the Results of a Predefined Analysis" on page 4-36.

To rename a user-defined chart:

1. In analysis view, locate and expand the target that contains the analysis you want to rename.
2. Expand the **Analyses** folder.
3. Select the user-defined analysis you want to rename.
   A bar-chart-and-person icon identifies user-defined analyses.
4. On the **Analysis** menu, choose **Rename**.
5. In the Rename Analysis dialog box, enter a unique name for the analysis you are renaming and click **OK**.

Deleting a User-Defined Analysis

**Note:** You cannot delete a predefined analysis.

To delete a user-defined analysis:

1. In analysis view, locate and expand the target that contains the analysis you want to delete.
2. Expand the **Analyses** folder.
   A bar-chart-and-person icon identifies the user-defined analyses in the folder.
3. Select the user-defined analysis that you want to delete.
4. On the **Analysis** menu, choose **Delete**.
5. In the message dialog box that prompts you to confirm the deletion, click **OK**.

**Working with Analyses**

After you have opened an analysis chart, either by selecting and showing an existing analysis or by browsing collected data to create a new analysis, the data included in that analysis is shown in the Oracle Capacity Planner Analysis window.

The Analysis window contains two or more pages. The first page is called the Chart page and it displays the analysis chart. The remaining page or pages are Details pages. A separate Details page exists for each class from which one or more data items are included in the analysis. Each Details page shows the:

- Data sources for the data items plotted in the chart
- Time aggregation level of the plotted data items
- Value of each plotted data item each time the data item was collected during the time range for the analysis

The time range for the collected data appears along the bottom of each chart, with the beginning of the time range at the left and the end of the time range at the right.

Two types of lines can appear on a chart. Each solid line plots the values of a selected data item during the specified time range. Each dashed line plots the result of a trend analysis to time or trend analysis to value. See "What Is a Trend Analysis?" on page 4-33 for more information about performing a trend analysis.

The rest of this section describes other features of the Analysis window.

**Viewing the Value of a Data Point**

To view the value for a data point (that is, one plotted point of a data item) on a line in an analysis chart, position the cursor over the data point. If there is a point beneath the cursor, Capacity Planner displays the date, time, and value for that data point displays in a box above the point (see **Figure 4–7**).

**Figure 4–7  Viewing the Value of a Data Point**
Selecting a Line

When you view an analysis chart, you can perform certain operations after selecting a line in the chart. Most of the available operations are started by clicking a toolbar button on the analysis window after a chart line is selected.

To select a line, click a data point on the line. When a line is selected, the description of the line is displayed in the status bar at the bottom of the window, and the appropriate toolbar buttons are enabled.

Operations available from the toolbar are also available on a context menu. To display the context menu, click the right mouse button on a data point in a line in the analysis chart.

To be sure which line is currently selected (before clicking a toolbar button), read the description of the line in the status bar.

Adding a Class of Data to an Analysis

After you open an analysis, you may want to add data from other classes to the analysis. You can use this feature to compare two different classes of data.

To add a class of data to an analysis that is currently displayed in the Analysis window:

1. Confirm that Capacity Planner is in analysis view.
2. Select from the navigator the class of data that you want to add.
3. Specify the selection criteria (as described in "Specifying Selection Criteria for a Class of Data" on page 4-24) for the class.
4. Click Add to Chart.
5. In the Add Data to Analysis dialog box, select the name of the chart to which you want to add the data.

You can add data items from multiple classes to an analysis, and you can select different aggregation levels and date ranges for each class.

However, data items within a single class must share the same aggregation level and date range. If you try to add additional data items from the same class to an existing chart, you will receive a prompt, warning that the chart already contains data from this class. If you click OK, Capacity Planner will overwrite the chart with the currently selected data, aggregation levels, and date range.
Modifying Selection Criteria from the Analysis Window

From the analysis window, you can modify the selection criteria associated with any of the classes of data included in the analysis. Modify the selection criteria using one of these methods:

- Select a line in the analysis chart and click the Select Items toolbar button.
- Click the right mouse button on a data point in the line and choose Select Items from the context menu.
- Click the Data tab in the analysis window (as opposed to the Chart tab) and click the Select Items toolbar button.

These actions display the Select Items dialog box, which contains the property sheet for the class of data associated with the selected line. This property sheet contains the selection criteria for that class of data, which you can modify and apply to the current analysis. See "Specifying Selection Criteria for a Class of Data" on page 4-24 for more information.

After you modify selection criteria, you can click either Apply or OK on the Analysis Options dialog box. If you click Apply, the changes made to the selection criteria are applied to the analysis and the updated analysis is shown. The Select Items dialog box remains displayed, and you can make other modifications to the same selection criteria, if you want. If you click OK, Capacity Planner applies the modifications to the analysis and closes the Select Items dialog box.

Removing a Line from a Chart

You can remove a line from an analysis chart by either of these methods:

- Select the line by clicking the right mouse button, then choose Remove Line from the context menu.
- Select the line, then click the Remove Line button on the analysis window toolbar.

These actions remove the data for the selected data item from the chart, but not from the historical database.

Excluding a Data Point from a Chart

You can exclude a data point (that is, one plotted point of a data item) from a chart. To exclude a data point, click the right mouse button on the data point and choose Exclude Point from the context menu.
Excluding a data point is useful if you know that the value of a particular data point is skewed. For example, if you know that a particular CPU-intensive program was not run at the usual time, you can remove the value for the % Processor Time data item for that time from the chart. The selected data point is removed from the chart, but the data for the data point is not removed from the historical database.

After you exclude one or more data points from a line, a red X appears in the status bar when you select the line.

To later redisplay excluded data points for a selected line, click View Exclusions on the Analysis window toolbar, or click the right mouse button on the line and select View Exclusions from the context menu.

These actions display the Data Point Exclusions dialog box, which displays the current list of excluded points for the selected line. You can toggle the check mark for each data point in the list. A check mark indicates that the data point is excluded from the analysis. To display an excluded data point in the analysis again, clear the check mark.

When you click OK, Capacity Planner closes the Data Point Exclusions dialog box and updates the chart to include the points removed from the list of exclusions.

---

**Note:** Data point exclusions are not saved with an analysis.

---

**Showing or Hiding the Chart Legend**

You can control whether or not the legend is displayed in an analysis chart by toggling the Show/Hide Legend button on the analysis window toolbar. When the legend is not shown, you can identify a line by clicking it, which displays the description of the line in the analysis window status bar.

**Zooming and Scrolling to View More or Less Chart Data**

Depending on the date range and the number of data items and data sources you are analyzing, you may want to zoom in, zoom out, or scroll the contents of the chart window.

To view more detail or less detail, click the Zoom In and Zoom Out buttons on the Analysis Chart window toolbar. You can also zoom in by pressing the Page Down key on your keyboard or the numeric 3 on your keypad, and you can zoom out by pressing the Page Up key or the numeric 9 on your keypad.
You can also zoom in on a very specific part of the chart by dragging a rectangle around the area you want to magnify (Figure 4–8). Release the mouse button to zoom in on the selected area. You can zoom back out by using the Zoom Out button Home or End key on your keyboard.

Figure 4–8 Zooming in on a Selected Area of the Chart

Often, the chart data will extend beyond the width of the Analysis Chart window. You can view the data that extends beyond the edges of the window by resizing the Analysis Chart window or by scrolling to the right or left.

To scroll the Analysis chart window:

1. Press and drag the pointer on the black scroll bar below the chart (Figure 4–9).
2. When the portion of the chart you want to view is displayed in the Analysis Chart window, release the mouse button.

Optionally, you can use the arrow keys on your keyboard to scroll left and right. Press the left arrow to scroll left and the right arrow to scroll right. If you experience a conflict with the Tab function using the left and right arrow keys, you can use the up and down arrow keys on your keyboard to scroll. Press the up arrow to scroll left (or the numeric 8 on your keypad), or the down arrow key to scroll right (or the numeric 2 on your keypad).
Auto-Scaling Data

If an analysis contains data from different classes where the scale of the data is significantly different, you may want to apply scaling to the data. Scaling normalizes the data so that all lines have a maximum value of no greater than 100. Very large data items are scaled down, and very small data items are scaled up.

To apply scaling, click **Toggle Auto Scaling** on the analysis window toolbar. When scaling is applied to a chart, data lines with very different scales may be visually correlated. When scaling is enabled, Capacity Planner displays the label **Scaled Data** along the Y-axis of the chart. If you select a line from the chart by clicking it, the scaling factor for that line is included in the status bar.

What Is a Trend Analysis?

A trend analysis infers or estimates future values by projecting and extending known values. Oracle Capacity Planner can perform the following types of trend analyses:

- **Trend analysis to a point in time**

  In a trend analysis to a point in time, you provide a goal time for a data item. Oracle Capacity Planner uses the specified values in the historical database to project the value of the data item at the goal time.

  A trend analysis to a point in time is used to answer questions such as, "How full will this disk be at the end of the year?"

- **Trend analysis to a value**

  In a trend analysis to a value, you provide a goal value for a data item. Oracle Capacity Planner uses the specified values in the historical database to project the time at which the data item will reach the goal value.
A trend analysis to a value is used to answer questions such as, "When will our CPU utilization reach 95 percent?"

As the default, the Capacity Planner Trend Analysis wizard uses the critical threshold for the metric (if one is defined) when you perform a trend to a value.

### Specifying and Performing a Trend Analysis

To specify and perform a trend analysis, follow these steps:

1. In the Analysis window, either:
   - Select a line by clicking a data point in the line, then click the **Trend Analysis Wizard** button on the toolbar.
   - Click the right mouse button on a data point in a line, then select **Trend Analysis Wizard** from the context menu.

   Both of these methods display the Trend Analysis Wizard.

2. Capacity Planner displays the **Trend Analysis Wizard Welcome panel** that identifies the selected data on which you can conduct the trend analysis. You can click on the option box that prevents the Welcome screen from displaying in subsequent uses of the wizard. Click on Next to move to the next wizard panel.

3. In the **Date Range panel**, select a date range to use as a basis for the trend analysis:
   - Click **Use only the visible date range (as currently zoomed in the chart)** to use the range of dates currently visible in the analysis chart window (not including any data that extends beyond the edge of the chart window).
     
     This option is enabled only if you zoomed in to see more detail in the chart. For more information, see “Zooming and Scrolling to View More or Less Chart Data” on page 4-31.
   - Click **Use the date range selected for the chart** to use the date range currently used for all the data in the chart (even data that extends beyond the edge of the chart window).
   - Click **Select a new chart range** to select a different date range. You can designate either a recent period of time by choosing **Use a recent period of time** and then selecting the time increment and number of units of time to use, or you can specify a new start and end time by choosing **Use a new start and end time**.
   - Click on Next to move to the next wizard panel.
4. In the **Trend Analysis Type panel** of the wizard, specify which type of trend analysis you want to perform.

   - To perform a trend analysis to a value, click **Estimate when the data item will reach the following value**: and enter the numeric value for which you wish to determine the date and time.
   
   - To perform a trend analysis to a future date and time, click **Estimate what the value of the data item will be at the following date**: and enter the time and date for which you wish to determine a value.
   
   - Click on **Next** to move to the next wizard panel.

5. The **Summary panel** displays the results of the trend analysis. Click on **Finish** to add the trend line to the chart.

6. Choose **Customize Annotation** from the View menu to display the Annotate Trend dialog box and make changes to the annotation. Optionally, you can right mouse button click on the annotation created by the Trend Analysis wizard and then choose Customize Annotation from the context menu.

   Use the Annotate Trend dialog box to specify whether Capacity Planner will annotate the trend analysis (see **Figure 4–10**) and the appearance of the trend analysis line in the chart window. If you need information about the fields in the Annotate Trend dialog box, click **Help**.

   **Figure 4–10  Annotation for a Trend Analysis**

7. Click **OK** to close the Annotate Trend dialog box.

---

**Note:** To move the annotation box in an analysis chart, click the box, hold the mouse button down, then move the mouse to a different position on the chart. Release the mouse button when you have reached the position in the chart where you want the annotation box displayed.
Saving Changes to a User-Defined or Predefined Analysis

You can save the changes you make to an analysis. Oracle Capacity Planner can determine if you are saving a user-defined analysis or a predefined analysis. The steps for saving your changes differ, depending on the type of analysis.

Saving the Results of a User-Defined Analysis

To save changes to a user-defined analysis:

1. While viewing the analysis, click **Save Chart** on the analysis window toolbar.
2. Click **Yes** in the message box.

   Your changes are saved to in the Analysis folder for the selected target using the current name of the analysis or data class. To save the analysis under a different name, choose **Save As** from the Analysis window **File** menu.

Saving the Results of a Predefined Analysis

If you modify a predefined analysis, you must provide a new name for the analysis when you save the results of the analysis. When you do this, you create a new user-defined analysis. Saving the analysis with a new name ensures that the original predefined analysis is not overwritten.

To save the results of a predefined analysis:

1. While viewing the analysis, click **Save Chart** on the analysis window toolbar.
2. Click **Yes** in the dialog box that is displayed.
3. In the Save Analysis As dialog box, type a unique name for the user-defined analysis that will be created.
4. Click **OK** in the Save Analysis As dialog box.

   Capacity Planner places the new user-defined chart in the Analyses folder of the navigator panel.

Printing an Analysis Chart

To print an analysis chart, click the **Print Chart** button in the Analysis Chart toolbar while the chart is displayed.

The size of the chart on the screen determines the size of the chart in the chart printout. For example, when you print a chart that is 5 inches high and 7 inches wide on your screen, the chart will be 5 inches high and 7 inches wide in the printout.
Generating a Report for an Analysis Chart

To generate an HTML report for an analysis chart:

1. Click the Report Chart button while the chart is displayed.

   Capacity Planner displays a dialog box that tells you the name of the HTML file used to display the report and where the file will be saved.

2. Make a note of the file name and location.

3. Click Yes to preview the chart in your Web browser, or click No if you do not want to preview the report.

   You can view the report later using a Web browser, or—if you have experience with Web publishing tools and techniques—you can share the report with your co-workers by publishing the HTML file and its associated graphic files on a Web server.

Understanding the Oracle Capacity Planner Historical Database

The logical structure of the Oracle Capacity Planner historical database schema was designed to facilitate querying of capacity planning data by tools other than Oracle Capacity Planner, such as Microsoft Excel. This section contains a brief description of the design of the Oracle Capacity Planner historical database schema. It is not intended to be a comprehensive description of all tables and columns in the schema.

---

**Caution:** Performing any modification to the Oracle Capacity Planner historical database schema (tables, columns, or indexes) or to the data itself is not recommended and is not supported. Such modifications may render your Oracle Capacity Planner historical database schema unusable as a target to load or retrieve capacity planning data.

---

Understanding the Service Reference Table (vp_service_ref)

The service reference table contains a list of all targets for which data has been stored in the Oracle Capacity Planner historical database. The HOST column contains the name of the host where the Agent that loaded data for the specified target (the NAME column) is located. The SVC_ID column is a column used for lookup into the class reference table, described in the following paragraph.
Understanding the Class Reference Table (vp_class_ref)

The class reference table contains a list of all collection classes for which data has been stored in the Oracle Capacity Planner historical database, for all targets. To see the list of classes for a particular target, a query should look for the SVC_ID column equal to a SVC_ID value from the service reference table, described in the previous paragraph. Such a query would produce a list of all classes for which data exists in the database for a particular target.

Understanding the Data Tables

Each class of data in the class reference table has six data tables that contain the data for that collection class. Each table contains data for a particular time aggregate, for example, hours, days, weeks, months, and years. The base table contains the raw data as it is collected at the collection frequency. Therefore, the base table does not contain any statistical aggregations. The aggregate tables contain aggregate statistics for each data item collected for that class.

Data Table Names

Data tables are named according to the first four columns of the class reference table (in reverse order) plus the aggregate. Example 4–1 shows an entry for a collection class in the class reference table.

Example 4–1  Collection Class Entry in the Class Reference Table

<table>
<thead>
<tr>
<th>CLS_ID</th>
<th>MOD_ID</th>
<th>SVC_ID</th>
<th>IS_UDS</th>
<th>CONTAINER_CLASS_LABEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>2</td>
<td>2</td>
<td>0</td>
<td>I/O</td>
</tr>
</tbody>
</table>

The collection class in Example 4–1 would have the data tables shown in Example 4–2.

Example 4–2  Data Tables for a Collection Class

- VP_0_2_2_8_BASE
- VP_0_2_2_8_HOUR
- VP_0_2_2_8_DAY
- VP_0_2_2_8_WEEK
- VP_0_2_2_8_MONTH
- VP_0_2_2_8_YEAR
Data Table Contents

The first two columns of each data table are always the Timestamp column and the Data Source Name column. The Data Source Name column is essentially the class name, for example, Logical Disk. In aggregate tables (tables other than BASE), the third column is an accuracy calculation, which is not supported in this version of Oracle Capacity Planner.

All subsequent columns contain the values for the data items collected for that class, as they are actually named. In aggregate tables, these columns are prefixed with a two-character abbreviation for the aggregation statistic that the column contains. Table 4–4 shows these abbreviations and their meanings.

Table 4–4 Prefixes Used for Column Names in Aggregate Tables

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>AV</td>
<td>Average</td>
</tr>
<tr>
<td>SM</td>
<td>Sum</td>
</tr>
<tr>
<td>MN</td>
<td>Minimum</td>
</tr>
<tr>
<td>MX</td>
<td>Maximum</td>
</tr>
<tr>
<td>SD</td>
<td>Standard deviation</td>
</tr>
<tr>
<td>VR</td>
<td>Variance</td>
</tr>
<tr>
<td>CT</td>
<td>Count</td>
</tr>
</tbody>
</table>

These statistics are calculated for the set of data in that aggregate from the next lowest level. For example, a row in the DAY aggregate table contains statistics calculated for all entries in the HOUR table for that day.
The Concurrent Processing Tuning Assistant (hereafter referred to as the Tuning Assistant) is a reporting mechanism that allows you to examine historical processing information about Oracle Concurrent Processing requests and concurrent managers. The Tuning Assistant provides information that assists you in achieving better concurrent processing throughput by adjusting concurrent manager assignments and request scheduling.

The Tuning Assistant provides several predefined reports that identify problem areas in concurrent manager processing. The Tuning Assistant generates reports directly against the information stored in the Oracle Application Object Library tables or the Concurrent Processing Tuning Assistant repository.

Considerations When Using the Tuning Assistant

There are two ways to run the Tuning Assistant:
- Against the Oracle Application Object Library tables
- Against the Concurrent Processing Tuning Assistant repository

The following section describes the advantages of both approaches, along with some issues you need to consider when using them.

Connecting Directly to the Applications Database

For the most up-to-date information, generate the reports directly from the information stored in the Application Object Library tables. However, this schema is optimized for data entry, not data analysis. Depending on the amount of data, you may see poor performance when generating reports directly against the live Applications database.
Considerations When Using the Tuning Assistant

One method for improving Tuning Assistant performance in retrieving data is to periodically use the SQL language ANALYZE command to compute statistics on tables that the Tuning Assistant accesses. These tables include:

- FND_APPLICATION_TL
- FND_LOOKUP_VALUES
- FND_CONCURRENT_PROCESSES
- FND_CONCURRENT_PROGRAMS
- FND_CONCURRENT_PROGRAMS_TL
- FND_CONCURRENT_QUEUES
- FND_CONCURRENT_QUEUES_TL
- FND_CONCURRENT_REQUESTS
- FND_PRINTER_STYLE
- FND_PRINTER_STYLE_TL
- FND_PRODUCT_INSTALLATIONS
- FND_USER
- FND_CONC_PP_ACTIONS (for Apps 11.x)
- FND_CONC_RELEASE_CLASSES (for Apps 11.x)
- FND_CONC_RELEASE_CLASSES_TL (for Apps 11.x)

See the Oracle SQL documentation for information on how to use the SQL ANALYZE command and the impact it may have on your system.

---

**Note:** When looking at information presented by the Tuning Assistant, be aware of the data purge policies of your system administration and the effect these policies may have on the data reported. If the concurrent processing tables are purged frequently or if concurrent manager and request data are purged at different intervals, the usefulness of the data displayed in the reports could be limited.

Tuning Assistant reports do not include currently running requests. Only completed requests are included in reports.

---
Connecting to the Concurrent Processing Tuning Assistant Repository

Tuning Assistant reports are limited by the amount of information stored in FND tables. Since, in a production system, these tables are purged on a regular basis, there is a need to keep the data in a separate repository schema if you want to analyze usage data for an extended period.

Using the Concurrent Processing Tuning Assistant repository solves this problem by allowing you to archive pertinent information before the FND tables are purged. In addition, the report generation will be accelerated because the schema is optimized for data analysis. The only drawback is that the data is only current up to the last data copy. The intention is for administrators to copy the data once a day. If up-to-the-minute information is required, generate the reports directly from the live Applications database.

When you run the 'Load Data into the Concurrent Processing Tuning Assistant Repository' job from the Enterprise Manager console, data will be uploaded from the Applications schema FND tables into the new repository schema. Data will then be aggregated into new tables. Use the Purge Policy field on this job’s parameter page to indicate how many days of data should be saved for reporting. If the field is left blank or you enter 0, then the data is not purged.

Oracle recommends that the 'Load Data into the Concurrent Processing Tuning Assistant Repository' job be run on a daily basis to keep the repository data up-to-date. After the first execution of the job, consecutive runs copy only the new information added since the previous execution of the job.

Note: When generating reports against the repository, the best performance will be attained when you set the options under "Requests Included in Report" to None. This is most applicable to the Concurrent Manager reports and the Concurrent Program reports.

Usage Scenarios for the Tuning Assistant

The following section provides scenarios of how you might use the reports to tune your request schedules: concurrent manager balancing and concurrent manager specialization.
Starting the Tuning Assistant

Concurrent Manager Balancing

To determine concurrent manager balancing, view the Waiting Requests by Hour (24 x 7) report and look for the time periods with the greatest wait times.

If you find a time period that seems to have a relatively great number of backups, examine which requests were run and which requests were waiting during this time period. For selected time periods, drill down to the Requests that Waited report to identify the requests that waited. It may be necessary to schedule these requests during periods with excess concurrent manager capacity.

To find time periods with excess concurrent manager capacity, examine the Concurrent Managers by Hour (24 x 7) report, and look for underutilized time periods. For details about activity during selected time periods, drill down to the Requests that Ran report.

To reduce wait time, consider rescheduling a program to run when the concurrent managers have capacity to spare. Use these reports to identify requests whose schedules can be adjusted to distribute load more evenly.

If all concurrent managers are running at near or maximum capacity, it may be necessary to add more concurrent managers. If system resources are also fully utilized, it may be necessary to add additional hardware to support processing demands.

Concurrent Manager Specialization

Designating certain concurrent managers to process either short or long running programs can help to mitigate queue backup. Designating a concurrent manager to process short running jobs can help to prevent short running jobs from getting stuck behind long running jobs.

Look at the Long Running Requests report to determine if any of these requests should be associated with a concurrent manager that will handle long running jobs.

Additionally, look at the Short Running Requests that Waited report to identify if any of these requests should be associated with a concurrent manager that will handle short running jobs.

Starting the Tuning Assistant

You can access the Tuning Assistant in the following ways:

- From the Oracle Enterprise Manager console
Starting the Tuning Assistant

- From the UNIX command line
- From the Windows NT Start menu

The following sections explain how to use these methods.

Starting the Tuning Assistant from Oracle Enterprise Manager

To start the Tuning Assistant from Oracle Enterprise Manager, highlight the concurrent manager you want to investigate and do one of the following:

- Click the Application Management drawer and select Concurrent Processing Tuning Assistant
- Select Tools=>Application Management=>Concurrent Processing Tuning Assistant
- Select a Concurrent Manager in the navigator tree, click the right-mouse button, and select Related Tools=>Concurrent Processing Tuning Assistant

The Tuning Assistant is displayed. However, if preferred credentials have not been set or if they are incorrect, the Concurrent Processing Tuning Assistant Login dialog box is displayed. Provide the login information to connect to a valid Applications schema.

Starting the Tuning Assistant from the UNIX Command Line

Before starting the Tuning Assistant from the UNIX command line, do the following:

1. Verify that your Oracle Home has been setup (for example, setenv ORACLE_HOME /disk1/oracle/oem/).
2. Verify that $ORACLE_HOME/bin directory is in your PATH variable ($ORACLE_HOME/bin:$PATH).

Once your Oracle Home is set up, on the command line type:

`oemapp cpta`

The Concurrent Processing Tuning Assistant Login dialog box is displayed. Provide the login information to connect to a valid Oracle Applications schema.

---

**Note:** ORACLE_HOME represents the Oracle home in which the Tuning Assistant is installed.
If the Tuning Assistant is connecting to the Oracle Management Server, the Tuning Assistant lists all discovered concurrent managers in its navigator tree. If the Tuning Assistant connects to an Oracle Applications schema or the Concurrent Processing Tuning Assistant repository, the Tuning Assistant will ensure that it is a valid schema containing Oracle Application Object Library tables.

Starting the Tuning Assistant from the Start Menu on Windows NT

To start the Tuning Assistant from the Start menu, select Start=>Programs=>ORACLE_HOME=>Management Pack for Oracle Applications=>Concurrent Processing Tuning Assistant. The Concurrent Processing Tuning Assistant Login dialog box is displayed. Provide the login information to connect to a valid Oracle Applications schema, a Concurrent Processing Tuning Assistant repository, or an Oracle Management Server.

**Note:** ORACLE_HOME represents the Oracle home in which the Tuning Assistant is installed.

If the Tuning Assistant is connecting to the Oracle Management Server, the Tuning Assistant lists all discovered concurrent managers in its navigator tree. If the Tuning Assistant connects to an Oracle Applications schema or the Concurrent Processing Tuning Assistant repository, the Tuning Assistant will ensure that it is a valid schema containing Oracle Application Object Library tables.

Using the Tuning Assistant

The following options are available in the Tuning Assistant:

- Tuning Assistant Main Window
- Displaying Reports
- Saving Reports
- Report Properties
- Drill Down from Tuning Assistant Reports
- Printing Tuning Assistant Reports
- Tuning Advisor
Tuning Assistant Main Window

The Tuning Assistant main window consists of two panes. The left pane displays a navigator tree that lists the Tuning Advisor feature and the various Tuning Assistant reports (concurrent managers, requests, and programs).

When the Tuning Advisor or a report is highlighted in the left pane, the General and Options tabs display in the right pane. Otherwise the Oracle Applications logo displays.

General Tab

The General tab contains a thorough description of the contents of the report and why the report is useful.

Options Tab

The Options tab shows the current settings for the reporting options, for example, the reporting period, applications included in the report, and requests included in the report. Change the settings in this tab to retrieve the data in which you are most interested. Of the following options, only those appropriate for the particular report will display.

- Reporting Period

  The Reporting Period group includes alternative options, such as previous week, previous four weeks, one week starting, and time period. The time period will be initialized to the minimum and maximum dates available in the current applications schema.

- Application Included in Report

  With this option, you can select either one application to be represented in the report or all available applications to be represented. By default, all applications are included.

- Requests Included in Report

  The Requests Included In Report option has various settings based on the type of report you selected. These settings include:
  
  - Minimum Duration
    
    Only requests with a duration greater than the minimum duration will be included in the report.
  
  - Minimum Wait Time
Only requests that waited longer than or equal to the minimum wait time will be included in the report.

- Maximum Wait Time

Only requests that waited less than or equal to the maximum wait time will be included in the report.

- Maximum Runtime

Only requests that ran for less time than the maximum runtime will be included in the report.

For each of these options, enter a value in the text field and select the time granularity. The time granularity options are minutes, hours, days, and weeks. If you do not want an available option, set its time granularity to None.

- Limit the Number of Rows Retrieved

With this option you can limit the number of rows retrieved to a value you specify. Only the number of rows specified are included in the report. If you do not specify the number of rows, all rows that meet the criteria for inclusion are displayed in the report.

**Displaying Reports**

To display reports, you can either click **Show Report** on the right pane or double click on the report node on the report tree.

When a report is opened, information is retrieved from the Application Object Library tables. As the Tuning Assistant retrieves the data, a busy bar appears at the bottom of the display. Some reports will show intermediate data in the display area. If the busy bar is still visible, this indicates that the data is still being retrieved.

A Cancel button is displayed next to the busy bar. Click **Cancel** to interrupt an operation. Depending on the type of operation that is being performed, the cancel operation may or may not be processed immediately. If partial data is available, Cancel will stop the data retrieval and display the results that were retrieved before the cancellation occurred.

The following are additional characteristics about the reports:

- Clicking column headers in these reports causes data to be sorted by the selected column header if the report is not a "by hour (24x7)" report.
Some reports present a drop-down list at the top of the display to filter the information that is being displayed, or to change the format of the information that is being displayed.

**Saving Reports**

To save reports, click **Save As** on the toolbar.

Reports can be saved to a file in comma-separated value (CSV) format or HTML format. The file will contain the data that was retrieved for this report. Files saved in CSV format can be uploaded into spreadsheet applications. Files saved in HTML format can be viewed using a Web browser.

For reports that provide you with the ability to manipulate the displayed data, the Tuning Assistant saves the data as it is currently displayed.

**Report Properties**

To display the properties of a report, click **Properties** on the toolbar.

The Report Properties option displays information about a report, for example, options selected. Report Properties include the General and Options tabs, as well as a SQL Text tab that displays the SQL text used to generate the report. Drill-down reports include a Drill Source tab which includes information about the parent report for this drill-down report.

Some reports provide the ability to modify or change report properties and redisplay the report with the changed settings.

**Drill Down from Tuning Assistant Reports**

To drill down to a report, click **Drilldown** on the toolbar. You can also right-mouse click on a report to access a drill-down report.

Many reports have a drill-down capability. These reports will drill down to data associated with the currently selected items.

**Printing Tuning Assistant Reports**

To print reports, click **Print** on the toolbar.

The Print option prints the data that is currently displayed in the report window.
Report Descriptions

The following reports are available through the Tuning Assistant:

- Concurrent Managers by Hour (24x7)
- Concurrent Manager Usage by Program
- Program Run Summary by Status
- Program Wait Summary
- Waiting Requests by Hour (24x7)
- Long Running Requests
- Short Running Requests that Waited
- Request Run Summary by Month
- Drill-Down Reports
  - Requests that Ran
  - Requests that Waited
  - Request Details

Concurrent Managers by Hour (24x7)

The Concurrent Managers by Hour (24 x 7) report answers the question, "How is my concurrent manager capacity being used?"

The purpose of this report is to identify time periods when concurrent managers had capacity to spare. This report shows the percentage of time each concurrent manager was actually utilized for a block of time periods. By examining the time jobs were run in a concurrent manager against its total capacity, you determine capacity utilization.

This report shows the days of the week in columns and hourly time periods in rows. Each slot in the display contains the utilization for that concurrent manager during that time period. This report provides a graphical display using color and font styles to show time period utilization: red/bold (greatest utilization), yellow/italic (less utilization), and gray/regular (no utilization).

Because this report displays data in a weekly format (24 x 7), when you choose a time period that extends beyond a week, the data displayed is the sum of the data for each hour over the time period. For example, if the time period extends from
Monday to Monday (8 days), the Monday column in the report displays the sum of the data for the two Mondays.

The features of this report include:

- Selecting individual or all concurrent managers from the Concurrent Manager drop-down list. Concurrent managers prefixed with an asterisk (*) were available for the time period specified in the report options but serviced no requests. In other words, the concurrent managers were running but they did no work.

- Selecting the type of data displayed from the Data Displayed drop-down list. Types of data include:
  - Concurrent manager utilization shows the percentage of concurrent manager capacity that was used. This percentage is calculated by dividing the number of minutes requests were run by the number of minutes of concurrent manager capacity available.
  - Concurrent manager capacity in minutes.
  - Request runtime in minutes.
  - Number of requests that ran.
  - Request runtime to concurrent manager capacity ratio shows the ratio of concurrent manager capacity that was used. This ratio is calculated by dividing the number of minutes requests were run by the number of minutes of concurrent manager capacity available.
  - Concurrent manager utilization fraction shows the fraction of concurrent manager capacity that was used. This fraction is calculated by dividing the number of minutes requests were run by the number of minutes of concurrent manager capacity available.

- Customizing the high utilization threshold using a slider. The slider controls the color in which each hour is displayed. Any hours with a concurrent manager utilization greater than the slider value will be displayed in red.

For this report you can drill down to the Request that Ran report. Select one or more time periods and choose Drilldown from the toolbar. You can also right-mouse click on a row or a cell to access a drill-down report.

**Concurrent Manager Usage by Program**

The Concurrent Manager Usage by Program report answers the question, "Which programs ran on which concurrent managers?"
Report Descriptions

You can use this information to determine which concurrent manager and program combinations are potential bottlenecks.

For a given time period, this report provides the following information:

- Concurrent Manager
- Program
- Duration in minutes: total, average, minimum, and maximum (The report is sorted by total duration.)
- Times Run (Number of times the program ran in this concurrent manager.)

Program Run Summary by Status

The Program Run Summary by Status report answers the question, "Which programs ran and how long did they take to run?"

This report provides general information about requests summarized by program and grouped by status:

- Application
- Program
- Duration in minutes: total, average, minimum, and maximum (The report is sorted by total duration.)
- Times Run
- Status

From this report you can drill down to the Requests that Ran report. Select one or more rows, and choose Drilldown from the toolbar. You can also right-mouse click on a selected row to access a drill-down report.

Program Wait Summary

The Program Wait Summary report answers the question, "Which programs had to wait and how long did they wait?"

With this report you can identify programs that have historically long wait times. This information can be used to identify which programs may benefit most from a change in program scheduling. This report provides the following information:

- Application
- Program
- Actual wait time (in minutes): total, average, minimum, and maximum (The report is sorted by total wait time.)

- Times Run

From this report you can drill down to the Requests that Waited report. Select one or more rows, and choose Drilldown from the toolbar. You can also right-mouse click on a selected row(s) to access a drill-down report.

**Waiting Requests by Hour (24x7)**

The Waiting Requests by Hour (24 x 7) report answers the question, "What are my problem time periods?"

The resulting report shows the days of the week in columns and hourly time periods in rows. Each square in the display contains the amount of time requests waited (in minutes) during that time period.

This report presents a graphical display using color and font styles to show wait times: red/bold (longest wait times), yellow/italic (middle wait times), and gray/regular (no wait).

The graphical display of this data is useful when tuning concurrent managers by adjusting job schedules and by visually locating the "hot", "warm", and "cold" time periods. You can use this information to adjust request scheduling.

The features of this report include:

- Selecting an individual program or all programs from the Programs list.
- Selecting the type of data from the Data Displayed drop-down list. The available types of data are:
  - Minutes requests spent waiting
  - Number of requests that waited
- Customizing the threshold for "hot" and "warm" periods using a slider.

From this report you can drill down to the Requests that Waited report. Select one or more time periods, and choose Drilldown from the toolbar. You can also right-mouse click on a row or cell to access a drill-down report.

**Long Running Requests**

The Long Running Requests report answers the question, "Which jobs took a long time to run?"
This report shows runtimes for requests started during a given time period that took longer than \( n \) minutes to run. This helps you identify slow running requests.

A possible remedy for slow running requests is to schedule requests during off-peak hours. This report also identifies programs that should run in a particular concurrent manager. You can designate a concurrent manager for slow running requests and a concurrent manager for fast running requests. Long running jobs should be delegated to the slow running concurrent manager, and faster jobs should be delegated to the fast running concurrent manager. This prevents fast jobs from being blocked by a slow job, increasing overall throughput.

For all requests with a duration greater than a specified number of minutes, this report provides the following information:

- Program name
- Duration in minutes (The report is sorted by this column.)
- Request ID
- User Name
- Concurrent Manager
- Actual Start
- Status
- Priority
- Parameters
- Request limit (if available)

From this report you can drill down to the Request Details report. Select a row, and choose Drilldown from the toolbar. You can also right-mouse click on a selected row to access a drill-down report.

**Short Running Requests that Waited**

The Short Running Requests that Waited report answers the question, "Which requests waited a long time relative to their runtime?"

This report lists the short running jobs that queue longer than a specified number of minutes.

This report is useful for determining which requests are waiting a relatively long time compared to their runtime. Requests can wait longer than they run. If many
requests are identified, consider creating a concurrent manager that specializes in short running requests. This may help to increase the throughput of these requests.

This report provides the following information:

- Program name
- Wait Length (in minutes) (The report is sorted by this column.)
- Duration (in minutes)
- Request ID
- Status
- Phase
- Earliest Start
- User Name
- Concurrent Manager

From this report you can drill down to the Request Details report. Select a row, and choose **Drilldown** from the toolbar. You can also right-mouse click on a selected row to access a drill-down report.

**Request Run Summary by Month**

The Request Run Summary by Month report answers the question, "How has my request processing changed over time?"

You can use this information to determine on a monthly basis if overall performance is improving or deteriorating on a month-to-month basis. The average duration of a request (in minutes) is a good indicator of the change in system performance over time.

You can also use this report to note if the number of requests processed is increasing over time.

This report provides the following information:

- Year-Month
- Total Duration (in minutes)
- Avg Duration (average duration in minutes)
- Number of Requests (that ran during the month)
Drill-Down Reports

Drill-down reports display information that is in the context of the report from which the drill-down was invoked. For example, from the Concurrent Managers by Hour (24x7) report, you can drill down to the Requests that Ran report.

Requests that Ran
The Requests that Ran report answers the question, "Which requests ran in the drill-down context?"

For all requests that ran in this context, this report provides the following information:
- Program
- Duration (in minutes) (The report is sorted by this column.)
- User Name
- Concurrent Manager
- Actual Start (time)
- Actual Completion (time)
- Priority
- Request ID
- Constrained (yes or no)
- Single Thread (yes or no)
- Status
- Request limit (if available)

From this report you can drill down to the Request Details report. Select a request, and choose Drilldown from the toolbar. You can also right-mouse click on a selected row to access a drill-down report.

Requests that Waited
The Requests that Waited report answers the question, "Which requests waited in the drill-down context?"

For all requests that waited in this context, this report provides the following information:
- Program Name
- Wait Length (in minutes) (The report is sorted by this column.)
- User Name
- Concurrent Manager (that ran the request)
- Run alone
- Priority
- Single Thread
- Earliest Start (possible)
- Actual Start
- Actual Completion
- Request ID
- Constrained (yes or no)
- Request limit (if available)

From this report you can drill down to the Request Details report. Select a request, and choose **Drilldown** from the toolbar. You can also right-mouse click on a report to access a drill-down report.

**Request Details**

The Request Details report answers the question, "What are the details for a given request ID?"

You can drill down to this information from any report that shows individual requests. This information is compatible with the request detail information presented by Oracle Applications Manager.

The information in this report is provided in the General, Schedule Options, and Completions Options tabs. The information includes:

- In the General tab
  - Request ID
  - Name
  - Requestor
  - Language
  - Phase
Tuning Advisor

- Status
- Submission date
- Requested start date
- Actual start date
- Actual completion date
- Parameters
- Completion Text

- In the Schedule Options tab
  - Schedule
  - Priority
  - Requested Start

- In the Completion Options tab
  - Notify
  - Print To
  - Print Style
  - Copies
  - Language

Tuning Advisor

The Tuning Advisor feature provides information about possible problems that may be impeding the best-possible performance of your concurrent managers.

Once problem areas are identified, suggestions for improving performance include: increasing capacity, rebalancing resources, and rescheduling requests.

Tuning Advisor Reports

There are a number of reports specific to the Tuning Advisor. The reports are:

- Tuning Advisor Report
- Tuning Suggestion Report for High Utilization with Many Waiting Requests
- Tuning Suggestion Report for Low Utilization with Many Waiting Requests
Tuning Suggestion Report for No Capacity with Many Waiting Requests

**Tuning Advisor Report**
The Tuning Advisor Report summarizes the information regarding concurrent managers and provides overviews of problem areas.

This report is divided into two tables:
- Concurrent Managers
  - This table lists all the concurrent managers.
- Concurrent Manager Problem Overview
  - This table summarizes the information by day and hour of the week (24 x 7) for the concurrent manager highlighted on the Concurrent Managers table.

Table cells highlighted in red (with bold font) suggest there is a high utilization of the concurrent manager while many requests waited.

Table cells highlighted in yellow (with italic font) suggest there is a low utilization of the concurrent manager while many requests waited.

Table cells highlighted in cyan (with bold italic font) suggest there was no capacity while many requests waited. This could mean the concurrent manager assigned to these requests was down.

Table cells that are not highlighted signify that no problem conditions were found.

To access a Tuning Suggestion report, open a Tuning Advisor report, select a cell on the right-hand 24x7 problem overview table, then drill down to the tuning suggestion reports.

**Tuning Suggestion Report for High Utilization with Many Waiting Requests**
This tuning suggestion report lists the requests that waited while the associated concurrent manager was over utilized. Suggestions are offered of how you might correct the many waiting requests problem.

This report has two parts: the upper part contains general information for this time period and the lower part shows (by default) requests that waited.

To view the specific tuning suggestions for this report, click Suggestions. Suggestions are offered of how you might correct the specific problems.
Tuning Suggestion Report for Low Utilization with Many Waiting Requests

This tuning suggestion report lists the requests that waited while the associated concurrent manager was under utilized.

This report has two parts: the upper part contains general information for this time period and the lower part shows requests that waited.

This is a puzzling situation where there is no obvious explanation for what could be causing a backup when the concurrent manager is under utilized. While the report identifies that there is a problem, it is not capable of providing any tuning suggestions.

**Note:** You can drill down to view further details on every concurrent request or concurrent manager that appears in the tuning suggestion screens. For example, drilling down on a concurrent manager shows you the utilization pattern of that concurrent manager.

Tuning Suggestion Report for No Capacity with Many Waiting Requests

This tuning suggestion report is for the situation where there are many waiting requests and the concurrent manager is not up. It shows the concurrent manager information and lists the requests that waited during that time period and tuning suggestions.

This report has two parts: the upper part contains general information for this time period and the lower part shows (by default) requests that waited.

To view the specific tuning suggestions for this report, click Suggestions. Suggestions are offered of how you might correct the specific problems.

**Note:** Select a request on the Requests that Waited table and drill down to see request details.
Oracle Applications Advanced Event Tests

The Oracle Applications Advanced Event Tests include a library of applications-specific event tests which are provided for lights-out event monitoring and problem detection of the Applications system.

Aside from the basic up/down event tests provided for all services administered in the Oracle Enterprise Manager console, the Management Pack for Oracle Applications provides a library of event tests specific to Oracle Applications subsystems.

Note: To successfully use the event tests, the node credentials on Windows NT must be for a user with the "logon as batch" privilege.

The Application subsystem specific events notify administrators of fault, performance, and space problems. The event tests according to category are:

Note: The Fault and Performance event tests are specific to the version of the Agent. The Space event test is independent of the version of the Agent. To determine the version of the Agent, go to the Enterprise Manager Console and find the node on which the concurrent manager is running. Right mouse click on the node target and select "Properties".

The event tests for release 8.1.6 and earlier targets are included for backward compatibility purposes. It is highly encouraged that you upgrade to the new event tests because the old event tests may not be supported in future releases of the Management Pack for Oracle Applications.
■ Fault
  – Concurrent Manager UpDown
  – CRM Waiting on a Lock
  – ICM Waiting on a Lock
  – Request Error Rate
  – Request Warning Rate
  – Unresponsive Concurrent Manager

■ Performance
  – Inactive Request Pending
  – Pending Concurrent Request Backlog
  – Request Pending Time
  – Run Alone Request Submitted

■ Space
  – Concurrent Manager Disk Free

■ Test for V8.1.6 and Earlier Agents

■ Fault
  – Concurrent Manager UpDown (for V8.1.6 and Earlier Agents)
  – CRM Waiting on a Lock (for V8.1.6 and Earlier Agents)
  – ICM Waiting on a Lock (for V8.1.6 and Earlier Agents)
  – Request Error Rate (for V8.1.6 and Earlier Agents)
  – Request Warning Rate (for V8.1.6 and Earlier Agents)

■ Performance
  – Inactive Request Pending (for V8.1.6 and Earlier Agents)
  – Pending Concurrent Request Backlog (for V8.1.6 and Earlier Agents)
  – Request Pending Time (for V8.1.6 and Earlier Agents)
  – Run Alone Request Submitted (for V8.1.6 and Earlier Agents)

The Oracle Applications event library also includes node events. See the Oracle Enterprise Manager Event Test Reference Manual for a complete list of node events.
For more information on submitting or scheduling events, see the Oracle Enterprise Manager Administrator’s Guide. Pay special attention to the event frequency value, which can be set on the General tab of the Create Event panel. This value determines the frequency of polling for event occurrences. The default value is every 60 seconds, but for many application management events, you may wish to choose larger values, for better performance and a lower overall impact on system resources.

Note: To expand the Intelligent Agent messages related to the Management Pack for Oracle Applications, at the system prompt from the Agent’s Oracle home type: oerr <facility> <message number> where <facility> is smamp. For example:

```
oerr smamp 6001
```

Cause: Failed to open a cursor.

Action: Verify that the maximum cursors limit has not been exceeded.

Before running any program from the command line (UNIX or Windows NT), verify that all the correct values are present in the necessary environment variables, for example, ORACLE_HOME and PATH.

Fault Event Tests

Concurrent Manager UpDown

This event test monitors the state of the Internal Concurrent Manager (ICM). If the ICM goes down, an alert is generated.

Parameters
None.

Output
None.

Default Frequency
60 seconds.
Fault Event Tests

User Action
Submit a standalone concurrent manager startup job when the event issues an alert. The startup concurrent manager job could also be configured as a fix-it job to automatically restart the ICM when it goes down.

CRM Waiting on a Lock
This event test checks whether the Conflict Resolution Manager is waiting to get a lock. If the lock wait time reaches a specified amount of time, a warning is issued.

Parameters
1. Critical threshold: Lock wait time (in minutes) for a critical alert. Default is 3 minutes.
2. Warning threshold: Lock wait time (in minutes) for a warning alert. Default is 2 minutes.

Note: Threshold values must be between 2 and 32 minutes.

Output
- Session identification number.
- Operating system process identification number.
- Lock mode.
- Machine name.
- Terminal name for the locking session.

Default Frequency
60 seconds.

User Action
Locate the session that is blocking the Conflict Resolution Manager and determine if the session can be deleted.

Note: A fix-it job could be registered to automatically delete the blocking session when the event is triggered.
ICM Waiting on a Lock

This event test checks whether the Internal Concurrent Manager is waiting to get a lock. If the lock wait time reaches a specified amount of time, a warning alert is issued.

Parameters
1. Critical threshold: Lock wait time (in minutes) for a critical alert. Default is 3 minutes.
2. Warning Threshold: Lock wait time (in minutes) for a warning alert. Default is 2 minutes.

Note: Threshold values must be between 2 and 32 minutes.

Output
- Session identification number.
- Operating system process identification number.
- Lock mode.
- Machine name.
- Terminal name for the locking session.

Default Frequency
60 seconds.

User Action
Locate the session that is blocking the Internal Concurrent Manager and determine if the session can be deleted.

Note: A fixit job could be registered to automatically delete the blocking session when the event is triggered.

Request Error Rate

This event test monitors the error rate of concurrent requests. When the error rate reaches the threshold parameters set by the user, a warning or critical alert is generated.
Fault Event Tests

Parameters

1. Monitor Field: Specify or exclude certain concurrent programs from monitoring. Choose one of the following: All Concurrent Programs, All Except These Concurrent Programs, or Only These Specific Concurrent Programs. The default is to monitor all concurrent programs.

2. List Field: Type the application name and concurrent program name for which the event will filter or exclude from monitoring. These names can be found in the Oracle Applications Manager. The default is empty and disabled.

3. Critical threshold: Percentage of requests marked with errors for critical alert. Default is 10%.

4. Warning threshold: Percentage of requests marked with errors for warning alert. Default is 5%.

Output
Percentage of requests with errors.

Default Frequency
60 seconds.

User Action
Review the Request Log files in the APPL_TOP/log directory to determine which requests need to be corrected.

Request Warning Rate

This event test monitors the warning rate of concurrent requests. When the warning rate reaches the threshold parameters set by the user, a warning or critical alert is generated.

Parameters

1. Monitor Field: Specify or exclude certain concurrent programs from monitoring. Choose one of the following: All Concurrent Programs, All Except These Concurrent Programs, or Only These Specific Concurrent Programs. The default is to monitor all concurrent programs.

2. List Field: Type the application name and concurrent program name for which the event will filter or exclude from monitoring. These names can be found in the Oracle Applications Manager. The default is empty and disabled.

3. Critical threshold: Percentage of requests marked for critical alert. Default is 10%.
4. Warning threshold: Percentage of requests marked for warning alert. Default is 5%.

**Output**
Percentage of requests with warnings.

**Default Frequency**
60 seconds.

**User Action**
Review the Request Log files in the APPL_TOP/log directory to determine which requests need to be corrected.

**Unresponsive Concurrent Manager**
This event test checks the responsiveness of the concurrent managers. If any of your concurrent managers are down at the beginning of the test and are still down after the number of seconds you entered as a parameter, they are considered unresponsive.

In other words, this event test tells you if the concurrent manager is having trouble coming back up or can not be brought back online, giving you the opportunity to resolve the problem.

The difference between the Unresponsive Concurrent Manager event and the Concurrent Manager UpDown event is that the Concurrent Manager UpDown event notifies you when the internal concurrent manager has gone down or comes back up. The Unresponsive Concurrent Manager event test notifies you if any of the other concurrent managers are down over the time period you specify. This event only checks for the concurrent managers that should be up at that time. If a concurrent manager is inactive because of its work shift definition, it will not trigger the Unresponsive Concurrent Manager event.

**Parameters**
Unresponsive Seconds: Type the number of seconds for the time period. This value should be roughly equivalent to the time taken for 2 PMON (Process Monitor) cycles. Calculate this value by multiplying the PMON value by the SLEEP value. The default number of iterations for PMON is 20 and the default number of sleep seconds is 60. Therefore the default is 2400 seconds (2*20*60).
Performance Event Tests

Inactive Request Pending

This event test monitors the state of the requests submitted to the Concurrent Manager(s). If any of the requests is in an inactive state, an alert is generated.

Parameters
1. Monitor Field: Specify or exclude certain concurrent programs from monitoring. Choose one of the following: All Concurrent Programs, All Except These Concurrent Programs, or Only These Specific Concurrent Programs. The default is to monitor all concurrent programs.
2. List Field: Type the application name and concurrent program name for which the event will filter or exclude from monitoring. These names can be found in the Oracle Applications Manager. The default is empty and disabled.

Output
- The number of inactive requests in the concurrent manager(s) queue.
- Table containing the concurrent programs that violated the event test. The columns in the table are: Request ID, Requested By, Application Name, Concurrent Program Name, and Hours Runalone.

Default Frequency
60 seconds.

User Action
Locate the inactive request and remove it from the queue.

Pending Concurrent Request Backlog

This event test monitors for concurrent requests that have been in the pending state for a time period exceeding the threshold, and triggers an alert if they exceed the 'total concurrent requests' threshold.

Parameters
1. Monitor Field: Specify or exclude certain concurrent programs from monitoring. Choose one of the following: All Concurrent Programs, All Except These Concurrent Programs, or Only These Specific Concurrent Programs. The default is to monitor all concurrent programs.
2. List Field: Type the application name and concurrent program name for which the event will filter or exclude from monitoring. These names can be found in the Oracle Applications Manager. The default is empty and disabled.

3. Threshold for total number of requests pending: Number of requests pending in the queue. Default is 1.

4. Time Threshold (in minutes) for including requests in the pending queue backlog. Default is 1 minute.

Output
- Number of requests currently pending.
- Table containing the concurrent programs that violated the event test. The columns in the table are: Request ID, Requested By, Application Name, Concurrent Program Name, and Hours Runalone.
- Length of time the requests has been pending in the queue.

Default Frequency
60 seconds.

User Action
Increase the number of concurrent processes to handle the load.

Request Pending Time
This event test monitors for requests that have been in the pending state for a time period exceeding the threshold set by the user.

Parameters
1. Monitor Field: Specify or exclude certain concurrent programs from monitoring. Choose one of the following: All Concurrent Programs, All Except These Concurrent Programs, or Only These Specific Concurrent Programs. The default is to monitor all concurrent programs.

2. List Field: Type the application name and concurrent program name for which the event will filter or exclude from monitoring. These names can be found in the Oracle Applications Manager. The default is empty and disabled.

3. Hours pending: Number of hours the request has been pending. Default is 1 hour.

4. Minutes pending: Number of minutes the request has been pending. Default is 30 minutes.
Performance Event Tests

Output
- Number of hours or minutes that the request has been pending.
- Table containing the concurrent programs that violated the event test. The columns in the table are: Request ID, Requested By, Application Name, Concurrent Program Name, and Hours Runalone.

Default Frequency
60 seconds.

User Action
Check to see if the queue is being serviced actively. Increase the processes for the queue manager to balance the load, if necessary.

Run Alone Request Submitted
This event test monitors the state of the requests submitted to the Concurrent Manager(s). If any of the requests is in a run alone state, a warning is generated.

Parameters
1. Monitor Field: Specify or exclude certain concurrent programs from monitoring. Choose one of the following: All Concurrent Programs, All Except These Concurrent Programs, or Only These Specific Concurrent Programs. The default is to monitor all concurrent programs.
2. List Field: Type the application name and concurrent program name for which the event will filter or exclude from monitoring. These names can be found in the Oracle Applications Manager. The default is empty and disabled.

Output
- The number of run alone requests in the concurrent manager(s) queue.
- Table containing the concurrent programs that violated the event test. The columns in the table are: Request ID, Requested By, Application Name, Concurrent Program Name, and Hours Runalone.

Default Frequency
60 seconds.

User Action
Determine whether or not the run alone request submitted is necessary. If it is not, the request should be deleted so that other requests can be processed.
Space Event Tests

Concurrent Manager Disk Free

This event test monitors the growth rates of the log, output, and other partitions for the concurrent requests. A checkbox is provided to select any or all of these partitions, or any other partition on the concurrent processing server node.

Note: This event test requires the Application environment (APPSORA.env) file which is located in the Application code base (APPL_TOP).

Parameters
1. Critical threshold for log: Free space threshold in percentage. Default is 30%.
2. Warning threshold for log: Free space threshold in percentage. Default is 50%.
3. Critical threshold for output: Free space threshold in percentage. Default is 30%.
4. Warning threshold for output: Free space threshold in percentage. Default is 50%.
5. Name of partition. (* is not a supported name.)
6. Critical threshold for other partitions: Free space threshold in percentage. Default is 30%.
7. Warning threshold for other partitions: Free space threshold in percentage. Default is 50%.

Output
Partition name and space available in percentage on the partition.

Default Frequency
60 seconds.

User Action
Purge the log or output files.
Fault Event Tests (For V8.1.6 and Earlier Agents)

Concurrent Manager UpDown (for V8.1.6 and Earlier Agents)

This event test monitors the state of the Internal Concurrent Manager (ICM). If the ICM goes down, an alert is generated.

**Parameters**
None.

**Output**
None.

**Default Frequency**
60 seconds.

**User Action**
Submit a standalone concurrent manager startup job when the event issues an alert. The startup concurrent manager job could also be configured as a fix-it job to automatically restart the ICM when it goes down.

CRM Waiting on a Lock (for V8.1.6 and Earlier Agents)

This event test checks whether the Conflict Resolution Manager is waiting to get a lock. If the lock wait time reaches a specified amount of time, a warning is issued.

**Parameters**

1. Critical threshold: Lock wait time (in minutes) for a critical alert. Default is 3 minutes.
2. Warning threshold: Lock wait time (in minutes) for a warning alert. Default is 2 minutes.

---

**Note:** You can configure the Run OS Command job task as a fixit job to remove the log/output files from the Oracle Applications APPL_TOP.

See the *Oracle Enterprise Manager Administrator’s Guide* for more information on configuring job tasks.
Fault Event Tests (For V8.1.6 and Earlier Agents)

Output
- Session identification number.
- Operating system process identification number.
- Lock mode.
- Machine name.
- Terminal name for the locking session.

Default Frequency
60 seconds.

User Action
Locate the session that is blocking the Conflict Resolution Manager and determine if the session can be deleted.

Note: A fixit job could be registered to automatically delete the blocking session when the event is triggered.

ICM Waiting on a Lock (for V8.1.6 and Earlier Agents)

This event test checks whether the Internal Concurrent Manager is waiting to get a lock. If the lock wait time reaches a specified amount of time, a warning alert is issued.

Parameters
1. Critical threshold: Lock wait time (in minutes) for a critical alert. Default is 3 minutes.
2. Warning Threshold: Lock wait time (in minutes) for a warning alert. Default is 2 minutes.

Note: Threshold values must be between 2 and 32 minutes.

Output
- Session identification number.
Fault Event Tests (For V8.1.6 and Earlier Agents)

- Operating system process identification number.
- Lock mode.
- Machine name.
- Terminal name for the locking session.

Default Frequency
60 seconds.

User Action
Locate the session that is blocking the Internal Concurrent Manager and determine if the session can be deleted.

---

Note: A fixit job could be registered to automatically delete the blocking session when the event is triggered.

---

Request Error Rate (for V8.1.6 and Earlier Agents)

This event test monitors the error rate of concurrent requests. When the error rate reaches the threshold parameters set by the user, a warning or critical alert is generated.

Parameters
1. Critical threshold: Percentage of requests marked with errors for a critical alert. Default is 10%.
2. Warning threshold: Percentage of requests marked with errors for a warning alert. Default is 5%.

Output
Percentage of requests with errors.

Default Frequency
60 seconds.

User Action
Review the Request Log files in the APPL_TOP/log directory to determine which requests need to be corrected.
Request Warning Rate (for V8.1.6 and Earlier Agents)

This event test monitors the warning rate of concurrent requests. When the warning rate reaches the threshold parameters set by the user, a warning or critical alert is generated.

**Parameters**
1. Critical threshold: Percentage of requests marked for critical alert. Default is 10%.
2. Warning threshold: Percentage of requests marked for warning alert. Default is 5%.

**Output**
Percentage of requests with warnings.

**Default Frequency**
60 seconds.

**User Action**
Review the Request Log files in the APPL_TOP/log directory to determine which requests need to be corrected.

Performance Event Tests (For V8.1.6 and Earlier Agents)

Inactive Request Pending (for V8.1.6 and Earlier Agents)

This event test monitors the state of the requests submitted to the Concurrent Manager(s). If any of the requests is in an inactive state, an alert is generated.

**Parameters**
None.

**Output**
The number of inactive requests in the concurrent manager(s) queue.

**Default Frequency**
60 seconds.

**User Action**
Locate the inactive request and remove it from the queue.
Pending Concurrent Request Backlog (for V8.1.6 and Earlier Agents)

This event test monitors for concurrent requests that have been in the pending state for a time period exceeding the threshold, and triggers an alert if they exceed the 'total concurrent requests' threshold.

**Parameters**
1. Threshold for total number of requests pending: Number of requests pending in the queue. Default is 1.
2. Time Threshold (in minutes) for including requests in the pending queue backlog. Default is 1 minute.

**Output**
- Number of requests currently pending.
- Length of time the requests has been pending in the queue.

**Default Frequency**
60 seconds.

**User Action**
Increase the number of concurrent processes to handle the load.

Request Pending Time (for V8.1.6 and Earlier Agents)

This event test monitors for requests that have been in the pending state for a time period exceeding the threshold set by the user.

**Parameters**
1. Hours pending: Number of hours the request has been pending. Default is 1 hour.
2. Minutes pending: Number of minutes the request has been pending. Default is 30 minutes.

**Output**
Number of hours or minutes that the request has been pending.

**Default Frequency**
60 seconds.

**User Action**
Check to see if the queue is being serviced actively. Increase the processes for the concurrent manager to balance the load, if necessary.
Run Alone Request Submitted (for V8.1.6 and Earlier Agents)

This event test monitors the state of the requests submitted to the Concurrent Manager(s). If any of the requests is in a runalone request, a warning is generated.

Parameters
None.

Output
The number of run alone requests in the concurrent manager(s) queue.

Default Frequency
60 seconds.

User Action
Determine whether or not the runalone request submitted is necessary. If it is not, the request should be deleted so that other requests can be processed.
The job tasks and job scheduling services of the Oracle Enterprise Manager console allow you to automate standard and repetitive tasks, such as executing a SQL script or executing an operating system command. The Management Pack for Oracle Applications includes job tasks that can be configured to bring a concurrent manager up or down. The pack also includes job tasks that can be configured to trigger automatically as fixit jobs for a particular event. Jobs can be scheduled for specific times or time intervals allowing the administrator to proactively monitor and correct problems.

This chapter describes each of the jobs included with the Management Pack for Oracle Applications. For more information on submitting or scheduling jobs, see the Oracle Enterprise Manager Administrator’s Guide.

---

**Note:** To expand the Intelligent Agent messages related to the Management Pack for Oracle Applications, at the system prompt from the Agent’s Oracle home type: oerr `<facility>` `<message number>` where `<facility>` is `smamp`. For example:

```
oerr smamp 6001
```

**Cause:** Failed to open a cursor.

**Action:** Verify that the maximum cursors limit has not been exceeded.

Before running any program from the command line (UNIX or Windows NT), verify that all the correct values are present in the necessary environment variables, for example, ORACLE_HOME and PATH.
Setting Concurrent Manager Node Credentials

Prior to using Oracle Applications Jobs, you must set the Concurrent Manager Node Credentials. This is necessary because on UNIX, all jobs executed by the Oracle Intelligent Agent are performed as the operating system (OS) user specified in the preferred credentials for that node. This may present an Oracle Applications administrator with a problem if the APPL_TOP for the Concurrent Processing server is owned by an OS user, such as applmgr, which is different from the OS user, oracle, which is needed to perform database operations.

The following are suggestions for how to work around this problem:

- Create two separate Enterprise Manager users: one for performing database related activities, and another for performing Oracle Applications related activities.

  Log on to the Enterprise Manager database account and set the node credentials to the user oracle. Log out of Enterprise Manager and log back on as the Enterprise Manager Oracle Applications user. Set the node credentials to the applmgr account.

- Keep the user oracle in the preferred node credentials. Allow the ICM to be started as user oracle. All log and output directories must be writable by user oracle. The users oracle and applmgr should belong to the same group. You may need to set the umask in the .login files of these users to ensure that files created in the Concurrent Manager’s environment have the appropriate group permissions.

- Keep the user oracle in the preferred node credentials. Configure the .rhosts file for applmgr so that the user oracle can rsh to the managed node as the user applmgr. Alter the concurrent manager startup script ($FND_TOP/bin/oemstart.sh, for example) to rsh as applmgr to the managed node and start the concurrent manager.

  For example, if your Intelligent Agent is on "prodapps.acme.com" add the following line to the .rhosts file for the user "applmgr":

  prodapps.acme.com oracle

  The concurrent manager startup script should then read:

  rsh -l applmgr prodapps.acme.com sh -c "\".$1;startmgr sysmgr=$2\""

- Change the oemstart.sh script to be set-user-id (suid), owned by the APPL_TOP owner applmgr.
Job Descriptions

The job tasks for Oracle Applications are:

- "Concurrent Manager Shutdown" on page 7-3
- "Concurrent Manager Shutdown (for V8.1.6 and Earlier Agents)" on page 7-4
- "Concurrent Manager Startup" on page 7-4
- "Concurrent Manager Startup (for V8.1.6 and Earlier Agents)" on page 7-5
- "Kill Locking Session" on page 7-6
- "Kill Locking Session (for V8.1.6 and Earlier Agents)" on page 7-7
- "Load Data into Concurrent Processing Tuning Assistant" on page 7-7

---

**Note:** The jobs for release 8.1.6 and earlier targets are included for backward compatibility purposes. It is highly encouraged that you upgrade to the new jobs because the old jobs may not be supported in future releases of the Management Pack for Oracle Applications.

---

**Concurrent Manager Shutdown**

The Concurrent Manager Shutdown job task shuts down the Internal Concurrent Manager (ICM), in the mode specified by the user. This job requires an Agent that is release 8.1.7 or higher.

When configured in the *abort* mode, the job shuts down the ICM regardless of the existing state of the queues.

When configured in the *stop* mode, the job waits until current requests are processed and completed before stopping the ICM.

**Parameters**

1. Stop
2. Abort

Choose the Stop mode if you would like to bring down the ICM graciously. Choose the Abort mode if you would like to bring down the ICM immediately, regardless of the state of the concurrent request queues.

**Output**

1. Completion status of the job
Job Descriptions

2. Name of user who registered the job
3. Name of target database

**User Action**
If the job fails, check the ICM log file for details. If the environment variable APPLCSF is set, the ICM log file will be located in $APPLCSF/$APPLLOG. Otherwise, the ICM log file will be located in $FND_TOP/$APPLLOG.

**Concurrent Manager Shutdown (for V8.1.6 and Earlier Agents)**

The Concurrent Manager Shutdown job task shuts down the Internal Concurrent Manager (ICM), in the mode specified by the user.

When configured in the *abort* mode, the job shuts down the ICM regardless of the existing state of the queues.

When configured in the *stop* mode, the job waits until current requests are processed and completed before stopping the ICM.

**Parameters**
1. Stop
2. Abort

Choose the Stop mode if you would like to bring down the ICM graciously. Choose the Abort mode if you would like to bring down the ICM immediately, regardless of the state of the concurrent request queues.

**Output**
1. Completion status of the job
2. Name of user who registered the job
3. Name of target database

**User Action**
If the job fails, check the ICM log file for details. If the environment variable APPLCSF is set, the ICM log file will be located in $APPLCSF/$APPLLOG. Otherwise, the ICM log will be located in $FND_TOP/$APPLLOG.

**Concurrent Manager Startup**

The Concurrent Manager Startup job task starts the Internal Concurrent Manager (ICM). This job task can be configured as a fixit job to be associated with the
Concurrent Manager UpDown event test to automatically start up the Concurrent manager (ICM) when it goes down. This job requires an Agent that is release 8.1.7 or higher.

**Parameters**

1. Queue Size: The duration of time between worker quantity checks (checks for number of active workers). The unit of time is process monitor checks. Default is 1.

2. Sleep Time: The number of seconds that the concurrent manager should wait between checks for new requests. Default is 60.

3. Pmon: The duration of time between process monitor checks (checks for failed workers). The unit of time is concurrent manager iterations (request table checks). Default is 5.

4. Restart: The concurrent manager will attempt a restart after an abnormal termination. Default value is Not Checked.

5. Diag: Determines if diagnostic output should be produced regularly by all concurrent managers. This should be off (unchecked) under most circumstances, since much information (and thus large log files) is produced. Default value is Not Checked.

**Output**

1. Completion status of the job

2. Name of user who registered the job

3. Name of target database

**User Action**

If the job fails, check the ICM log file for details. If the environment variable APPLCSF is set, the ICM log file will be located in $APPLCSF/$APPLLOG. Otherwise, the ICM log will be located in $FND_TOP/$APPLLOG.

**Concurrent Manager Startup (for V8.1.6 and Earlier Agents)**

The Concurrent Manager Startup job task starts the Internal Concurrent Manager (ICM). This job task can be configured as a fixit job to be associated with the Concurrent Manager UpDown event test to automatically start up the Concurrent manager (ICM) when it goes down.

**Parameters**

No parameters are required.
Output
1. Completion status of the job
2. Name of user who registered the job
3. Name of target database

User Action
If the job fails, check the ICM log file for details. If the environment variable APPLCSF is set, the ICM log file will be located in $APPLCSF/$APPLLOG. Otherwise, the ICM log will be located in $FND_TOP/$APPLLOG.

Kill Locking Session
The Kill Locking Session job task is intended to be used as a fix-it job for the following Oracle Applications Advanced Event Tests:

- ICM Waiting on a Lock
- CRM Waiting on a Lock

It is rare for a concurrent program to lock out the ICM or CRM for an excessive amount of time. This job will most likely trigger for a form session that is out of control.

When configured as a fixit job for the previously mentioned event tests, the session preventing ICM or CRM from continuing would automatically be deleted. This job requires an Agent that is release 8.1.7 or higher.

Parameters
No parameters are required.

Output
User will be informed if the job succeeds.

User Action
If the job fails, check your user privileges to make sure you have the rights to kill the session.

Also, check the ICM log file for details. If the environment variable APPLCSF is set, the ICM log file will be located in $APPLCSF/$APPLLOG. Otherwise, the ICM log will be located in $FND_TOP/$APPLLOG.
Kill Locking Session (for V8.1.6 and Earlier Agents)

The Kill Locking Session job task is intended to be used as a fix-it job for the following Oracle Applications Advanced Event Tests:

- ICM Waiting on a Lock
- CRM Waiting on a Lock

It is rare for a concurrent program to lock out the ICM or CRM for an excessive amount of time. This job will most likely trigger for a form session that is out of control.

When configured as a fixit job for the previously mentioned event tests, the session preventing ICM or CRM from continuing would automatically be deleted.

**Parameters**
No parameters are required.

**Output**
User will be informed if the job succeeds.

**User Action**
If the job fails, check your user privileges to make sure you have the rights to kill the session.

Also, check the ICM log file for details. If the environment variable APPLCSF is set, the ICM log file will be located in $APPLCSF/$APPLLOG. Otherwise, the ICM log will be located in $FND_TOP/$APPLLOG.

Load Data into Concurrent Processing Tuning Assistant

The Oracle Concurrent Processing Tuning Assistant (CPTA) is a utility that allows you to examine historical processing information about Oracle Concurrent Processing requests and concurrent managers. Its reports are limited by the amount of information stored in FND tables. Since, in a production system, these tables are purged on a regular basis, there is a need to keep the data in a new repository schema. When you run this job, data will be uploaded from the Applications schema FND tables into the new repository schema. Data will then be aggregated into new tables. This accelerates the processing of the reports.

The repository schema can reside in any Oracle database. Given the potentially massive amount of data that can be stored in this repository, Oracle recommends that you do not use the Oracle Enterprise Manager repository schema for this purpose.
In the first execution of the ‘Load Data into Concurrent Processing Tuning Assistant’ job, approximately 20% of the data in the FND tables is copied to the new repository schema. Every consecutive execution of the job copies only the records added since the previous copy. The repository will continue to grow in proportion to the load on your Applications database.

**Parameters**
1. **User Name**: User name for the Repository Schema. This name must be an existing database user name.
2. **Password**: Password for the user name.
3. **Host**: Host name for the database where the Repository Schema resides.
4. **Port Number**: Port number for the database where the Repository Schema resides.
5. **SID**: Database system identifier for the database where the Repository Schema resides.
6. **Purge Policy**: Indicates that, when the job runs, data which is older than the number of days entered in this field will be purged from the repository. If the field is left blank or you enter 0, then the data is not purged.
This appendix lists some of the problems you might encounter while using the Management Pack for Oracle Applications, along with some possible solutions and workarounds. Sections include:

- Managed Node (Concurrent Manager Node)
- Oracle Management Server Node (OMS)
- Client Node

**Note:** To expand the Intelligent Agent messages related to the Management Pack for Oracle Applications, at the system prompt from the Agent’s Oracle home, type: `oerr <facility> <message number>` where `<facility>` is `smamp`.

For example: `oerr smamp 6001`

Cause: Failed to open a cursor.

Action: Verify that the maximum cursors limit has not been exceeded.

Before running any program from the command line (UNIX or Windows NT), verify that all the correct values are present in the necessary environment variables, for example, `ORACLE_HOME` and `PATH`.

Table A–1 lists symptoms the Management Pack for Oracle Applications may exhibit and refers you to the appropriate section for information. The table is also divided into sections which reflect the nodes where the problems may occur.
Managed Node (Concurrent Manager Node)

This section describes problems related to the Intelligent Agent and possible solutions.

Cannot Start the Intelligent Agent - Oracle Performance Utility Conflict

Summary

The user cannot start the Intelligent Agent on Windows NT. The user gets the message stating: “The Oracle Performance Utility has been found. Please disable or deinstall in order to start the Oracle Intelligent Agent”.

Table A–1 Possible Problems Encountered While Using the Management Pack for Oracle Applications

<table>
<thead>
<tr>
<th>Managed Node (Concurrent Manager Node)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot Start the Intelligent Agent - Oracle Performance Utility Conflict on page A-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Oracle Management Server Node (OMS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problems Connecting to Oracle Management Server on page A-3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to Connect to Repository When Using Performance Manager or Capacity Planner on page A-4</td>
</tr>
<tr>
<td>Unable to Start Performance Manager in Context of the Console on page A-4</td>
</tr>
<tr>
<td>Error Connecting to Repository When Using Performance Manager on page A-5</td>
</tr>
<tr>
<td>Cannot Save Current Performance Manager Work on page A-6</td>
</tr>
<tr>
<td>Errors Occur When Attempting to Connect to Oracle Applications Instances on page A-6</td>
</tr>
<tr>
<td>Losing Connection to a Service on page A-7</td>
</tr>
<tr>
<td>Version of Agent Is Not Compatible with Event or Job on page A-7</td>
</tr>
<tr>
<td>Advanced Events Do Not Display in the Browser on page A-7</td>
</tr>
<tr>
<td>‘Failed to Authenticate User Error’ When Running a Job on page A-8</td>
</tr>
<tr>
<td>Multiple Instances of the Same Concurrent Managers in the Console on page A-9</td>
</tr>
<tr>
<td>Chart Recording Stops When Enterprise Manager Console Is Closed on page A-9</td>
</tr>
</tbody>
</table>
**Oracle Management Server Node (OMS)**

**Troubleshooting**

### Oracle Management Server Node (OMS)

#### Problems Connecting to Oracle Management Server

**Summary**

User cannot connect to the Oracle Management Server.

**Reason**

Unknown

**Action**

Verify that the maximum number of sessions on the Oracle Management Server repository (database) has not been exceeded. If needed, increase the "processes = " init.ora parameter for this database, and then stop and restart the database.

Use SQL*Plus or another tool to verify that you can connect from the Oracle Management Server ORACLE_HOME to the database being used as the Oracle Management Server repository.

---

**Reason**

The Oracle Performance Utility is not compatible with the Oracle Intelligent Agent.

The Oracle Performance Utility is a service that allows Windows NT users to monitor their Oracle instance using the Microsoft NT Performance Monitor tool. This utility is not compatible with the Oracle Intelligent Agent.

**Action**

Deinstall the Oracle Performance Utility using the Oracle Installer you used to install the local database. Alternatively, rename or delete the registry key for Oracle Performance Utility. For example, rename the following key from:

```
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OracleOHOMEDO\Performance
```

To:

```
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\OracleOHOMEDO\RENAILED_Performance
```

**Note:** You will not be able to run the Oracle Performance Utility after this key has been renamed or deleted. To run the Oracle Performance Utility, restore the registry key to its original state.
Unable to Connect to Repository When Using Performance Manager or Capacity Planner

Summary
The user cannot connect to the repository when using either the Performance Manager or Capacity Planner applications.

Reason
An empty connect string was given when the Oracle Management Server repository was created. Alternatively, an unqualified DNS hostname was given at the time of creation and you are trying to connect from a separate DNS domain.

Action
Modify the repository credentials and specify the connect string even though you want to use the local database. If you are connecting to the Oracle Management Server from outside the DNS domain in which the Oracle Management Server repository was created, use a fully qualified hostname when creating the repository (for example, use omshost.acme.com not omshost).

See "Creating the Oracle Management Server Repository" on page 2-7 for additional information.

Unable to Start Performance Manager in Context of the Console

Summary
The user cannot start Performance Manager in the context of the Oracle Enterprise Manager console.

Reason
Performance Manager makes a direct connection to the Oracle Enterprise Manager repository based on a connect string Performance Manager retrieves from the Oracle Management Server. This process fails when invoked from hosts in external DNS domains if you do not specify a fully qualified connect string during the repository creation process (in the Configuration Assistant). Also, this process fails if the local tnsnames.ora file does not have an entry for the database being used for the Oracle Management Server repository.
Action

Modify the repository credentials with a connect string to the repository database. This also includes the situation where the repository and the database are on the same machine.

Verify that the local tnsnames.ora file contains the correct Oracle Net connect alias by using SQL*Plus or another tool to connect to the Oracle Management Server repository database.

Error Connecting to Repository When Using Performance Manager

Summary

The user receives the following messages when attempting to connect to the repository when using Performance Manager:

VTD-0057: Error connecting to repository.
Exception VdbLostConnectionException{wstring reason = "ORA-12203: TNS:unable to connect to destination"; long oracleError=12203;}

When the user continues, the following message appears:

VTD-0058: Repository-based operations will not be available.

Reason

Unknown

Action

Use the vtm -debug command from the command line to run Performance Manager in tracing mode. Then connect to the Oracle Management Server and search the trace output for the service Performance Manager is using to connect to the repository.

This symptom may be caused by incorrect Oracle Net configuration on the client node where you are experiencing this behavior. This symptom can occur if you used an Oracle Net connect alias (for example, mydatabase.world), instead of the colon-separated (for example, myhost.acme.com:1521:mySID) syntax when you created the Oracle Management Server repository.

Use SQL*Plus or another tool to verify that you can connect from this node to the database being used as the Oracle Management Server repository. Use the exact Oracle Net connect alias (for example, foo.world) you used when creating the repository.
See "Creating the Oracle Management Server Repository" on page 2-7 for additional information.

**Cannot Save Current Performance Manager Work**

**Summary**

User cannot save work performed in Performance Manager.

**Reason**

If you start Performance Manager in standalone mode and Performance Manager is connected to a database directly without using the Oracle Management Server, you are not able to save your work.

**Action**

You can save your work to the repository by starting Performance Manager in the context of the Oracle Enterprise Manager console. Follow the menu path Tools=>Application Management=>Performance Manager.

**Errors Occur When Attempting to Connect to Oracle Applications Instances**

**Summary**

User is attempting to connect to an Oracle Applications instance using Performance Manager or Capacity Planner and receives the following error message:

Error: A required patch has not been applied to this Oracle Applications instance

**Reason**

The patch for Oracle Applications bug #1302931 for Oracle Applications version 10.7 or the patch for Oracle Applications bug #1371501 for Oracle Applications version 11.0 and higher was not applied to the Applications instance.

**Action**

Apply the patch for bug #1302931 or bug #1371501 to the Applications instance.
Losing Connection to a Service

Summary
While viewing charts from a service, the following message appears indicating that the connection to the service has been lost.

VTM-0002: Error displaying chart Pending Requests per Manager
Error reading response from Data Gatherer, connection lost for service NT110
Attempts to reconnect to the service fail.

Reason
The Intelligent Agent has stopped running.

Action
Restart the Intelligent Agent.

Version of Agent Is Not Compatible with Event or Job

Summary
While scheduling either an event or a job, user sees the following error:
Agent version on the node is incompatible.

Reason
Events and jobs are specific to certain versions of the Agent, for example, versions 8.1.7 or later of the Agent, or versions 8.1.6 or earlier of the Agent.

Action
Use the correct version of the event/job with the associated version of the Agent.

Advanced Events Do Not Display in the Browser

Summary
The Enterprise Manager console does not display the Management Pack for Oracle Applications advanced events in the browser.
The Management Pack for Oracle Applications was not installed in the Oracle home in which the Oracle Management Server is running.

Install the Management Pack for Oracle Applications in the same Oracle home as the Oracle Management Server. Stop and restart the Oracle Management Server.

User has encountered the 'Failed to authenticate user' error message while running a job.

A Windows NT user account does not exist that has the log on as batch job privilege.

For the Intelligent Agent to execute jobs on a managed node (Windows NT only), a Windows NT user account must exist that has the log on as batch job privilege. The privilege can be assigned to an existing local or domain user (starting with Oracle Server release 7.3.3) or a new Windows NT user. The preferred credentials for the node must be set for that user in the Enterprise Manager console. Refer to the Oracle Enterprise Manager Configuration Guide for information on setting preferences. The user must have permission to write to the $ORACLE_HOME/network or $ORACLE_HOME\Net80 directories.

1. Create a Windows NT user account. Refer to the Windows NT documentation for information.

Note: This user account does not need to be an administrator account, although the administrator privilege is needed for starting Windows NT services, for example, the listener and database. You can use an existing Windows NT administrator account or create a new account.
2. Because the Intelligent Agent must first logon to Windows NT to execute any command, the account which logs into the NT operating system must have the Windows NT system privilege **Log on as a batch job**. Refer to "Configuring Windows NT Security for the Enterprise Manager Job System" on page 2-3 for information on how to grant this privilege.

**Multiple Instances of the Same Concurrent Managers in the Console**

**Summary**

The user sees the same Concurrent Manager instance listed more than once in the Oracle Enterprise Manager Console.

**Reason**

The database alias name in the oapps.ora file was modified after the instance was discovered.

**Action**

In the Oracle Enterprise Manager Console, right-mouse click on the old concurrent manager instance and select **Remove**.

**Chart Recording Stops When Enterprise Manager Console Is Closed**

**Summary**

When the user starts recording a Performance Manager chart then closes the Enterprise Manager console window, the recording stops.

**Reason**

The Performance Manager application runs in the same process space as the Enterprise Manager console. This is a restriction of the console.

**Action**

Keep the Enterprise Manager console window open or minimize the window.
Index

A
Add New Service button, 4-3
Add New Target button, 3-4
Add New Target command, 3-9
advice
diagnostic, 3-17
Agent
accessing through intermediate host, 3-3
Agent data gathering service’s integration with, 3-2, 4-1
checking the log file, 4-20
checking the status of, 4-20
on UNIX, 2-4
checking status, 2-4, 2-8
starting, 2-4, 2-8
stopping, 2-4, 2-8
verifying status, 2-4, 2-8
Oracle Data Gatherer’s integration with, 3-2, 4-1
setting the location of, 3-3, 4-3
troubleshooting, 4-20
Agent data gathering service
See Agent
analysis
adding data from other classes to, 4-29
copying, 4-26
creating from a data class, 4-23
generating a report for an, 4-37
identifying user-defined and predefined, 4-25
modifying the selection criteria for an existing, 4-30
printing, 4-36
saving predefined, 4-36
saving results of, 4-36
saving user-defined, 4-36
viewing and modifying an existing, 4-25
See also charts
Analysis window
overview of, 4-28
using the scroll bar, 4-32
zooming in, 4-31
zooming out, 4-31
analyzing
collected historical data, 4-20
annotation box
moving in an analysis chart, 4-35
auto-scaling
chart data, 4-33

B
bar charts, 3-12

C
Capacity Planner
See Oracle Capacity Planner
Chart, 3-15
Chart Format button, 3-12
chart group
definition, 3-10
Chart Status button, 3-15, 3-26, 3-32
using, 3-16
charts
auto-scaling the data included in, 4-33
chart-specific commands, 3-15
constraints, 3-13
displaying or hiding the chart legend, 4-31
drilling down, 3-15
excluding data points from, 4-30
filtering chart data, 3-14
formats of, 3-12
generating reports for, 3-22
going help on, 3-21
hiding the chart legend, 4-31
orientations, 3-20
printing, 3-22
removing lines from, 4-30
saving your changes, 3-21
scaling the data in, 4-33
selecting a line in, 4-29
setting chart options, 3-13
sorting data in table, 3-20
viewing, 3-9
viewing the values of data points in, 4-28
See also analysis
checking status
Agent
  on UNIX, 2-4, 2-8
class
  contents of data tables in the historical database, 4-39
definition, 4-15
modifying selection criteria for including in an analysis, 4-30
names of data tables in the historical database, 4-38
specifying for historical data collection, 4-15
specifying selection criteria for including in an analysis, 4-24
understanding the data tables in the historical database, 4-38
class reference table
understanding, 4-38
collected data
analyzing, 4-20
browsing, 4-22
definition, 3-11
collection frequency
specifying for a target, 4-10
collection problems
  troubleshooting, 4-20
computing statistics
using SQL ANALYZE command, 5-2
concurrent manager
  balancing, 5-4
  specialization, 5-4
Concurrent Manager UpDown (for v8.1.6 and earlier Agents) event test, 6-12
Concurrent Manager Utilization by Hour (24 x 7) report, 5-4
connecting
  manually to a target, 3-9
to a discovered target, 3-8
to a target, 3-9
to an historical database, 4-21
Console
  starting
    from command line, 2-11
    from Windows Start menu, 2-11
constraints
  selecting chart, 3-13
copying
  an analysis, 4-26
creating
  a copy of an analysis, 4-26
  an analysis from a data class, 4-23
critical threshold, 3-26
CRM Waiting on a Lock (for v8.1.6 and earlier Agents) event test, 6-12

D
data
  analyzing collected, 4-20
  browsing collected, 4-22
determining what is being collected, 4-17
organization of collected, 4-22
purging policies, 5-2
selecting collected, 3-11
data class
definition, 4-16
in Capacity Planner analysis view, 4-22
modifying selection criteria, 4-30
saving as an analysis, 4-23
specifying for historical data collection, 4-15
specifying selection criteria for, 4-24
viewing an analysis for, 4-24
data collection
See historical data collection
data item
definition, 4-17
selecting for collection, 4-17
stopping collection for a, 4-18
data point
displaying a currently excluded point in a chart, 4-31
excluding from a chart, 4-30
viewing the value of a, 4-28
data samples
-specifying the length of time between, 4-10
-specifying the number to collect for a time interval, 4-10
data source
definition, 3-11, 4-17
examples of, 4-17
selecting, 3-11
selecting for collection, 4-17
stopping collection for a, 4-18
deleting
-lines from a chart, 4-30
-recordings, 3-24
-user-defined analysis, 4-27
disconnecting
disconnecting from historical database, 4-21
Disk Full event test, 6-11
displaying
-a chart legend, 4-31
-existing user-defined analyses, 4-25
-predefined analyses, 4-25
drill-down charts, 3-15
drilling down to historical data, 3-18

E
Enterprise mode
-running Performance Manager in, 3-6
event permissions, 3-30
events
-in Performance Manager, 3-25
multiple targets, 3-29
registering in Performance Manager, 3-30
excluding a data point from a chart, 4-30

F
filtering chart data, 3-14
FND_APPLICATION_TL table, 5-2
FND_CONC_PP_ACTIONS table, 5-2
FND_CONC_RELEASE_CLASSES table, 5-2
FND_CONC_RELEASE_CLASSES_TL table, 5-2
FND_CONCURRENT_PROCESSES table, 5-2
FND_CONCURRENT_PROGRAMS table, 5-2
FND_CONCURRENT_PROGRAMS_TL table, 5-2
FND_CONCURRENT_QUEUES table, 5-2
FND_CONCURRENT_QUEUES_TL table, 5-2
FND_CONCURRENT_REQUESTS table, 5-2
FND_LOOKUP_VALUES table, 5-2
FND_PRINTER_STYLES table, 5-2
FND_PRINTER_STYLES_TL table, 5-2
FND_PRODUCT_INSTALLATIONS table, 5-2
FND_USER table, 5-2

G
green dot on class icon in navigator panel
meaning of, 4-18

H
help
-accessing for Oracle Capacity Planner, 4-5
-for charts, 3-21
hiding
-a chart legend, 4-31
-the list of predefined analyses, 4-25
hierarchical charts, 3-12
historical data collection
-aggregation of data in, 4-12
-setting up a, 4-6
-specifying a target for, 4-7
-specifying the age of the data saved for analysis, 4-14
-specifying the classes of data to collect, 4-15
-stopping for a class of data, 4-18
historical database
-connecting to, 4-21
-contents of data tables for classes in, 4-39
disconnecting from, 4-21
-names of data tables for a class, 4-38
specifying the location of a, 4-11
understanding the class reference table, 4-38
understanding the data tables for a class in, 4-38
understanding the logical structure of, 4-37
understanding the service reference table, 4-37
unsupported modifications to, 4-37
horizontal orientation
of a chart, 3-20

I
Inactive Request Pending event test, 6-8
Intelligent Agent
See Agent

K
Kill menu item
in Performance Manager, 3-15

L
line charts, 3-12
load frequency
specifying for a target, 4-11
load problems
troubleshooting, 4-20
loader passes
selecting the length of time between, 4-11
selecting the number for a time interval, 4-11
log file for Agent, 4-20
Long Running Requests report, 5-4

M
main window
of Oracle Performance Manager, 3-7
Management Server
selecting from login dialog, 2-11
modifying
existing analysis, 4-25
selection criteria for a class of data in an analysis chart, 4-30
moving
annotation box in an analysis chart, 4-35

O
occurrences, 3-29
oemapp console command, 2-11
Oracle Application Object Library tables, 5-1
Oracle Capacity Planner
drilling down to, 3-19
functions of, 4-1
how it collects and stores data, 4-2
starting, 4-4
two-step process for using, 4-6
usage scenarios for, 4-4
Oracle Data Gatherer
See Agent
Oracle Performance Manager
functions of, 3-1
starting, 3-5
usage scenarios for, 3-4
Oracle Performance Utility, A-3
overview charts
viewing, 3-10

P
Pending Concurrent Request Backlog event
test, 6-8
performance
improving in retrieving data, 5-2
Performance Manager
See Oracle Performance Manager
performance statistics
projecting, 4-33
pie chart, 3-12
predefined analyses
definition, 4-22
displaying or hiding the list of, 4-25
identifying icon, 4-25
printing
a chart, 3-22
an analysis, 4-36
problems
troubleshooting, 4-20
purging
concurrent processing tables, 5-2
determining how much historical data to keep

Index-4
before, 4-14  
policies for data, 5-2

R
recording chart data, 3-22  
recordings
  removing, 3-24  
  starting, 3-23  
  stopping, 3-23  
Recordings folder, 3-8  
reducing wait time, 5-4  
removing
  a line from a chart, 4-30  
renaming
  a user-defined analysis, 4-27  
report
  generating for an analysis report, 4-37  
reports
  Concurrent Manager Utilization by Hour (24 x 7), 5-4  
  generating for charts, 3-22  
  Long Running Requests, 5-4  
  Requests that Ran, 5-4  
  Requests that Waited, 5-4  
  Short Running Requests that Waited, 5-4  
  Waiting Requests by Hour (24 x 7), 5-4  
Request Error Rate event test, 6-6  
Request Pending Time (for v8.1.6 and earlier Agents) event test, 6-16  
Request Pending Time event test, 6-9  
request schedules
  tuning, 5-3  
Request Warning Rate (for v8.1.6 and earlier Agents) event test, 6-15  
Request Warning Rate event test, 6-6  
Requests that Ran report, 5-4  
Requests that Waited report, 5-4  
Runalone Request Submitted (for v8.1.6 and earlier Agents) event test, 6-17  
Runalone Request Submitted event test, 6-10  
analysis results, 4-36  
class data as a user-defined analysis, 4-23  
Performance Manager charts, 3-21  
scrolling
  in the Analysis window, 4-32  
security login, 2-12  
selection criteria
  modifying for class data in an analysis, 4-30  
service reference table
  understanding, 4-37  
Set Connection Details menu item, 3-4, 4-3  
Set Options button, 3-15  
Short Running Requests that Waited report, 5-4  
shortcut keys, 3-24  
Show Overview Charts menu option, 3-10  
  toolbar button, 3-10  
sorting
  data in a table chart, 3-20  
SQL ANALYZE command, 5-2  
Standalone mode
  running Performance Manager in, 3-7  
starting
  Console
    from command line, 2-11  
    from Windows Start menu, 2-11  
  Oracle Capacity Planner, 4-4  
  Oracle Performance Manager, 3-5  
  Tuning Assistant
    from Oracle Enterprise Manager, 5-5  
    from Start menu, 5-6  
stopping
  collection of data for a data source or data item, 4-18  
strip charts, 3-12
T  
table charts, 3-12  
sorting data in, 3-20  
tables
  FND_APPLICATION_TL, 5-2  
  FND_CONC_PP_ACTIONS, 5-2  
  FND_CONC_RELEASE_CLASSES, 5-2  
  FND_CONC_RELEASE_CLASSES_TL, 5-2  

Index-5
FND_CONCURRENT_PROCESSES, 5-2
FND_CONCURRENT_PROGRAMS, 5-2
FND_CONCURRENT_PROGRAMS_TL, 5-2
FND_CONCURRENT_QUEUES, 5-2
FND_CONCURRENT_QUEUES_TL, 5-2
FND_CONCURRENT_REQUESTS, 5-2
FND_LOOKUP_VALUES, 5-2
FND_PRINTERYLES, 5-2
FND_PRINTERYLES_TL, 5-2
FND_PRODUCT_INSTALLATIONS, 5-2
FND_USER, 5-2
Oracle Application Object Library tables, 5-1
purging concurrent processing, 5-2
target
connecting manually, 3-9
connecting to discovered, 3-8
selecting for historical data collection, 4-7
specifying the classes of data to collect
from, 4-15
specifying the collection frequency for, 4-10
specifying the load frequency for, 4-11
threshold associations
editing, 3-18, 3-34
threshold state indicators, 3-4
thresholds
critical, 3-16
editing, 3-28
order of precedence, 3-27
refreshing, 3-33
resetting, 3-18, 3-33
setting, 3-28
triggered events, 3-29
types, 3-27
viewing, 3-31
warning, 3-16
trend analysis
definition, 4-33
specifying and performing, 4-34
to a point in time, 4-33
to a value, 4-33
troubleshooting
collection and load problems, 4-20
Tuning Assistant
starting from Oracle Enterprise Manager, 5-5
starting from Start menu, 5-6
usage scenarios, 5-3
tuning request schedules, 5-3

U
usage scenarios
for Oracle Capacity Planner, 4-4
for Oracle Performance Manager, 3-4
for Tuning Assistant, 5-3
user-defined analysis
creating, 4-23
definition, 4-22
deleting, 4-27
identifying icon, 4-25
resetting, 4-27
renaming, 4-27
user-defined charts
restriction when drilling down, 3-19
using Oracle Capacity Planner help, 4-5

V
vertical orientation
do a chart, 3-20
viewing
an analysis of a data class, 4-23
an existing analysis, 4-25
chart data by zooming and scrolling, 4-31
overview charts, 3-10
Performance Manager charts, 3-9
the selection criteria for a class of data in an
analysis, 4-30

W
wait time
reducing, 5-4
Waiting Requests by Hour (24 x 7) report, 5-4
warning threshold, 3-26

Z
zoom buttons
on Analysis window toolbar, 4-31